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About the Guide

Welcome to Release 8.0.4.1.0 of the Oracle Financial Services Regulatory Reporting for US Federal
Reserve — Lombard Risk Integration Pack User Guide.

This section provides a brief description of the scope, the audience, the references, concepts and the
organization of the user guide and conventions incorporated into the user guide. The topics in this section
are organized as follows:

¢ Scope of the Guide

¢ Intended Audience

¢ Documentation Accessibility

¢ Related Information Sources

¢ How This Guide is Organized

+ Conventions Used

Scope of the Guide

The objective of this user guide is to provide a comprehensive working knowledge on Oracle Financial
Services Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack, Release
8.0.4.1.0. This user guide is intended to help you understand the key features and functionalities of
Oracle Financial Services Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
(Oracle Financial Services Data Foundation (OFSDF) Interface with Lombard Risk for US FED) release
8.0.4.1.0 and details the process flow and methodologies used.

Intended Audience

This guide is intended for:

¢+ Regulatory Reporting Analyst who bears the responsibility to verify and submit the results.
He/She is also entrusted to maintain the dimensional values across multiple reporting
requirements, maintain results area structure of Oracle Financial Services Data Foundation.

+ Data Analysts, who clean, validate, and import data into the Oracle Financial Services Download
Specification format, and ensure that data is populated in the relevant tables as per the
specifications and executions required for regulatory reporting.

¢ System Administrator (SA), instrumental in making the application secure and operational and
configures the user roles providing necessary access to users.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website
at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
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Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Related Information Sources

In addition to this user guide you can refer to the following documents in the OHC documentation library:

¢ Oracle Financial Services Regulatory Reporting for US Federal Reserve — Lombard Risk
Integration Pack Installation Manual Release 8.0.4.1.0

¢ Oracle Financial Services Data Foundation User Guide Release 8.0.4.0.0
¢ Oracle Financial Services Data Foundation Installation Manual Release 8.0.4.0.0

¢ Oracle Financial Services Analytical Applications Infrastructure User Guide Release 8.0.4.0.0
(present in the OHC documentation libaray)

How this Guide is Organized?

The OFSDF Interface with Lombard Risk for US FED User Guide includes the following topics:

¢ Chapter 1: Introduction

¢ Chapter 2: Getting Started

¢ Chapter 3: Regulatory Reporting (REG REP) Solution Data Flow
¢ Chapter 4: OFSAA Features

¢ Chapter 5: Executing Run through Run Management

¢ Chapter 6: Metadata Export Utility

¢ Chapter 7: Report Submission

¢ Chapter 8: Maintenance

¢ Chapter 9: Troubleshooting Guidelines

Conventions Used

Table 1 lists the conventions used in this guide.

Table 1: Conventions Used in this Guide

Convention | Meaning

Italics Names of books, chapters, and sections as references

Bold ¢ Object of an action (menu names, field names, options, button names) in a
step-by-step procedure

¢ Commands typed at a prompt

¢ Userinput
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Monospace ¢ Directories and subdirectories
¢ File names and extensions

¢ Process names

¢ Code sample, including keywords and variables within text
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1 Introduction

This chapter provides an understanding of the Oracle Financial Services Data Foundation (OFSDF)
Interface with Lombard Risk for US FED application and its scope. It includes:

¢  Overview

¢ OFSAA Requlatory Reporting Architecture
¢ Scope

1.1 Overview

Regulatory reporting and financial services have evolved to be an inseparable combination. It has
worsened since the 2008 financial crisis. Today, banks and financial institutions need to file hundreds of
regulatory reports. For the U.S. Federal Reserve alone, institutions must file multiple submissions of
FFIEC 101, call reports, stress testing reports, and so on. Reporting requirements increase rapidly in
number and complexity for banks operating regionally or globally, where they must file in multiple
jurisdictions.

The OFS REG REP US FED solution enables financial services organizations to manage and execute
regulatory reporting in a single integrated environment. It automates end-to-end processes from data
capture through submission with industry-leading solutions. It leverages Oracle Financial Services
Analytical Application (OFSAA) and Oracle Financial Services Data Foundation (OFSDF) for managing
analytical application data. The AgileREPORTER in Regulatory Reporting (REG REP) Solution enables
firms to automate the final mile of the reporting process. It provides pre-built integration to Lombard Risk
Reporting, eliminating the need for further manual intervention. The solution ensures data integrity
allowing banks to focus more time on analyzing and gaining new business insight from their growing
stores of data instead of preparing data and reports with the sole objective of meeting submission
deadlines.

1.2 OFSAA Regulatory Reporting Architecture

OFSAA : Enterprise

Data Sources Staging Reporting

Loans and

GL Data Leases

Off Balance

Sheetbiodiicts Analytical Engines OFSAA Results
iti i i Management Reportin,
Securities | Regulatory Capital Calculations | g p g

P ALLL, Fair Value, Economic Capital
Trading Data Derivatives | p Y

Calculations
Capital Data | Stress Executions | Account Summary
Currency Data
Transactions Summary

OFSAA — Analytical Application Infrastructure

Figure 1: Regulatory Reporting (REG REP) Solution Architecture
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This interface connects the Oracle FSDF to Lombard Risk. As one can see in Architecture figure above,
Data flows from OFSAA to Lombard Risk.

OFSDF is an analytical data warehouse platform for the Financial Services industry. OFSDF combines an
industry data model for Financial Services along with a set of management and infrastructure tools that
allows Financial Services Institutions to develop, deploy, and operate analytical solutions spanning key
functional areas in Financial Services, including:

1. Enterprise Risk Management

2. Enterprise Performance Management

3. Customer Insight

4. Financial Crime and Compliance Management

OFSDF is a comprehensive data management platform that helps institutions to manage the analytical
data life cycle from sourcing to reporting and business intelligence/BI using a unified, consistent platform
and toolset.

AgileREPORTER is a forms and workflow tool that enables both creation and submission of regulatory
returns. AgileREPORTER addresses the financial reporting requirements of both domestic and
international banks and financial institutions by automating compliance with mandated reports to central
banks, regulatory agencies. AgileREPORTER works easily with multiple sources of information as it
standardizes data elements and automates regulatory report production in prescribed templates with the
associated workflow for automatic submission. It is Reliable and efficient infrastructure to compile,
generate and submit regulatory reports. It collects data from a wide universe (not just OFSAA Results). It
provides automated repeated manual adjustments, variance analysis and validation checks. It provides
features to explain and justify a number quickly, including links to OBIEE.

The solution provides a pre-built interface or integration between FSDF and AgileREPORTER. With this
integration end user can automate end to end reporting process covering data preparation to last mile of
reporting.

1.3 Scope

Oracle Financial Services Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
covers the following regulatory reports for specified release as mentioned in the table:

Table 2: Scope

Report Report Name Released Version

FR Y-9C Consolidated Financial Statements for Holding Companies 8.0.1

Financial Statements for a Bank Holding Company Subsidiary

FRY-20 Engaged in Bank-Ineligible Securities Underwriting and Dealing 8.01
FR Y-15 Banking Organization Systemic Risk Report 8.0.1
FFIEC-009 Country Exposure Report 8.0.1
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Report Report Name Released Version

FFIEC-009A Country Exposure Information Report 8.0.1

FR Y-11 Flnanual Statem_ents of U.S. Nonbank Subsidiaries of U.S. 8.0.1
Holding Companies
Abbreviated Financial Statements of U.S. Nonbank

FRY-11S Subsidiaries of U.S. Holding Companies 80.1

FR-2314 Flnanc_lal _Statements of Foreign Subsidiaries of U.S. Banking 8.01
Organizations

FR-2314S Abbrgwated F|r_1an(_:|al Statements of Foreign Subsidiaries of U.S. 8.01
Banking Organizations

FR Y-14A Capital Assessments and Stress Testing - Annual 8.0.1

FR Y-9LP Parent C_ompany Only Financial Statements for Large Holding 8.0.1
Companies

FEIEC-031 Consollqlated Repo_rts of C_:ondltlon and Income for a Bank with 8.0.2
Domestic and Foreign Offices

FR Y-12 Cons'olldated Holdlng.Company Report of Equity Investments in 8.0.1
Nonfinancial Companies

FEIEC-041 Consollglated.Reports of Condition and Income for a Bank with 8.0.3
Domestic Offices Only

FR-2052A Complex Institution Liquidity Monitoring Report 8.0.3
Financial Statements of U.S. Nonbank Subsidiaries Held by

FRY-7N Foreign Banking Organizations 8.0.3
Abbreviated Financial Statements of U.S. Nonbank Subsidiaries

FRY-7NS Held by Foreign Banking Organizations 8.0.3
Weekly Report of Selected Assets and Liabilities of Domestically

FR-2644 Chartered Commercial Banks and U.S. Branches and Agencies of | 8.0.3
Foreign Banks

FR-2886B Cash and Balances Due from Depository Institutions 8.0.3

FR-2900 Report of 'I_'ransactlon Accounts, Other Deposits, and Vault Cash 8.0.3
(Commercial Banks)

FR Y-14Q Schedule M.1 — Balances 8.0.3

FR Y-14Q Schedule K — Supplemental 8.0.3

FR Y-14Q Schedule A — Retail 8.0.3

FR Y-14Q Schedule H — Wholesale Risk 8.0.3

FR Y-14M Capital Assessments and Stress Testing Report - Monthly 8.0.3
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Report Report Name Released Version

Regulatory Capital Reporting for Institutions Subject to the

FFIEC-101 Advanced Capital Adequacy Framework 8.0.3
FDIC-8020 Statement of Deposits 8.0.3
The following table lists the detailed scope.
Table 3: Detailed Scope
ﬁt_ Report Code gggidule Schedule Name
1 FDIC-8020 - Statement of Deposits
2 FFIEC-009 C Part | Claims on an Immediate Risk Basis
3 FFIEC-009 C Partll Claims on an Ultimate Risk Basis and Memorandum Items
4 FFIEC-009 D Claims from Positions in Derivative Contracts
5 FFIEC-009 L Foreign-Office Liabilities
6 FFIEC-009 o Off-Balance-Sheet Items
7 FFIEC-009A A Country Exposure Information Report Part A
8 FFIEC-009A B Country Exposure Information Report Part B
9 FFIEC-031 RC-S Servicing, Securitization, and Asset Sale Activities
10 FFIEC-031 RC-V Variable Interest Entities
11 FFIEC-031 RC Balance Sheet
12 FFIEC-031 RC-A Cash and Balances Due from Depository Institutions
13 FFIEC-031 RC-B Securities(bugs)
14 FFIEC-031 RC-C Loans and Lease Financing Receivables(bugs)
15 FFIEC-031 RC-D Trading Assets and Liabilities
16 FFIEC-031 RC-E Deposit Liabilities
17 FFIEC-031 RC-F Other Assets
18 FFIEC-031 RC-G Other Liabilities
19 FFIEC-031 RC-H Selected Balance Sheet Items for Domestic Offices
20 FFIEC-031 RC-I Assets and Liabilities of IBFs
21 FFIEC-031 RC-K Quarterly Averages
22 FFIEC-031 RC-L Derivatives and Off-Balance-Sheet Items
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zlc;. Report Code ggr&idule Schedule Name

23 FFIEC-031 RC-M Memoranda

24 FFIEC-031 RC-N Past Due and Nonaccrual Loans, Leases, and Other Assets
25 FFIEC-031 RC-O Other Data for Deposit Insurance and FICO Assessments
26 FEIEC-031 RC-P é;%l;z?glyéfr\;ieczigential Mortgage Banking Activities in

27 FEIEC-031 RC-Q gzzcie;s and Liabilities Measured at Fair Value on a Recurring
28 FFIEC-031 FC'R Part Regulatory Capital Components and Ratios

29 FFIEC-031 :TC'R Part | pisk-Weighted Assets

30 FFIEC-031 RC-T Fiduciary and Related Services

31 FFIEC-031 RI Income Statement

32 FFIEC-031 RI-A Changes in Equity Capital

33 FEIEC-031 RI-B (nglaar:g:r;gffl_sezgg sggstjgseries and Changes in Allowance for
34 FEIEC-031 RI-C Eci)ssz%iregated Data on the Allowance for Loan and Lease
35 FFIEC-031 RI-D Income from Foreign Offices

36 FFIEC-031 RI-E Explanations

37 FFIEC-041 RC Balance Sheet

38 FFIEC-041 RC-A Cash and Balances Due from Depository Institutions

39 FFIEC-041 RC-B Securities

40 FFIEC-041 RC-C Loans and Lease Financing Receivables

41 FFIEC-041 RC-D Trading Assets and Liabilities

42 FFIEC-041 RC-E Deposit Liabilities

43 FFIEC-041 RC-F Other Assets

44 FFIEC-041 RC-G Other Liabilities

45 FFIEC-041 RC-K Quarterly Averages

46 FFIEC-041 RC-L Derivatives and Off-Balance-Sheet Items

a7 FFIEC-041 RC-M Memoranda
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zlc;. Report Code ggr&idule Schedule Name

48 FFIEC-041 RC-N Past Due and Nonaccrual Loans, Leases, and Other Assets

49 FFIEC-041 RC-O Other Data for Deposit Insurance and FICO Assessments

50 FFIEC-041 RC-P 1-4 Family Residential Mortgage Banking Activities

51 FEIEC-041 RC-Q gzzcie;s and Liabilities Measured at Fair Value on a Recurring

52 FFIEC-041 FC'R Part Regulatory Capital Components and Ratios

53 FFIEC-041 :TC'R Part | pisk-Weighted Assets

54 FFIEC-041 RC-S Servicing, Securitization, and Asset Sale Activities

55 FFIEC-041 RC-T Fiduciary and Related Services

56 FFIEC-041 RC-V Variable Interest Entities

57 FFIEC-041 RI Income Statement

58 FFIEC-041 RI-A Changes in Bank Equity Capital

59 FEIEC-041 RI-B Charge-offs and Recoveries and Changes in Allowance for
Loan and Lease Losses

60 FEIEC-041 RI-C Eci;zgé%regated Data on the Allowance for Loan and Lease

61 FFIEC-041 RI-E Explanations

62 FFIEC-101 - Advanced Capital Adequacy Framework

63 FR Y-11 BS Balance Sheet

64 FRY-11 BS-A Loans and Lease Financing Receivables

65 FRY-11 BS-M Memoranda

66 FRY-11 IS Income Statement (calendar year-to-date)

67 FR Y-11 IS-A Changes in Equity Capital

68 FRY-11 IS-B Changes in Allowance for Loan and Lease Losses

69 FR Y-11S List Detailed Listing of Subsidiaries

70 FR Y-12 A Type of Investments

71 FR Y-12 B Type of Security

72 FRY-12 C Type of Entity within the Banking Organization
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fllc.). Report Code ggr&idule Schedule Name

73 FR Y-12 D l;lgﬂ(—)f(ijnancial Investment Transactions During Reporting
74 FR Y-14A0R - Operational Risk

75 FR Y-14ARCI - Regulatory Capital Instruments

76 FR Y-14ARCT - Regulatory Capital Transitions

77 FR Y-14ASCENR - Scenario

78 FR Y-14ASUMM - Summary

79 FR Y-14M - Capital Assessments and Stress Testing Report

80 FR Y-14M Al nge_sﬁigal;irf(ta\l;(iaelr_lrgtl)(l)esed-end 1-4 Family Residential Loan
81 FR Y-14M A2 nge_sggrlt:flcr)ﬁLLlece(lil_?;ggend 1-4 Family Residential Loan
82 FR Y-14M B-1 Eé)vn;fle_srt;%llgome Equity Loan and Home Equity Line - Loan
83 FR Y-14M B-2 Egrrlwfce)ﬁchI;\(l)é??raEggity Loan and Home Equity Line -

84 FR Y-14M C-1 Address Matching Loan Level Data

85 FR Y-14M D-1 Domestic Credit Card Data - Loan Level Table

86 FR Y-14M D-2 Domestic Credit Card Data - Portfolio Level Table

87 FR Y-14QA1 - Retail

88 FR Y-14QBAL M Balances

89 FR Y-14QCIL H.1 Corporate Loan Data

90 FR Y-14QCRE H.2 Commercial Real Estate

91 FR Y-14QFVOHFS J Retail Fair Value Option/Held for Sale (FVO/HFS)

92 FR Y-14QMSR | MSR Valuation

93 FR Y-14QOpsriskBL E.2 Business Line

94 FR Y-14QOpsriskMS E.1 Operational Loss History

95 FR Y-14QOpsriskRFR E.5 Legal Reserves Frequency

96 FR Y-14QOpsriskTH E.4 Threshold Information

97 FR Y-14QOpsriskUOM E.3 Unit-Of-Measure

98 FR Y-14QPPNR G Pre-Provision Net Revenue
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zlc;. Report Code ggr&idule Schedule Name
929 FR Y-14QRCI C Regulatory Capital Instruments
100 FR Y-14QRCT D Regulatory Capital Transitions
101 FR Y-14QRetailAuto A.2 US Auto Loan
102 FR Y-14QRetaillntauto Al International Auto Loan
103 FR Y-14QRetaillntcard A3 International Credit Card
104 FR Y-14QRetaillntfm A5 International First Lien Mortgage
105 FR Y-14QRetailINTHE A4 International Home Equity
106 FR Y-14QRetaillntlothcons | A.6 International Other Consumer Schedule
107 FR Y-14QRetaillntsb A.8 International Small Business
108 FR Y-14QRetailStudent A.10 Student Loan
109 FR Y-14QRetailUSothcons | A.7 US Other Consumer
110 FR Y-14QRetailUssb A.9 US Small Business
111 FR Y-14QSEC B Securities
112 FR Y-14QSUPMNT K Supplemental
113 FR Y-14QTRADING F Trading
114 FR Y-15 - Banking Organization Systemic Risk Report
115 FR Y-15 A Size Indicator
- Financial Statements for a Bank Holding Company
116 FR Y-20 Subsidiary Engaged in Bank-Ineligible Securities
Underwriting and Dealing
117 FR Y-7N _ Erri?gcriwaéiﬁla(tiigeonrtgsa(;]fizua.tiso.nl\slonbank Subsidiaries Held by
118 FRY-7N IS Income Statement
119 FR Y-7N IS-A Changes in Equity Capital
120 FR Y-7N IS-B Changes in Allowance for Loan and Lease Losses
121 FRY-7N BS Balance Sheet
122 FR Y-7N BS-A Loans and Lease Financing Receivables
123 FR Y-7N BS-M Memoranda
120 | FRvms T | e e S o ek
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zlc;. Report Code ggr&idule Schedule Name

125 FR Y-9C - Consolidated Financial Statements for Holding Companies
126 FR Y-9C HI Consolidated Income Statement

127 FR Y-9C HI-A Changes in Holding Company Equity Capital

125 | FRvoc
129 FR Y-9C HI-C E(i)ssasgiiregated Data on the Allowance for Loan and Lease
130 FR Y-9C HC Consolidated Balance Sheet

131 FRY-9C HC-B Securities

132 FR Y-9C HC-C Loans and Lease Financing Receivables

133 FR Y-9C HC-D Trading Assets and Liabilities

134 FR Y-9C HC-E Deposit Liabilities1

135 FRY-9C HC-F Other Assets

136 FR Y-9C HC-G Other Liabilities

137 FR Y-9C HC-H Interest Sensitivity

138 FR Y-9C HC-I gsiLrj]rsaunr(;i-;(;Iated Underwriting Activities (Including

139 FR Y-9C HC-K Quarterly Averages

140 FRY-9C HC-L Derivatives and Off-Balance-Sheet Items

141 FRY-9C HC-M Memoranda

142 FR Y-9C HC-N Past Due and Nonaccrual Loans, Leases, and Other Assets
143 FR Y-9C HC-P é;%ii?glégiiziSential Mortgage Banking Activities in

144 FR Y-9C HC-Q g:;ie;s and Liabilities Measured at Fair Value on a Recurring
145 FR Y-9C HC-R Regulatory Capital

146 FR Y-9C HC-S Servicing, Securitization, and Asset Sale Activities

147 FR Y-9C HC-V Variable Interest Entities

148 FR Y-OLP _ ﬁzlrgir:]tg(?g?rﬁs;zi é)snly Financial Statements for Large

149 FR Y-9LP Pl Parent Company Only Income Statement
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zlc;. Report Code ggr&idule Schedule Name

150 FR Y-9LP PI-A Cash Flow Statement

151 FR Y-9LP PC Parent Company Only Balance Sheet

152 FR Y-9LP PC-A Investments in Subsidiaries and Associated Companies

153 FR Y-OLP PC-B Memoranda

154 FR-2052A - Complex Institution Liquidity Monitoring Report

155 FR-2314 _ (F)ipga:nﬁiziluitr?;ements of Foreign Subsidiaries of U.S. Banking

156 FR-2314 IS Income Statement (calendar year-to-date)

157 FR-2314 IS-A Changes in Equity Capital

158 FR-2314 IS-B Changes in Allowance for Loan and Lease Losses

159 FR-2314 BS Balance Sheet

160 FR-2314 BS-A Loans and Lease Financing Receivables

161 FR-2314 BS-M Memoranda

162 FR-2314S _ G?g.r%\/eigﬁgglzg%r:ri?zlaSti?;Zmems of Foreign Subsidiaries of
Weekly Report of Selected Assets and Liabilities of

163 FR-2644 - Domestically Chartered Commercial Banks and U.S.
Branches and Agencies of Foreign Banks

164 FR-2886B RI-A Changes in Equity Capital

165 FR-2886B RC-B Securities

166 FR-2886B RC Balance Sheet

167 FR-2886B RC-C Loans and Lease Financing Receivables

168 FR-2886B RC-M Claims on and Liabilities to Related Organizations

169 FR-2886B RC-N Past Due and Nonaccrual Loans, Leases, and Other Assets

170 FR-2886B RC-R Regulatory Capital

171 FR-2886B RI Income Statement

172 FR-2886B RI-B Changes in Allowance for Loan and Lease Losses

173 FR-2886B RC-A Cash and Balances Due from Depository Institutions

174 FR-2886B RC-L Derivatives and Off-Balance Sheet ltems

175 FR-2900 _ CR:zgr?rt of Transaction Accounts, Other Deposits, and Vault
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2 Getting Started

This chapter provides an understanding of the pre-requsites, general and data preparation assumptions
and logging into the application. It includes:

¢ Prerequisites

¢ Assumptions
¢ Logging in to the OFSDF Interface with Lombard Risk for US FED

¢ Organization of the Interface for User Roles

¢ Metadata Browser

OFSDF interface with Lombard Risk for US FED allows you to perform the following activities:

¢ Manage Data Loading and Transformation from various source systems to staging, processing,
and results.

¢ Manage relevant OFSAA metadata for regulatory reporting purpose. This includes creating,
modifying, and viewing the metadata used in reporting.

¢+ View the report metadata for mapping.
¢ Drill down from AgileREPORTER to OFSAA results area.

2.1 Prerequisites

The prerequisites are:
¢ Oracle Financial Services Analytical Applications Infrastructure (AAl) is deployed and configured.
¢+ Oracle Financial Services Data Foundation is deployed and configured.
¢ Processed data required for reports as per the release scope.

¢ Ensure that the report templates for AgileREPORTER ARforFED_v1.9.2.6.zip is available in the
AgileREPORTER.

¢ Ensure that AgileREPORTER version 1.15.4-b1112 is installed.

¢+ Knowledge of working with regulatory reports.

2.2 Assumptions

OFSDF interface with Lombard Risk for US FED is a reporting application and it does not perform any
risk/stress calculations. Following listed are the assumptions for the application:

¢ Textual and other related portions of reports like person details, contact details, Yes / No choices
must be updated on Report Portal directly and FSDF does not have placeholder for it.

¢+ Data provided is post reconciliation to ensure that accuracy of data being reported (non-
prescribed by regulators) are performed in OFSAA using various components — General Ledger
(GL) reconciliation.
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¢ Validity checks such as edit checks, cross-validation checks and so on prescribed by regulator
are performed within the AgileREPORTER.

¢+ All monetory amounts are expected to be positive in number, except valuation outputs which can
be positive or negative. Rules are constructed assuming the negative sign of valuation amounts
wherever applicable.

¢+ The application populates few specific dimension tables, known as seeded / sample tables as
part of the installation script. Since they are used in the metadata, changes in data values have
impact on the overall functioning.

¢+ All percentage data are expected in decimal format meaning 9% must be provided as 9 and not
0.09.

¢+ For a data provided as of date, such as last day of the quarter of the reporting year: Quarterly and
Year to Date (YTD) report for the given date displays same value for those measures which are
of as of date in nature. For example, Annual and Quarterly Balance Sheet and BASEL reports
generated as of 31-MAR show same values for all measures such as Account Balance.

¢ Account Balances such as End of Period Balances are expected to be provided as Net of
(without) Unearned Income.

¢ In FR-2052A, for PIDs 1.0.9 and 0.0.22 there is no OOTB rule provided by OFSAA to identify
these PIDs. The accounts which must be reported under PIDs is purely Reporter’s Discretion. So
a Custom Rule can be built by the user to report these PIDs.

¢+ Reporting currency identification in FR-2052A must be done by populating setup_master table, in
which V_COMPONENT_CODE = 'ENTITY_REPORTING_CD' that is defaulted to ‘N’, must be
changed to ‘Y’ if the Reporting entity has greater than $700 billion in total consolidated assets and
greater than $10 trillion in assets under custody.

¢+ Data load for FR Y-14M Report must include all the loans closed from the previous month.

¢ In FR-2052A, few  Processing Dimension  tables like DIM_ASSET_LEVEL,
DIM_RESULT_BUCKET are used. These tables contain values other than the ones required by
Lombard Field Structures template provided by Lombard as they are consumed by the
processing application too. For example: Seeded Script of DIM_ASSET_LEVEL has node values
not to be considered for FR-2052A. Only following values must be considered for FR-2052A
execution from DIM_ASSET_LEVEL table.

V_ASSET LEVEL CODE
A-0-Q
A-1-Q
A-2-Q
A-3-Q
A-4-Q
A-5-Q
S-1-Q
S-2-Q
S-3-Q
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V_ASSET _LEVEL CODE

S-4-Q

G-1-Q

G-2-Q

G-3-Q

S-5-Q

S-6-Q

S-7-Q

1G-1-Q

E-1-Q

E-2-Q

S-8

G-4

E-3

E-4

1G-2-Q

IG-3

1G-4

IG-5

IG-6

IG-7

N-1

N-2

N-3

N-4

N-5

N-6

N-7

L-1

L-2

L-3

L-4

L-5

L-6

L-7

L-8

L-9

L-10

L-11

Y-1

Y-2

Y-3
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V_ASSET LEVEL CODE

C-1

Z-1

S-7

G-3

G-2

E-2

A-3

A-0

S-2

IG-1

S-6

S-5

A-2

S-3

A-5

E-1

G-1

S-1

A-4

A-1

S-4

1G-2

¢ For FR-2052A for DIM_RESULT_BUCKET, values under v_bucket_type = ‘FRY2052A’ should be
considered, rest of the values can be ignored as they are consumed by the processing
application.

¢ For FR-2900, deposit data is expected to be provided on net or reciprocol basis in applicable
cases as per regulatory instructions.

¢ For FR-2900, regulatory template needs to update the CEN Code 1, 2, 3 or Blank for each
branch.

a. Code 3is for non deposit office, 2 is for consolidation office and 1 is for estimated
deposits. For actual dpeosits, code should be left blank.

b. Integration Pack handles code 2 and code 3. Assuming all deposits are actual since this
is been sourced from granular data, this code is left blank by default. For some branches,
if you want to make it as estimated deposits, code 1 must be added manually in
AgileREPORTER.
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2.3 Logging in to the OFSDF Interface with Lombard Risk for US FED

After the application is installed and configured, to access the OFSDF Interface with Lombard Risk for US
FED application you need to log into OFSAAI environment using the OFSAAI login page.

To access application follow these steps:
1. Enter the OFSAAI URL in your browser. The OFSAAI login page is displayed.

Financial Services Analytical Applications

ORACLE

Language Us-English v
User ID |

Password

ORACLE

2015 Oracle andior itz affiliates. All rights reserved

Figure 2: OFSAAI Log in

2. Select the desired language from the Language drop-down list.

3. Enter your User ID and Password. When you log into OFSAAI, the first screen is dsplayed.

M v A& v | usengenv | RROFUSER ¥

ORACL € Financial Services Analytical Applications

Applications | bject A

ontguration & Identty Management

Select Applications.
Financial Services Data Foundaton v " ﬁ Financial Services Data Foundation
Financisl Services Data Foundstion

> Data Model Management » Eﬁ Data Management Framewark
Managpe Dats Model Mansge Dats movement utang framework for Data Mansgement
. b =] uniied Anatytical Metagata .ﬁ Rule Run Framework
2 (R niruas Metadeia Marnsgurmect Define and maintain snatytcal metsdats defnbons ::::-;:o::;::::::::;dt and somplex business logio in o Rules,
G s
@ Derived Entay " @ Opesations ,E‘i Settings
Tosis for Data Center operations Seffings
3
ﬁ Metadata Browser

Browse metadats inesge

¥ W anmiytcs Messaata
v B e Rum Framewerk
» BB oparsions
» B semings

D Mietadiats Fopazer

Figure 3: Landing Page
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2.4 Organization of Interface for User Roles

This section explains the various features used by a analyst. It describes the organization of the user
interface and provides step-by-step instructions for navigating through the application to carry out these
activities.

Data Analysts are expected to perform the following activities:
1. Marking Run as Final
2. Executing Batch to Refresh Derived Entities
3. Drill Down from AgileREPORTER to OFSDF
Reporting Analyst are expected to perform the following activities:
1. Drill Down from AgileREPORTER to OFSDF
2. Using Metadata Browser to check Schedule Wise metadata

3. Using Metadata Browser to check metadata usage across schedules

2.4.1 Marking Run as Final

Various applications provide data for regulatory reporting. You must mark specific executions for
regulatory reporting as final run.

Bl v X v | usengishv | OFsAD ¥

ORACLE Financial Services Analytical Applications

Objest System Configuration & Identity My Inbox

Select Applications Financial Services Data Foundation » Run Management > Run Management

Financial Services Data Foundation

4 @ Financial Services Data Foundation
» B Data Model Management
» B 0ata Management Framework
» [E unifies naiytical Wetadata
» B Ruie Run Framework
4 B Run Management
B3 Run Management

» [ operations
» B settings

&8 Wetadata Browser

v

» Search
Segment FSDFSEG v

Run Type

l

4 List of Runs

No Records 1o Display.

S01t000f 0

| B & |

Figure 4: Run Management Summary Screen
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‘2 Run Execution Summary - Windows Internet Explorer s

Run Execution Summary
Run Name \US FED Runz Run ID 1485798454288
Run Type BASELINE RUN

# Run Execution Details S]]
Run Skey Run Exeoution Id FIC MIS DATE Execution Status Execution Date Time of Execution

7] 127004 1465788710479 08/20/2013 COMFLETE 08/13i2018 11:48:30

Reporting Flag Details

Figure 5: Run Management Summary Screen

2.4.2 Executing Batch to Resave Derived Entities

To execute the batch to refresh derived entities, follow the below steps:
1. Navigate to Financial Services Data Foundation = Operations 2 Batch Execution

2. Select the batch <<INFODOM>> USFED FFIEC031 RESAVEDE to resave all the DEs used in
FFIEC 031.

3. Similarly “<<INFODOM>>_USFED_FR2314_RESAVEDFE”,
“<<INFODOM>>_USFED_FRY11_RESAVEDE” can be used to resave DEs related to 2314,11
respectively.
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Figure 6: Batch Maintenance Screen
4. Monitor status of the batch using Batch Monitor link.
5. The batches available for this release are:
a. batch_resave de usfed_ffiec031
This batch saves the Derived Entities of FFIEC 031 report.
b. batch_resave de_usfed fr2314
This batch saves the Derived Entities of FR 2314 report.
c. batch_resave de usfed fryll
This batch saves the Derived Entities of FR Y-11 report.
d. batch_resave de usfed fry2052a
This batch saves the Derived Entities of FR 2052A report.
e. batch_resave de usfed fry2644

This batch saves the Derived Entities of FR 2644 report.
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f. batch_resave de_ usfed fry2900

This batch saves the Derived Entities of FR 2900 report.
g. batch_resave de usfed_fdic 8020

This batch saves the Derived Entities of FDIC 8020 report.
h. batch_resave de_usfed fry9C

This batch saves the Derived Entities of FR Y-9C report.
i. batch_resave de_ usfed fryldm

This batch saves the Derived Entities of FR Y-14M report.
j. batch_resave de usfed fryldq H1H2

This batch saves the Derived Entities of FR Y-14Q_H1H2 report.

2.43 Logging to AgileREPORTER to Retrieve the Returns

The Retrieve Return functionality in AgileREPORTER fetches data from OFSAA derived entities and
embeds them on AgileREPORTER templates. This runs the decision table process in Lombard Risk. You
can view the relevant OFSAA data on various schedules of the AgileREPORTER using this functionality.

Lombard Risk | Dashboard XBRLChecker | - himadmin | £ @
Show Deleted Returns Delete Retumn Log 1 Create New E§ import adjustments Export To Regulator Format & Export @) Retrieve Retumn
GETIEED WORKFLOW STATUS
ENTITY ~ RETURNS VERSION REFERENCE DATE JOB STATUS UPDATE  APPROVAL EDITIONS ~ TRANSMISSION ~ MODIFIED MODIFIED BY

US FED Reserve v LvXAE

us EFIEC031 4 3000972013 ® {3y Undate  NO ATTESTATION NEEDED 12/09/2016 112159 RPADMIN

a

Eniity

S us EFIEC041 4 3000972013 ® {3y Undate  NO ATTESTATION NEEDED

14/09/2016 12:01:45  RPADMIN

a

us ERYIC 2 300972013 ® € Undale NO ATTESTATION NEEDED 0B/09/2016 11:41:04  RPADMIN

o

Form
3
All 1
Retrieve Return
Available date Entity
All

Reference Date
Form

Log level

=l
—

Figure 7: Retrieve Returns Page

2.4.4 Report Verification - Drill Down from AgileREPORTER to OFSAA Results Area

Drill down functionality enables the user to view the accounts included in the aggregation. Following these
steps to drill down from AgileREPORTER to OFSAA:

1. Loginto the AgileREPORTER.
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Lombard Risk

Lombard Risk

AgileREPORTER®

Automated regulatory compliance

Highly scalable for global volume processing capability enables AgileREPORTER to be extended for
other business units and geographies as business requirements evolve

Sign in

Usemame

Password

Figure 8: AgileREPORTER Login page

2. The user can view the list of reports in the main page. Click any report name in the Returns

column, for example, FRY9C.

Lombard Risk | Dashboard
Show Deleted Returns
Regulator
ENTITY RETURNS < VERSION ¢ REFERENGCE DATE ¢
US FED Reserve v
us EFIEC031 4 30/09/2013
Entity
us FFIEC041 4 30/092013
us v
us ERYOC 2 30/0072013
Form
All v
Available date
All v

Delete Return Log

WORKFLOW STATUS
JOB STATUS
LVXAE

&) Create New

Job Manager

~ Export To Regulator Format

3 import adjustments

UPDATE  APPROVAL EDITIONS
() Undate  NO ATTESTATION NEEDED

() Update  NO ATTESTATION NEEDED

(y Undate  NO ATTESTATION NEEDED

1 15 v

XBRL Checker

3 Export

#* @

@) Retrieve Return

~ hi padmin

TRANSMISSION ~ MODIFIED MODIFIED BY %

12/09/2016 11:21:59  RPADMIN ]
14/09/2016 12:01:45  RPADMIN |
08/092016 11:41:04  RPADMIN &

Figure 9: AgileREPORTER Main Page

3. The schedule list is displayed in the
Schedule HC-E.

left hand side. Click any schedule name, for example

Lombard Risk  FRYSC v2 Us FED Reserve/US 300092013

A show Import Log

~ Adjustments ~ ExportToFile  + Export To Regulator Format

Type "Yes" or "No into the box below (default valu

Include Current years PAL [

Advanced Approaches
I the raporting institution an advanced
approaches institution?

(1for Yes, 0 for No)

Exit Parallel Run
Has the reporting institution completed
parallel running?

(1 for Yes, 0 for No)

Grandfathered unitary and insurance
SLHC

I the reporting institution a grandfathered
unitary SLHC or insurance SLHC that is
not required to file HC-R?

(1 for Yes, 0 for Noj

No Attestation Needed

&) Live Validation

Show Scale

&) Validate Now

~ Workilow

Editions | 08/092016 11:41:04 #8

Special Rounding
Indicates if the special rounding for reporting

institutions with 10 bln and more in assets

is enabled (1 for Yes. 0 for No)

BHCs, SHC or covered SLHC

Is the reporting institution a BHCs, SHC or
covered SLHC as defined by the final capital rule?
(1 for Yes, 0 for Noj

Any adjustments to aditional tier 1 capital related to changes in the fair value of liabiliies
that are reported in item 24 during the transition

Bl Wil [ Thou

(%) Wanage

= (O Edtions

Instances 1 -0

Pages

o
o
o

W2
Cover

Seh HI (1 0f4)

Sch HI (2 of4

Seh HI (3 of4)

Sch HI (4 of4

SehHIA

Sch HI-B (1 02

Sch HI-B (2 of 2

SchHI-C

Notes o Income Stmt (1 of 3
Notes to Income Stmt (2 of 3
Notes o Income Stmt (3 of 3.
SchHE (10f3

SchHE (2 0f3

Figure 10: AgileREPORTER Page Displaying List of Schedules
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Click any cell to drill down.
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Figure 11: AgileREPORTER Schedule Details Page

Figure 12 displays drill down for the first cell in Column A. The OFSAA icon is displayed. It
provides information about the amounts against different MDRM codes here. In the figure, the
first MDRM code — BHCB 2210 indicates the amount of deposits held by the bank that are of nhon-
interest bearing variant. Click the cell, and the OFSAA icon, to view how this cell was populated
from OFSAA results. You are redirected to the OFSAA drill down page.

(@ | A Show Impart Log - Agustmenss « ExpotToFle 5 LveVasdation &Y Valdato Now - Workiow
Edtions 11112015 1311599 - Lo instances 1 | 0
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Figure 12: AgileREPORTER Drill Down
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6. This cell is populated from the derived entity mentioned in the grid header DE — Deposit Liabilities
— Schedule HC-E. The value in the derived entity grid 333,220.00 must match with that of the cell
in the report. Derived entity is an aggregate built on top of OFSAA results model to serve

regulatory template requirements.

It is built using dimensions, measures and business

processors. The dimensions that participates in determining the cell value is displayed with data.
Click the derived entity link in the grid header.

Date Lineage

- Darived Entity : B - Oeconit Lisbilities - Gcheduis NE-E (1)
Gaoqraphy - Branch Country Depons Type Hierarchy e s - OO

Entsy T

Mermchy

Figure 13: Data Trace Browser/ OFSAA Report Drill-down Screen

7. Derived entity details are displayed in the Metadata Browser within the page. Scroll to view
complete details such as Datasets, Hierarchies, Measures and so on. Click the measure value in
the derived entity row, for example 333,220.00.

Data Lineage

Derived Untity : DL, Broonid Liakiliies o Schedule HTL il

Deisls.  Foadaics o Trad
Darrved Enisty Properbes (3)
tare
el Typsh
Agrepase Fag
[CE R

Depends on (13) /3

Darived Eatity

Jamp o Page

Hisrunciry

Lon Dalacce BLY - Deocaiy
Bosvevenas

ERER Al

Figure 14: Derived Entity MDB View
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Double-click any figure in the screen to drill-down to the fact tables. The below grid displays the
detailed granular rows of fact data that comprises the derived entity aggregate. The number
333220 is now seggregated down to 10 records with different balances. Scroll to the right in
second grid to view measure values.
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" Rerived Intity : DL - Deponil Lisbilitian 11 .= § i
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Hierprhy Borrowings
. - T mzme
ry
©)
* Datasel:DE - Dgpopil Lisbilties - Schadyle HC-E (LL] &
Band Short fesorgtien  Entde Type Descriphion | Baanch Degoription  Legwl Enfity Coge | ProduciNams ERM  Deposil tvpe gescriplon
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S0G o
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Figure 15: Drill Down Page
Click Attribute Selector icon on the header of the second grid.
Data Lineage 0

-
= Allnibute Selecioc
-9 Sewcied AdrEeten
Avstabe Ateun
Derived Entity : DL Qenoad Mabsiies . 55
Gacarante - Branch Country Repcatt Troe td

" Datanet : DA Renoai bsabiliiies . Scheduld
Bend StoqOescnpion  Consy Type Descronon

Figure 16: Drill Down Attribute Selector 1
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10. Expand Data Origin Dimension and select Data Source name. Click OK.

= Atnbute Seleclor

Lewcies ADBuer

" Derived Entity : RE - Degonit Lishilklies - Sc)
- Beanch Country Degoss Type Hd

“ Dataset: DS - Deposil L

VIS Dark satacares
Bark ratrcare
* »
" a4 stacares v
Bans
oK [
---- Do pp g o oAty o
24 rtecdormy > v mard Sepos Besece
2 Bask C wrd Orcaad .
NESNG Bacs stacares Brasch US! NTSLADA Demans Seccaty Basewre
Ba0h stacarws Beaach US1 s NTEEARA Dewuend deceats Gasere
v

Figure 17: US FED Drill Down Attribute Selector 2

11. If account number is required, scroll and expand the account dimension. Select account
number/contract code and click OK. Data source and account / contract code is displayed in the
drill down grid.
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Figure 18: Drill Down - Granular
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2.5 Metadata Browser

This section helps you to navigate through Metadata Browser and guides you in tracing the source of the
metadata. The Metadata Browser function allows you to view and analyze all aspects of the metadata
used in the OFSAAI. It provides extensive browsing capabilities of metadata, helps in tracking the impact
of changes to metadata, and trace through to the source of originating data.

Metadata Browser (Object and Application View) provides common repository of metadata objects
created in OFSAAI and applications hosted in OFSAAI. Using this view, you can identify the usage of
base objects in higher level objects and the mapping of Objects to Application, thus enabling traceability.
It also allows you to view the data flow and the work flow of the application and understand the usage of
objects within the application.

The new visualization of Metadata Browser (MDB) supports Application view and Object view. In
Application view, you can browse through the metadata created using the applications hosted in OFSAAI.
In object view, you can view the metadata created in OFSAAI.

To access the Metadata Browser (Object and Application View), your role must be mapped to the
SCR_MDB function.

Analysts review the metadata used for a particular report schedule to verify the data. Data verification
may require looking for metadata used in given schedule or it can be schedules in which particular
metadata is used. Data Analysts and Reporting Analysts perform the report verification. Metadata refers
to business measures, hierarchies, data sets, derived entities used for a given schedule.

To use MDB for schedule wise metadata, and to use MDB for metadata wise schedule follow the below
steps.

1. To use MDB for schedule wise metadata, for a given schedule, identify the metadata used.

a) User can verify the data for related data elements in results using this information.
Navigate to path Objects 2 OFSAA Data Model 2 Reporting Metadata 2 Reports.
The Left Hand Side (LHS) displays the list of reports. For example, Figure 19 refers to
HC-E Schedule of FRY9C report.

Datads | Stasstcs | AustTrab
= Report Properties (1}

= Depends on (1)

aaaaaaaaa

s pudppooooooouoooooooo

i E

8

Figure 19: MDB - Reporting Metadata - Schedule View 1

Oracle Financial Services Software 36



OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
User Guide, Release 8.0.4.1.0

b) Click the object view FRY-9C-HC-E. The Report Details page is displayed.
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Figure 20: MDB - Reporting Metadata - Schedule View 2
You can view the below information in the Details tab:

¢+ Reporting Elements: This section displays the line items in report with regulatory
references.

¢+ Depends On: This section displays the metadata used in a given schedule.

c) Click any Reporting Element. For example, BHCB2210. The following page is displayed.

[ Last Executed Date : 17.46v.2015 120929 User: idfuser  Connected To: OFSFSDFMIFO
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Figure 21: MDB - Reporting Metadata - Schedule View 3
You can view the following information in this page:

¢ Reporting Element Properties: It provides information on line items or cell
references in regulatory reports.

Table 4: Fields and their Descriptions in Reporting Element Properties
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Fields

Description

Derived

Provides information on whether the cell is derived / computed using
other elements.

Confidentiality

Refers to regulator specific interpretation. For MDRM codes, it
indicates whether the MDRM codes is confidential for disclosure within
a specific report.

Notes

Refers to regulator specific interpretation. For MDRM codes, this field
provides a detailed description of a given cell reference.

Start Date

Refers to regulator specific interpretation. For MDRM codes, this field
refers to the effective date of particular cell reference in case.

End Date

Refers to regulator specific interpretation. For MDRM codes, this field
refers to the effective end/ sunset date of particular cell reference.

¢ Dimension Filters:

This section displays the dimensions and node value filters used

to derive a particular cell.

¢ Depends on: This section displays all the hierarchies (dimensions, filters) and
business measure used for arriving at a particular cell/ MDRM code.

2. Starting from a common metadata used across applicaiton, you may want to know the list of
reports/ derived entities this metadata has used. Let us take an example of measure. To use
MDB for metadata wise schedule, for each metadata, identify the schedules in which it is used.
Follow these steps to identify the schedules:

a) To view the measures,

navigate to path Objects = OFSAA Data Model = Business

Metadata = Measures. The LHS displays the list of measures. For example, Figure 22
refers to Eop Balance RCY - Deposits Borrowings.

ORACLE

Applications (0)

Risparing Element
Rzperting Element
Rieporting Element

Figure 22: MDB - Business Metadata - Measure View 1

You can view the below information in this page:
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¢ Measure Properties: It provides information on properties of Business measures.
For example aggregation function, Measure Data Type, Business Exclusions, Filter
and Rollup Type.

¢ Depends on: This section displays all the object names and their types, such as
Entities, Columns and so on.

Follow these steps to view the derived entities used in a given schedule:

Note: The similar steps as below are applicable for other metadata such as Business Metadata
(Hierarchies, Measures, Variables and so on) and Derived Metadata (Dimensions, Filters and so
on).

a) To view the schedule wise derived entities, navigate to path Objects > OFSAA Data
Model - Derived Metadata = Derived Entities. The LHS displays list of Schedules.
For example, Figure 23 displays the derived entities used in Schedule HC-E:

ORACLE

Metadata Browser Last Executed Date : 17-H0v-2015 120929 User: mdfuser Connected To : OFSFSDFNFD.

Derived Entity

Dolals  Stafstos | Audd Tral
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1 Jump 1o Page s
Onject Type

Hierarchy

1 Jump to Page =
Objact Type

Reporiing Element
Reparting Element
Reporing Element
Reporing Element

= Applications (0)

Figure 23: MDB - Business Metadata - Measure View 2
You can view the following information in this page:

¢+ Derived Entity Properties: It provides information on properties of derived entities,
such as Source Type, Aggregate Flag, and Materialized View.

¢+ Depends on: This section displays all the object names and their types, such as
Measure, Hierarchy, and so on.
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3 Regulatory Reporting (REG REP) Solution Data Flow

This chapter provides an understanding of the data flow. It explains what happens within data flow and
how various processing aspects are integrated with the overall data flow.

It includes:

¢ Data Preparation

¢ Mapping of Results to Line Items in Reporting
¢ AgileREPORTER: Submission

3.1 Data Preparation

This section explains the input data preparation from OFSAA. It includes:

¢ Assumptions for Data Preparation

¢ Run/Execution Expectations

¢ Projection Data

¢ Data Flow from Sources Systems to Staging Area

¢+ Data Flow from Staging to Results Area

¢+ Data flow from Staging to Processing Area

¢ Data Flow From Processing to Results Area

¢ Dimension Tables/Entities

3.1.1 Assumptions for Data Preparation

1. REG REP is a reporting solution, which uses data from underlying fact tables directly for
reporting. The end user is expected to prepare the load for the required data in reporting area
accordingly. Although this has a thin processing layer to reclassify to regulatory dimensions and
bands, all the processing measures are expected to be from respective applications and provide
as required.

2. ltis integrated with results area of the respective processing application, and any change in the
underlying processing can disturb the REG REP data sourcing.

3. Baseline and stress data must be populated with appropriate codes. Inaccurate mappings may
can lead to inaccurate results. For details please refer to Relationship between Run and Stress.

4. For usage of consolidation dimension (which has values like Actual, Budged, Forecast, and so
on), all historical data is expected to be tagged as actual for the purpose of reporting vintage
data, as per report requirements. For projection data, for a given run and Projection Period
(quarter/year), only one set of data is expected to be stored.

5. All processing reporting requirements requiring cashflows, integration package expects bucketed
cash flow as a input (meaning a time bucket for cash flow and cash flow amount is expected as
input).
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6. The table FSI_CAL_MIS_DATE_MAP(D_CALENDAR_DATE DATE, D_MIS_DATE DATE) must

be populated for Reports — FR-2900, FFIEC-031 RC-K, FFIEC-041 RC-K, FRY-9C HC-K,
FFIEC-031 RC-O, and FFIEC-041 RC-O.
FSI_CAL_MIS_DATE_MAP is an entity used to generate the quarterly average report with two
date columns: D_CALENDAR_DATE and D_MIS_DATE.
a. D_CALENDAR_DATE holds the date details for the calendar year. This includes holiday
date.
b. D_MIS_DATE holds the effective date to be considered for quarterly average report
generation. This column is excluding holiday date.

If calendar date falls on an holiday, then D_MIS_DATE has value (date) for the last working date
or any other date value as per client's requirement.
The above mentioned reports will be generated only if FSI_CAL_MIS_DATE_MAP is populated.

Example for data in FSI_CAL_MIS_DATE_MAP:

D_CALENDAR_DATE | D_MIS_DATE | Comments
05-Jan-17 05-Jan-17
06-Jan-17 06-Jan-17

There is no data loaded from source. Consider balance from
07-Jan-17 06-Jan-17

06-Jan-2017 for 07-Jan-2017.

There is no data loaded from source. Consider balance from
08-Jan-17 06-Jan-17

06-Jan-2017 for 08-Jan-2017.

3.1.2 US FED RUN CHART

Oracle Financial Services Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
provides the US FED RUN Chart listing the tasks required for population of data for US FED Reports.
This covers the following tasks:

¢

¢

¢

¢

¢

¢

¢

Set up table population

Stage Dimension Load

Seeded Dimension Data Population

Common data Population

Common Tasks like Exchange Rate Population

US FED Specific Data Population and Transformation

Derived Entity Refresh

Download the US FED 8.0.4.1.0 RUN Chart from the MOS.
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3.1.3 Run/Execution Expectations

Run refers to execution. It is assumed that at different time periods, different combination of parameters,
and different data require different executions. From a reporting perspective, as required by regulators,
RRDF application requires data for the following executions:

1. Current Data / Execution
a. Reporting month end data
b. Projection Data
2. Historical (trend/vintage) Data
a. Yearly
b. Quarterly
3. Stressed Data

3.1.4 Consolidation

Consolidation is handled as part of Financial Services Data Foundation (FSDF). Consolidation in FSDF
refers to elimination of intra company transactions, that is, any kind of transactions between two parties or
entities which are part of the reporting organizational hierarchy for a given execution. When there is only
one legal entity involved in a execution it is called as SOLO Entity vs earlier one as CONSOLIDATED
Entity.

It is expected that in staging area, customer loads the data from source system and then uses
consolidation logic to arrive at consolidated output for results.
¢ Scope of consolidation is about list of Entities which participate in consolidation.

¢ Legal Entity Structure is looked through ORGANIZATION STRUCTURE DIMENSION. This
stores parent-child relationship. This is stored only once.

¢+ While moving the data, Legal Entity can move related entities to processing/reporting area.

¢ Legal structure being finalized once, this structure only stores one parent-child relationship.
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Ultimate Parent

(BHC)

v ‘I/ v

Parent A (Bank) Parent B (Bank) Parent C (Non Bank)

Figure 24: Consolidation

¢+ Transaction / exposure between SUB 1 and SUB 2 should be eliminated while reporting for
Parent A.

¢ Transaction / exposure between SUB 1 and SUB 3 should not be eliminated while reporting for
Parent A.

¢ Itis customer for banking products and issuer for traded securities which are considered for the
intra company elimination.

Consider the following example:

FSDF AREA ENTITY CODE ACCOUNT NUMBER | CUSTOMER | ISSUER
STAGE LOAN CONTRACTS SuB 1 ACCOUNT 1 SUB 2

STAGE LOAN CONTRACTS SUB 1 ACCOUNT 2 PARTY 1

STAGE INVESTMENT SuB 1 ACCOUNT 3 PARTY 1 SUB 2
CONTRACTS

FCT COMMON ACCOUNT SuB1 ACCOUNT 2 PARTY 1

SUMMARY

FSI INTRA COMPANY ACCOUNT | SUB 1 ACCOUNT 1 SUB 2

FSI INTRA COMPANY ACCOUNT | SUB 1 ACCOUNT 3 PARTY 1 SUB 2

As shown in the precedding table, Account 1 is moved to FSI INTRA COMPANY ACCOUNT as and
Account Summary tables. Run Enabled tables contain records specific to selected legal entity and
consolidation type.

Consolidation is also linked to multiple hierarchies banking organizations have. Multiple hierarchies refer
to the different grouping of group entities under different parent for a given regulatory requirements.
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Refer to the following representation where FR Y-9C and FR-2052A are two regulatory reporting
requirements.

FRY 9C FR2052a

Ultimate Ultimate
Parent Parent
(BHC) (BHC)
! ) { y
Parent A Parent C Parent A Parent B Parent C
(Bank) (Non Bank) (Bank) (Bank) (Non Bank)

007 SUB3 fo0% SUB1 E?

L_J ‘ 3 : e SuB 6
100°%4 100% 100%- 0% 100% 100%

Figure 25: Consolidation with Multiple Hierarchies

Consolidation percentage refers to percentage of asset or liability of child entity that is brought under
parent heading. Except for Joint ventures and similar organization structures, child entities are moved
under parent or they are not. This means consolidation percentage is either 100% or 0%. For
proportionate consolidation (Joint venture is an example for this), given child is moved under two parents
with all assets and liabilities divided as per Joint venture agreement. Currently, in FSDF 804,
proportionate consolidation is not handled.

Hierarchy structure is thus primary input to the consolidation process. Depending on whether end user
has multiple hierarchies or not there two data flow.

Consolidation with Multiple Organization Structure Hierarchy:
1. End user loads Organization Structure Hierarchy to STAGE ORG STRUCTURE MASTER table,
which is moved to ORG STRUCTURE DIMENSION using SCD component.

2. Execution specific organization structure hierarchies along with parent and child entity codes are
populated in STAGE LEGAL ENTITY HIERARCHY INTERFACE table, which is moved to LEGAL
ENTITY HIERARCHIES DIMENSION using SCD component.

3. Execution specific Consolidation percentage is loaded in STAGE ENTITY CONSOLIDATION
PERCENTAGE table, where child entity code, parent entity code and consolidation percentage is
populated. This is moved to FACT ENTITY CONSOLIDATION PERCENTAGE table using Table
to Table transformation. In FSDF 804 release, this feature is not supported yet.

4. The STAGE LEGAL ENTITY HIERARCHY is used for the Consolidation process and not the one
from ORGANIZATION STRUCTURE DIMENSION.
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FCT_REG_ACCOUNT_SUMMARY

DT

Run Execution Parameters

Calendar date

Reporting Entity

Consolidation Type

9

[| Consolidation Hierarchy

*
9

s
Reporting Currency

FCT_REG_RUN_LEGAL_ENTITY_MAP

Figure 26: Consolidation with Multiple Organization Structure Hierarchy
5. If the end user does not have Multiple Hierarchy, STAGE LEGAL ETNTITY HIERARCHY which is
used for the Consolidation process can be populated from ORG STRUCTURE DIMENSION

instead of the STAGE LEGAL ENTITY HIERARCHY.

FCT_REG_ACCOUNT_SUMMARY

Run Execution Parameters

Cansslidation Typ

W

»
s
n jon Type

FCT_REG_RUN_LEGAL_ENTITY_MAP

Figure 27: Consolidation without Multiple Organization Structure Hierarchy

NOTE: A Solo Run does not require any type of consolidation of elimination of accounts with other

entities.
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Additional Data Preparations to handle Consolidation

The entity FCT_REG_RUN_LEGAL_ENTITY_MAP is used once end user selects REPORTING ENTITY
from AgileREPORTER. This table is populated as part of USFED Run Execution.

RUN TYPE FIC MIS DATE REPORTING ENTITY RUN EXECUTION
SOLO 20151231 LE1 12
SOLO 20151231 LE2 14
CONSOLIDATED 20151231 LE1 16
CONSOLIDATED 20151231 LE2 16
CONSOLIDATED 20151231 LE3 16

For solo run, only one reporting entity is expected to be included whereas consolidated run includes all
entities involved in execution. This entity provides flexibility to select one REPORTING ENTITY in
AgileREPORTER and select relevant data for the particular execution based on if it is consolidated or
solo.

3.1.4.1 Relationship between Run and Stress

The REG REP application for example in FRY 14 Annual, picks up reporting data based on the Reporting
Run that populates the underlying Fact Table(s). Reporting Run is a flag, which must be marked as 'Y' in
a DIM_RUN table so that, the OBIEE reporting layer selects a particular run execution.

In this application, a Run comprises:

a. Baseline Run: The Bank Holding Company (BHC) may have multiple runs. The run used for
reporting is marked with a Reporting Flag = Y. This is the Baseline run for a given reporting
date. It is referred to as Baseline because the values that it represents are not stressed and the
BHC may use these base values for stressing them according to various scenarios. A history of
such runs accumulated over period of time provides historical runs. For more information on
updating the reporting flag, refer section Updating Reporting Flag.

b. Stress Run: Stress runs hold data, which are stressed by a certain percentage/basis point over
the Baseline figures. The BHC expects these figures to reflect the business/risk position under
predetermined business scenarios/economic conditions.

c. ldentification of Baseline and Stress run occurs from STRESS DIMENSION.

In this application, the required stress runs are tagged to a Baseline run. If the BHC performs several
stress runs, the relevant runs which are intended for reporting are identified and tagged with a reporting
Baseline run using the V_RUN_ID in the DIM_RUN.

DIM RUN stores n_run_skey / v_execution_id, which are execution specific for every run definition which
is v_run_id. Therefore, the run definition can remain constant over a period of time and different
executions provide different outputs due to underlying data changes.

DIM_STRESS conveys the stress definition. Additionally, it links the original run Definition (v_run_id) and
Stressed run ID (v_stressed_run_id). You must refer to the DIM_RUN table to get expected run execution
of these runs definitions pertaining to a particular date / n_mis_date_skey.
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The same fact table stores both the Baseline data and the Stressed data, uniquely identified through
Scenario codes (and Run skeys).

Refer to the Business Metadata.xls present in the installer package for details on different Fact tables
used for related reports.

3.1.5 Projection Data

The following points provide information on the projection data:

1
2.
3.

Baseline run also populates projected date data.
This application requires projected data at two levels - Quarterly and Annual.

The DIM_CONSOLIDATION table is used to identify the projections. It contains the codes for
projected quarters and years as required by the templates.

In the Fact tables, projection data is referred with respective Consolidation codes (scenario code
for FCT_MGMT_REPORTING). BHC must populate the data accordingly.

In the following example, FQ1 means Financial Quarter 1, FY1 means Financial Year 1 and so on.

Table 5: Projection Data Example 1

gggzolidation gggsﬁggsﬂon Reporting Line Scenario EOP Balance
100 Actual 100 BSL 426,367
400 FQ1 100 BSL 608,618
401 FQ2 100 BSL 870,502
402 FQ3 100 BSL 567,736
403 FQ4 100 BSL 846,196
404 FQ5 100 BSL 775,027
410 FY1l 100 BSL 470,092
411 FY2 100 BSL 473,880
412 FY3 100 BSL 942,034
413 Fy4 100 BSL 497,889
414 FY5 100 BSL 807,813
Note:

¢

For Movement measures data is not carried from one reporting period to another. For example,
Profit or Loss. Where General ledger balances such as loan outstanding are carried forward from
one year to another, profit and loss is period specific.

Therefore, unlike End of Period (EoP) balance, movement values for quarter actuals must be
derived for reporting. For a historical data, net sales for quarter 3 is the difference between sales
figure as of end of quarters 2 and 3. You do not need to provide this difference as a download.
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Movement data for actual is identified through different runs and the respective values is summed

up.

¢+ Only those records, whose corresponding runs fall between the fiscal month start date and end
date of the reporting quarter are selected for summation. Each Run has an associated date, and
runs can be performed daily. Assuming that runs are performed daily in a given quarter (90 days),
REG REP sums up data points across all 90 days to arrive at a quarter end movement figure.

Table 6: Projection Data Example 2

Code &rac;{'ggted Eienpeorting Scenario | Run ID Date Z;r?i) eucrt?d Movement
100 Actual 100 BSL RUNID001 | 10-Oct-13 | 300,000
100 Actual 100 BSL RUNIDO002 15-Nov-13 | 100,000

900,000
100 Actual 100 BSL RUNIDO003 20-Nov-13 | 300,000
100 Actual 100 BSL RUNID0O04 | 30-Dec-13 | 200,000
400 FQ1 100 BSL - - -- 608,618
401 FQ2 100 BSL - - -- 870,503
402 FQ3 100 BSL -- -- -- 567,736
410 FY1 100 BSL -- -- -- 470,093
411 FY2 100 BSL -- -- -- 473,881
412 FY3 100 BSL -- -- -- 942,035

¢+ However, when projection of net sales for quarter 2 next year is to be performed, no derivation is

required. Projections data for said quarter can be directly downloaded in the respective Fact
table(s) for reporting.

3.1.6 Data Flow from Source Systems to Staging Area

The staging area is populated with data from various data sources, such as GL data, Account data,
Customer data, Trading data, Currency data, and Master data. Refer to Data Integration Hub (DIH) User
Guide in OHC Documentation Library for details. DIH enables to load the data from the source systems to
the OFSAA staging tables, through logical interfaces, known as Application Data Interfaces (ADI). DIH
provides a set of User Interfaces (Ul), which is used to define and maintain External Data Descriptor
(EDD), Application Data Interfaces, and map the EDDs and ADIs through connectors.

3.1.7 Data Flow from Staging to Results Area

This section details the pass through data, transformed data and classification.
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3.1.7.1 Pass Through Data

Pass through data refers to the static data that is pre-processed and flows to the results area directly. The
Common Staging Area (CSA) model represents the data entry point into the FSDF. CSA provides a
simplified, unified data sourcing area for inputs required by analytical applications and engines. It consists
of over 400 tables and nearly 9000 columns organized into distinct subjects.

The staging area is a physical data model, which is deployed using the Analytical Application
Infrastructure, which manages it. The design of the staging area data model is to allow efficient data
loading for analytics. It thus has crucial differences from a general-purpose repository of
operational/transactional data across a bank.

The staging area acts as the single source of data, and contains unified data requirements for various
banking areas such as Loans and Losses, Off balance Sheet products, Securities, Derivatives, Capital
Data, Management Ledger and General Ledger. Common example of this category includes various
monetary amounts, dates and so on.

3.1.7.2 Derived / Transformed Data and Reclassifications

OFSDF Interface with Lombard Risk for US FED requires specific hierachies and dates to be transformed
and reclassified to regulator specific values.

Table 7: Data Transformation Example

Source Hierarchy Target Hierarchy

ISSUER TYPE = | INSTRUMENT RISK FACTOR = | INSTRUMENT DIM REG INSTR

US GOVT/ FED INTEREST RATE DERIVATIVE TYPE = | CLASSIFICAITON =US
SPOT GOVT SECURITIES

PROPERTY TYPE | LTV Ratio <2 DIM REG PRODUCT

= 1-4Units CLASSIFICAITON

For example, data from banks has attributes such as issuer type and bank instrument type. However,
these values are bank specific, and must be converted or reclassified to regulatory specific set of value
such as DIM REG INSTR CLASSIFICATION as mentioned above.

Reporting derived entities use this reclassified dimensions. Some of the reclassifications are performed in
the respective application area.

For example, DIM BASEL PRODUCT TYPE. This reclassification is performed in Basel application
processing and available for reporting directly.

Other transformations include various bands such as time to remaining maturity, time to next repricing
date, and so on.
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3.1.7.3 Re-classified to Regulatory Classifications

After transformation, the regulatory data is reclassified as follows:

Table 8: Data Reclassification Example 1

Source

Target

DIM PROPERTY TYPE | LTV Band Ratio

DIM REG PROD CLASSIFICAITON

1TO4UNITS

>2

1-4FAMCONLOAN

Table 9: Data Reclassification Example 2

FCT REG ACCOUNT SUMMARY

Account Number

REG PROD Classification

Residual Maturity Band Delinquency Band

1-4AFAMCONLOAN

1

The sample reclassifications performed to transform the existing hierarchies to regulatory specific

hierarchies are:

¢+ Regulatory Product Classification

* & & & O o o o o

Regulatory Instrument Classification
Regulatory Deposit Classification
Trading Account Book Type Classification

Claim Amount Population for Country Risk

Immediate Counterparty Classification for Country Risk
Claim Sector Reclassification for Country Risk

Risk Sector Reclassification for Country Risk

Cross Border Claim Reclassification for Country Risk
Guarantee Amount Population for Country Risk

The additional transformations that are performed are:
¢ Remaining Time to Maturity Band
¢ Next Repricing Date Band
¢+ Regulatory Delinquency Band

Within reclassification rules, few rules where source is customer specific values. In such cases, these
rules must be validated and updated as required by end user because Out of Box rule may differ from
what end user has. Such rules are very few and restricted to:

1. Standard Product Type Reclassification
2. Standard Party Type Reclassification
3. Regulatory Loan Purpose Classification

Refer Business Metadata for details of these reclassifications.
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3.1.8 Data Flow from Staging to Processing Area

The staging area of the FSDF serves as a container for analytical processing from sourcing to
consumption. Such processing is usually delivered in the form of discrete units called analytical
applications, spanning different analytical use cases ranging from Finance to Risk to Compliance.

These applications consist of custom-built computational engines and numerical libraries, and can
execute processes on the data that range from simple aggregations to complex, multi-step stochastic
processes such as Monte-Carlo simulation.

Hence, analytical applications place varying demands on the data infrastructure in terms of volumes and
speed, and hence place different demands on the data architecture. In practice, the normalized (3NF)
design favored for enterprise data warehouses often fails to be efficient or performant when it comes to
analytical processing across a wide range of use cases.

Therefore, the OFSDF recognizes the need for distinct application-specific working stores, separate from

the staging and reporting area. For example, the OFSAA Asset and Liability Management (ALM)
application has a distinct set of ALM-specific tables, as does the Market Risk solution.

Note: The structure of these processing area stores is decided by the actual analytical application and
engine used. The OFSAA suite of applications is organized this way, with each application managing a
specific set of tables/schemas within the processing area.

The processing area tables/schemas are not part of the OFSDF. This is because OFSDF is intended to
be an open platform. Other analytical applications and engines can equally provision data out of OFSDF
by mapping their input requirements appropriately to the OFSDF staging area model.

3.1.9 Data Flow from Processing to Results Area

This step is similar to Data Flow from Staging to Results Area. It involves either pass through data from
processing to results or loading directly to results (refer Section 3.1.10). This is mostly due to processing
measures such as Fair Value, Risk Weighted Assets, and so on.

3.1.10 Guidelines for Data Loading to Result Area Tables in Data Foundation for
Regulatory Reporting Implementations

Regulatory reports make use of data available across several fact tables in the OFSAA data foundation
model and these result tables are either loaded from the raw data sourced from source systems via out of
the box T2T’s or processed data output from various OFSAA applications.

For example, Fact LRM Account Summary (FCT_LRM_ACCOUNT_SUMMARY) which stores the liquidity
risk related attributes and metrics computed by OFSAA LRM application, Fact Loan Loss Forecasting and
Provision Account Summary (FCT_LLFP_ACCOUNT_SUMMARY) which stores the attributes and
measures computed by OFSAA LLFP application. However, there can be several implementation use
cases in the regulatory reporting space where customer may not have licensed any of OFSAA application
and hence must put additional custom effort to design an ETL process to load the required data elements
into the respective fact tables referenced by the report. The following section highlight some of the
guidelines that the customer can consider when designing a data flow for such a use case.
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¢+ Consistent Usage of Run Identifier

Most of the fact tables used in regulatory reporting are run enabled and have a composite primary
key inclusive of run identifier that enables same snapshot of data to be loaded multiple times into
the target fact table for any given execution date. All the out of the box processes that impact
data used in regulatory reports are executed as part of an integrated run to ensure that run
identifier is consistent across fact tables. Since the reporting is done on an integrated schema, it
is imperative for the custom data flow design to keep this integrity intact. This essentially means
that the custom ETL processes designed to load the data directly into the fact tables must be able
to leverage the run identifier generated by the run engine during execution. Run Identifier
information is available in DIM_RUN table.

¢ Correct Dimensional Lookup Configuration

Dimensional identifiers are typically part of referential integrity constraints with the fact table so
the custom ETL processes must ensure that lookups retrieve a valid surrogate keys for a given
value of business key. The intermediate staging structure must ensure all the business keys are
persisted correctly and the lookup condition is designed on the correct dimension table.

For example, FCT_LRM_ACCOUNT_SUMMARY.n_asset_level_skey >
DIM_ASSET_LEVEL.n_asset_level_skey. The business key (v_asset_level_code) must be
sourced and persisted to ensure correct values are populated in the target column, that is,
FCT_LRM_ACCOUNT_SUMMARY.n_asset_level_skey.

From OFSAA technical infrastructure standpoint, the mentioned options are available to the customer to
design and implement the custom ETL process explained above. OFSAA strongly recommends the below
options to maintain consistency in terms of data lineage in Metadata browser as the configured metadata
can be made available in meta model via MDB publish:

1. Data Integration Hub (DIH) Connectors

2. Data Mapping (T2T) option in Application Infrastructure

3. Data File Mapping (F2T) option in Application Infrastructure

3.1.10.1 DIH Connectors

For customer’s that have licensed DIH to source data from external systems into OFSAA , this probably is
the easiest approach to load data into the result area table. Source data could either reside in relational
structure or in a file structure. Mappings maintained in DIH are logical in nature while physical
implementation is managed internally. Dimensional lookups work seamlessly without the need for any
additional configuration in the connector mapping as this too is managed internally by DIH. Refer to DIH
user for details on how to load data into a result area table.
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Connectors

Connectors > Connectors (Definiion Mode) >
4 Connector Flow Diagram

5 Derniton 3 source =% Target [3  wapping Ef Propetties &7 summary

What are the objectives of this connector?

Which operafion should this c onnector perform on OFSAA?

®)Insert data Extract data

On w hich OFSAA module should this operation be performed?

®) staging Results

For w hich appiications (if any) shouid this connector be mapped?

v

For w hich External Data Stores (if any) should this connector be mapped?

v

3.1.10.2 Data Mapping (T2T)

Data Mapping refers to the process of retrieving unstructured data from data sources for further data
processing, storage, or migration. This feature is commonly known as RDBMS source to RDBMS
target(T2T) framework in the OFSAA world and can be leveraged when source data is available in Oracle
database. Dimensional lookups must be handled via the T2T’s join condition and expressions. Refer to
OFS AAI User Guide for more details on configuring a T2T.

3.1.10.3 Data File Mapping (Flat File to RDBMS Target - F2T)

If the source data is available in file structures, OFSAA F2T component can be used to bring the data in
the OFSAA eco system. As lookups cannot be configured in a F2T, this component must be used in
conjunction with T2T component, that is, data is first loaded from the file to an interim staging structure
using the F2T component followed by data load to the target result area table using the T2T component.
This is least recommended approach as there is need for interim table structure in data model and
involves multiple data hops which add to the overhead.

Refer to the OFS AAI User Guide for more details on configuring a F2T.
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3.1.11 FSDF Entity Information

3.1.11.1 Dimension Tables/Entities

Table 10: Dimension Tables/Entities

Sl. List of Seeded Tables Table/Entity Table/Entity Descriptions
No. Logical Names
1 DIM_ACCRUAL_STATUS Accrual Status This table stores the loan accrual status.
Dimension Values expected are :
0 = Accrual
1 = Non-Accrual
2 = Serviced for Others/Securitized
2 DIM_BANDS Bands Dimension This setup table contains the list of band
dimensions. Information on the table
name, columns containing the band
codes, upper and lower bound values are
stored in the setup table and a generic
code is executed to populate the band
codes in the respective fact tables.
3 DIM_CHANNEL Acquisition This table stores the master list of all
Channel Dimension | unique codes that denote channels
through which customers can be acquired.
4 DIM_CREDIT_LINE Credit Facility This table stores the credit facility
Dimension definition. Credit facility is committed line
of credit given to a customer who can
have multiple draws / exposures out of a
given credit line.
5 DIM_CUSTOMER_TYPE Customer Type This entity stores the master list of
Dimension customer types: OUR/ OTH.
6 DIM_DATES Date Dimension This table stores the List of Dates

generated between any two dates
typically covering extraction dates and
cash flow dates.
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7 DIM_DELQCY_WORKOUT_PROGRAM Delinquency This table stores the loss / delinquency
Workout Program workout program associated with loans.
Dimension Workout program is defined generally as:
if particular program is deferment,
forbearance, term changes, rate changes,
and so on. This is a seeded Dimension
and list of values are pre-populated by the
installer.
8 DIM_EDUCATION Education This table stores the customer's education
Dimension master information.
9 DIM_FISCAL_PERIODS Fiscal Periods This table stores the fiscal information for
Dimension each calendar based on the convention
followed in the particular jurisdiction.
10 DIM_FORECLOSURE_STATUS Foreclosure Status | This table stores the foreclosure process
Dimension status. Values expected are:
0 = Not in foreclosure
1 = In foreclosure, pre-sale
2 = Post-sale foreclosure, Redemption,
non-REO (if available, otherwise REQO)
3=REO
11 DIM_INTEREST_TYPE Interest Type This table stores the Interest Type.
Dimension
12 | DIM_LOAN_MODIFICATION_TYPE Loan Modification This table is used for any loan that is

Type Dimension

currently operating under modified terms
and identifies the specific terms that were
altered through loss mitigation efforts.

The information in this table is
independent of investor and speaks only
to the nature of the program. For example,
a FNMA loan can be modified under either
a FDIC or proprietary modification
program — in these cases, this information
is populated with the FDIC or proprietary
codes while the Investor field identifies the
modification as being performed on a
FNMA loan.

0 = Loan has not been modified

6 = ASF Streamline
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8 = FHFA Streamline (Specific to program
announced 12/15/08)
9 = FDIC Streamline (“Mod in a Box”)
10 = Proprietary Systematic Program
11 = Proprietary Other
12 = Home Affordable Modification
and:
0 = Not Modified
7 =2MP
8 = Proprietary Systematic
9 = Proprietary Other
10 = HAMP
13 DIM_ORG_STRUCTURE Organization This entity stores the Organization
Structure Structure of the Financial Institution.
Dimension
14 DIM_PRODUCT Product Dimension | This entity stores the details of all the
products (existing/stopped) offered by the
Financial Institution.
15 DIM_PRODUCT_TYPE Product Type This table stores the loan product type
Dimension information.
16 DIM_REG_PRODUCT_TYPE Regulatory Product | This table stores the regulatory product
Type Dimension types. This is used for regulatory reporting
purpose and contains values like Auto
Loans, Credit Cards, other consumer
loans, and so on.
17 DIM_REG_REGION Regulatory Region | This entity stores the borrower’s current
Dimension place of residency must be used to define
the region.
18 DIM_RUN Run Dimension The Run Master Dimension entity stores
Dimension all the baseline and simulation runs.
19 DIM_VEHICLE_TYPE Vehicle Type This table stores the vehicle types. For
Dimension example: SUV, Car, Truck, and so on.
20 DIM_WRITE_OFF_REASONS Write-Off Reasons This table stores the master list of reasons

Dimension

based on which the contracts are written-
off from the books.
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21 DIM_AGENCY_TYPE Agency Type This table stores details of Agency type
Dimension which issues and guarantees loans like
US Government Agency, US Government
Sponsored Agency.
22 DIM_COUNTRY Country Dimension | This table stores the master list of
countries.
23 DIM_CR_LN_VALUATION_TYPE Credit Line This entity stores the method used to
Valuation Type account the credit line. The credit line can
Dimension account for under the fair value option or
is held for sale and carried at the lower-of-
cost-or-market (LOCOM).
24 DIM_CREDIT_RATING Credit Rating This table stores the master list of credit
Dimension rating and rating issuers.
25 DIM_CUSTOMER Customer This entity stores the list of the
Dimension organization's customers and
counterparties and their attributes.
26 DIM_FRY9C_LINES FR Y-9C Lines This table stores the FR Y-9C reports
Dimension codes. The FR Y-9C report is a highly

analytical report submitted to the regulator
for the purpose of analyzing health of
banking institution.

Report the integer code (Additional
Instructions for FR Y 9C for descriptions).
Only enter designated descriptions
corresponding to the line number on the
FR Y-9C, HC-C, in which the outstanding
balance is recorded or, in the case of an
unused commitment, the line number in
which the credit facility would be recorded
if it were drawn.

Refer to following FR Y-9C instructions for
definitions of HC-C line item categories:

1. bhck1292 (U.S. Banks and other U.S.
Depository Institutions)

2. bhck1296 (Foreign Banks)
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3. bhck1590 (loans to finance agricultural
production and other loans to farmers)

4. bhck1763 (Commercial and Industrial
loans to U.S. addressees. Exclude
loans that are scored but not graded)

5. bhck1764 (Commercial and Industrial
loans to non-U.S. addresses. Exclude
loans that are scored but not graded)

6. bhck2081 (Loans to foreign
governments and official institutions)

7. bhckJ454 (Loans to non depository
financial institutions)

8. bhckJ451 (All other loans, excludes
consumer loans)

9. bhckF163 (All other leases, excludes
consumer leases)

10. bhckF160 (nonfarm,nonres, owner

occupied)

11. nonfarm, nonres, owner occupied

originated in non-domestic offices as
reported within bhck1410

27 DIM_INDUSTRY

Industry Dimension

This table stores the industry information.

28 DIM_LIEN_POSITION

Lien Position

Dimension

This table stores the list of lien positions
that can be on the collateral.

29 DIM_LOB

Line Of Business
Dimension

This entity stores the unique list of Line of
Bussiness and the details of each Line of
Bussiness.

30 DIM_MITIGANT

Mitigant Dimension

This entity stores information on various
risk mitigants like collateral, guarantee,
nettable liabilities, and so on.

31 DIM_PARTY

Party Dimension

This table stores the history of a party.
Party here can be customer, issuer and
guarantor, and so on.
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32 DIM_REG_INDEX Regulaory Index This table stores list of indices which are
Information designed to store the regulatory based
Dimension index code as designated by the
regulator. For example: LIBOR, PRIME,
Treasury Index, and so on.
33 DIM_REG_INTEREST_TYPE Regulaory Interest This table stores the list of indices which
Type Dimenison are designed to store the regulatory based
interest type code as designated by the
regulator for an account at account level
or group of accounts at a credit line level.
For example: FIXED, FLOATING, MIXED,
and so on.
34 DIM_STD_CREDIT_LINE_PURPOSE Standard Credit This table stores the regulator specified

Facility Purpose
Dimension

purpose of the said credit facility. This is
the list of values which are unique to US
Banking system. Only Number is
expected here. This is also synch up with
Shared National Credit data codes.

0= OTHER

1= ACQUISITION AND/OR MERGER
FINANCING

2 = ASSET SECURITIZATION
FINANCING

3 = CAPITAL EXPENDITURES
EXCLUDING REAL ESTATE

4 = COMMERCIAL PAPER BACK-UP

5= INDUSTRIAL REVENUE BOND
BACK-UP

6 = MORTGAGE WAREHOUSING
7 = TRADE FINANCING
8 = PERFORMANCE GUARANTEE

9 = WORKING CAPITAL - SHORT
TERM/SEASONAL

10 = WORKING CAPITAL —
PERMANENT
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11 =

20 =

21=

22 =

GENERAL CORPORATE
PURPOSES

DEBT
REFINANCE/CONSOLIDATION

ESOP FINANCING

AGRICULTURE AND/OR
LIVESTOCK PRODUCTION

AGRICULTURE AND/OR
RANCHING REAL ESTATE

STOCK BUYBACK

PORTFOLIO ACQUISITION
INCLUDING NOTE PURCHASE
AGREEMENTS

REAL ESTATE
ACQUISITION/DEVELOPMENT/CO
NSTRUCTION — LAND

REAL ESTATE
ACQUISITION/DEVELOPMENT/CO
NSTRUCTION — RESIDENTIAL

REAL ESTATE
ACQUISITION/DEVELOPMENT/CO
NSTRUCTION - COMML & INDL

REAL ESTATE
INVESTMENT/PERMANENT
FINANCING — RESIDENTIAL

REAL ESTATE
INVESTMENT/PERMANENT
FINANCING - COMMERCIAL AND
INDUSTRIAL

BUSINESS
RECAPITALIZATION/DIVIDENDS

NEW PRODUCT DEVELOPMENT
PROJECT FINANCING
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35 | DIM_STD_CREDIT_LINE_TYPE

Standard Credit
Facility Type
Dimension

This table stores the regulator specified

credit facility types. For example:
1= REVOLVING CREDIT

2= REVOLVING CREDIT CONVERTING
TO TERM LOAN

3 = REVOLVING CREDIT - ASSET
BASED

4 = REVOLVING CREDIT - DIP
5= NON-REVOLVING LINE OF CREDIT

6 = NON-REVOLVING LINE OF CREDIT
CONVERTING TO TERM LOAN

7= TERM LOAN

8 = TERM LOAN - A

9= TERM LOAN - B

10= TERM LOAN-C

11 = TERM LOAN - BRIDGE

12 = TERM LOAN - ASSET BASED
13 = TERM LOAN - DIP

14 = CAPITALIZED LEASE
OBLIGATION

15 = STANDBY LETTER OF CREDIT
16 = OTHER REAL ESTATE OWNED
17 = OTHER ASSET

36 | DIM_STD_MITIGANT TYPE

Standard Mitigant

Type Dimension

This entity stores the standard mitigant
type.

37 DIM_ACCOUNT

Account Dimension

This table stores the list of identifiers
which uniquely identify every single
financial arrangement between customer

and reporting bank.

38 | DIM_COLL_VALUE_BASIS

Collateral Vaulation

Basis Dimension

This table stores the valuation basis of the
Collateral Valuation. The allowed values

» o«

are “as is”, “as stabilized”, or “as

completed”.
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39 DIM_HOLDING_TYPE Holding Type This table stores the Holding Type of the
Dimension security.
40 DIM_LOCATION Location Dimension | This table stores the location dimension.
41 DIM_PROPERTY_TYPE Property Type This table stores the property types
Dimension associated.
42 DIM_REG_LOAN_PURPOSE Regulatory Loan This table stores the description for the
Purpose Dimension | regulatory loan purpose / utilization of loan
amount. Values expected are:
1 = Purchase
4 = Rate / Term Refinance
5 = Cash-Out Refinance
6 = Other Refinance
7 = Home Improvement
8 = Debt Consolidation
9 = Education
A = Medical
Y = Other
U = Unknown
43 DIM_CREDIT_STATUS Credit Status This entity stores the credit status codes
Dimension for the customer account along with the
descriptions for each status code. For
example: current, delinquent, foreclosed.
44 DIM_GEOGRAPHY Geography This table stores the distinct list of all
Dimension geographical locations, where any of the
transaction channels of the Bank are
located.
45 DIM_REG_PRODUCT_CLASSIFICATION | Regulatory Product | This tables stores the classification of

Classification
Dimension

loans underlying Mortgage Servicing
Rights into Regulatory classes as required
for reports. For example: FHLMC/ FNMA,

FHA loans, and so on.
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46 DIM_ASSET_LEVEL

Liquidity Asset
Level Dimension

This table stores the various Assent Level
that can be assigned to the account.
Under Basel Accord, an account can be
either Level 1 Asset or Level 2 Asset or
Other Asset.

a7 DIM_BROKER_DEPOSIT_TYPE

Broker Deposit
Type Dimension

This table stores the standard list of
broker deposit types that are required in
the regulatory document. A broker is an
individual or party (brokerage firm) that
arranges transactions between a buyer
and a seller for a commission when the
deal is executed. There are several kinds
of brokers, each of whom deals in specific
types of transactions. Each type of broker
provides different levels or type of service.
The list of values for this table is
Reciprocal, Sweep, and Other.

48 DIM_COLL_RELEASE_REASON

Collateral Release

Reason Dimension

This entity stores the reason due to which
the Collateral is released. Values

expected are Excess, Due, and so on.

49 DIM_CURRENCY Currency This table stores the currency information.
Dimension

50 DIM_ENCUMBRANCE_STATUS Dimension This entity stores the list of encumbrance
Encumbarance status. The list fo values are Fully

Status Dimension

Encumbered, Partially Encumbered, and
Not Encumbered.

51 DIM_INSTRUMENT_CONTRACT

Instruments
Contracts
Dimension

This entity stores the contracts and
instruments in the Market and their details
like Effective Date, Maturity Date, Face
Value, Day Convention, Strike, and so on.

52 DIM_INSTRUMENT_TYPE

Instrument Type
Dimension

This entity stores the details of all the
Instrument Types which Reveleus Market

Risk solution supports.

53 DIM_INSURANCE_SCHEME

Insurance Scheme

Dimension

This entity stores the details of insurance
scheme.
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54 DIM_IR_STRUCTURED_INSTRS Structured Security | This table stores details of Structured
Type Dimension Security Type like Pass Through
Certificates and mortgage-backed
securities.
55 DIM_MITIGANT_TYPE Mitigant Types This entity stores the master list of
Dimension mitigant types given by the customers
against their exposures. Possible types
include Collateral, Guarantee, and so on.
56 DIM_NETTING_AGREEMENT Netting Agreement | This table stores the details of Netting
Dimension Agreement. Netting agreement happens
between a bank and a counterparty for
OTC derivative and SFT transactions. For
example: ISDA, FOA, EEI, and so on.
57 DIM_PARTY_TYPE Party Type This table stores the history of a party for
Dimension party type. Party here could be customer,
issuer and guarantor, and so on.
58 DIM_REG_COLLATERAL_STOCK_TYPE | Regulatory This table stores the regulatory collateral
Collateral Stock stock type and acts as a reclassified
Type Dimension dimension which refers to the stock of
collateral held or posted by the entity
related to certain transactions like
derivatives. Expected values are:
¢+ Rehypothecatable — Unencumbered
(and Treasury Controlled)
¢+ Rehypothecatable — Encumbered (or
not Treasury Controlled)
¢+ Non-Rehypothecatable
¢ Segregated Cash
¢+ Non-Segregated Cash
59 DIM_REG_COVER_TXN_TYPE Regulatory This table stores the regulatory covered
Covered transaction types.

Transaction Type
Dimension
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60 DIM_REG_DEPOSIT_TYPE Regulatory Deposit | This table stores the details of various
Type Dimension deposit types like Demand deposits and
Negotiable Order of Withdrawal (NOW)
accounts.
61 DIM_STD_GL_TYPE Standard General This table stores the standard general
Ledger Type ledger types.
Dimension
62 DIM_UNDRLYNG_ASST_POOL_TYPE Underlying Asset This table stores the underlying asset pool
Pool Type type for derivative instruments. For
Dimension example, Student Loan ABS means an
asset backed security backed by student
loans. In this case, this table stores the
Student Loan.
63 DIM_REG_INSTR_CLASSIFICATION Regulatory This table stores data for different
Instrument Instrument Classification defined by the
Classification Regulators.
Dimension
64 DIM_STANDARD_PARTY_TYPE Standard Party This table stores the standard party type.
Type Dimension Party here can be customer, issuer and
guarantor, and so on.
65 DIM_STANDARD_PRODUCT_TYPE Standard Product This table stores the list of all product
Type Dimension types specified by regulator for risk
computations.
66 DIM_REG_PARTY_TYPE Regulatory Party This entity stores the regualtor specfic
Type Dimension party types.
67 DIM_REG_LIQ_REPORTING_GROUP Regulatory Liquidity | This is a reclassififed dimension storing
Reporting Group various PIDs/Product reported in Liquidity
Dimension reporting.
68 DIM_STANDARD_CENTRAL_BANKS Standard Central This table stores the names of various
Banks Dimension central banks across the world.
69 DIM_REG_INSURER Regulatory Insurer | This is a reclassified dimension which

Dimension

stores the deposit insurers as specified by
the regulator. Values Expected are FDIC,
OTHERS, and UNINSURED.
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70

DIM_RESULT_BUCKET

Result Bucket
Dimension

This table stores the result buckets

associated with each process.

71

DIM_SETTLEMENT_TYPE

Settlement Type
Dimension

This table is used to identify the
settlement mechanisms used for Secured
and Foreign Exchange products.
Following Secured products are identified
using the table:

TRIPARTY: secured financing
transactions settled on the US-based tri-
party platform,

OTHER: secured financing transactions
settled on other (for example, non-US)
third-party platforms,

BILATERAL: secured financing
transactions settled bilaterally.

Following Foreign Exchange products are
identified using the table:

CLS: FX transactions centrally cleared via
CLS,

OTHER: FX transactions settled via other
(non-CLS) central clearinghouses,
BILATERAL: FX transactions settled
bilaterally.

72

DIM_RISK_SCENARIO

Risk Scenario

Dimension

This table stores the Operation Risk
Scenarios.

73

DIM_REG_TRADING_POSITION_CLASS

Regulatory Trading
Position Class

Dimension

This table stores the regulatory trading

position class values.

74

DIM_REG_LIQ_CASHFLOW_GROUP

Regulatory Liquid
Cashflow Group
Dimension

This table store the cash flow groups used
for liquidity reporting like FR 2052a. This
serves as a reclassified dimension in
regulatory reporting.
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75 DIM_FIXED_ASSETS Fixed Assets This table stores the data related to fixed
Dimension assets. Fixed assets are physical assets
such as Buildings, Land, Machinary,
Automobiles, Gold bullion, and so on.
They can be sold and appropriate
profit/loss can be recognized based on
appropriate accounting principles.
76 DIM_ISSUER Issuer Dimension This entity is used as an issuer of
marketable collaterals.
77 DIM_REP_LINE Reporting Line This table stores list of all computed
Dimension reporting line items.
78 DIM_SECURITIZED_PRODUCTS Securitized This table stores details of Securitized
Products products like Residential pass-through
Dimension securities and Residential mortgage-
backed securities.
79 DIM_TRADING_ACCT_BOOK_TYPE Trading Account This table helps to identify trading assets
Book Type and liabilities. Along with Holding type as
Dimension held for trading, at times the regulator has
an additional criteria like positive fair value
for identification of trading assets and
negative fair value for trading liabilities.
80 DIM_CONSOLIDATION Consolidation This entity stores details of various kinds
Dimension of values to be analyzed like actual or
budget.
81 DIM_ACCOUNT_PORTFOLIO Account Portfolio This table is planned for deprecation.
Dimension
82 DIM_ACCT_PORTFOLIO Account Portfolio This table stores the master list of all the
Dimension portfolios of the Institution. Portfolios are
user-defined group of accounts. For
example, auto loan porfolio is a group of
auto loans.
83 DIM_ACCT_STATUS Account Status This table stores a set of unique codes

Dimension

that denote the status of an account.
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84 DIM_APR_RESET_TYPE Apr Reset Type This table stores the frequency of reset for
Dimension the APRs as applicable to the card
account.
85 DIM_BANKRUPTCY_CHAPTER Bankruptcy This table stores the code of the
Chapter Dimension | bankruptcy chapter filed by customer of
the said account. The list of values are
pre-populated by the installer.
86 DIM_CARD_FEE_PAY_TYPE Card Fee Pay Type | This table stores the fee pay types
Dimension associated with card account. Expected
values are:
0 = No fee
1 = Annual
2 = Monthly
3 = Other
87 DIM_CENTRAL_AUTHORITY Central Authority This table stores the list of all the central
Dimension authorities like Group Supervisor, and so
on, for an entity.
88 DIM_CREDIT_CARD_CO_BRAND_TYPE | Credit Card Co This table stores the co-branding type /
Brand Type association code linked to the said credit
Dimension card. The list of values are pre-populated
by the installer.
89 DIM_CREDIT_CARD_LENDING_TYPE Credit Card This table stores the credit card type
Lending Type code. The list of values are pre-populated
Dimension by the installer.
920 DIM_CREDIT_CARD_NETWORK Credit Card This table stores the credit card networks
Network Dimension | associated.
91 DIM_CREDIT_CARD_REWARD_TYPE Credit Card This table stores the credit card reward
Reward Type type code. The list of values are pre-
Dimension populated by the installer.
92 DIM_CREDIT_CARD_TYPE Credit Card Type This table stores the codes of the credit

Dimension

card usage. The list of values are pre-
populated by the installer.
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93 DIM_CREDIT_CLASS_TYPE Credit Class Type This table stores the credit class type
Dimension description assigned to the given account.
The list of values are pre-populated by the
installer.
94 DIM_CREDIT_LINE_CHANGE_TYPE Credit Line Change | This table stores the code of the credit line
Type Dimension change type initiated by bank as
applicable to the said account. The list of
values are pre-populated by the installer.
95 DIM_CREDIT_SCORE_TYPE Credit Score Type This table stores the credit score type
Dimension codes to be used for reporting for
regulatory purposes code. The list of
values are pre-populated by the installer.
96 DIM_DELQCY_WORKOUT_PROG_STAT | Delinquency This table stores code of status of the
us Workout Program work out programs. The list of values are
Status Dimension pre-populated by the installer.
97 DIM_DELQCY_WORKOUT_PROG_TYPE | Delinquency This table stores the workout program
Workout Program type code associated with said account.
Type Dimension The list of values are pre-populated by the
installer.
98 DIM_ENTITY_TYPE Entity Type This table stores list of all types of entities
Dimension in the organization structure.
99 DIM_INCOME_DOCUMENTATION_PROG | Income This table stores the code of the income
Documentation documentation related to particular
Program account / customer. The list of values are
Dimension pre-populated by the installer.
100 | DIM_INCOME_SOURCE_TYPE Income Source This table stores the income sources. The
Type Dimension list of values are pre-populated by the
installer.
101 | DIM_INDEX Index Information This table stores list of indices which are

Dimension

designed to measure price changes of an
overall market, such as the stock market
or the bond market. For example,
Vanguard's Total Bond Market Index, Dow
Jones Industrial Average, Tokyo Stock
Exchange(Nikkei 225), and so on.
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102 | DIM_INTEREST_TYPE_CONVERSION Interest Type This table stores the interest type change
Conversion code for a given loan. Indicates whether
Dimension the interest type was converted from ARM
to Fixed through loss mitigation, and the
duration of the fixed rate period. The list of
values are pre-populated by the installer.
103 | DIM_LIEN_PERFORMANCE Lien Performance This table stores the performance
Dimension description of the lien associated with the
loan account. It includes First and Junior
lien performance. The list of values are
pre-populated by the installer.
104 | DIM_LIQUIDATION_STATUS Liquidation Status This table stores the code of liquidation
Dimension status to convey the way account was
liquidated. The list of values are pre-
populated by the installer.
105 | DIM_LOAN_REPURCHASE_STATUS Loan Repurchase This table stores the loan repurchase
Status Dimension process status associated with the said
account. The list of values are pre-
populated by the installer.
106 | DIM_LOAN_SOURCE_TYPE Loan Source Type | This table stores the source by which the

Dimension

servicer originated or otherwise acquired
the mortgage. At the servicer's discretion,
acquired servicing can be reported as
retail, broker, or correspondent
originations to the extent the information is
available.

¢ Retail — Report all mortgages
originated through the reporting
institution’s retail, including branch
or internet, production channel.

¢+ Wholesale (Broker) - Report all
mortgages originated through the
reporting institution's
wholesale/broker production
channel. Report as broker originated
all third-party originated loans where

the bank cannot distinguish between
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broker and correspondent
originated.

¢  Correspondent - Mortgages acquired
through the reporting institution's
correspondent production channel.
This includes all mortgage whole
loans purchased on a recurring
basis (flow) from another
correspondent institution, eligible for
securitization into the secondary
markets or portfolio retention on the
bank's balance sheet. Report as
broker originated all third-party
originated loans when the bank
cannot distinguish between broker

and correspondent originated.

¢ Bulk Purchase — Pools of mortgage
whole loans purchased from a third
party originator for the right to
securitize or retention in the bank-
owned portfolio. Residential
Mortgages acquired for the Servicing
Portfolio in this manner are typically
negotiated as one-time transactions
between a Mortgage Institution and
an independent third party originator
(Mortgage Company or
Correspondent). Report all bulk
acquisitions and correspondent flow
acquisitions as correspondent
originated when the institution
cannot distinguish between these
categories. Do not label bank
acquisitions as Bulk Purchases.

¢ Servicing Rights Purchased - Refers
to a separately negotiated purchase
of mortgage servicing rights (PMSR)
from a third party. When the servicer
cannot distinguish between bulk
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whole loan and bulk servicing
acquisitions, the servicer must report
all of these acquisitions consistently
in the category that represents the
majority of the servicer's
acquisitions.

Note: This reporting category
applies exclusively to the Servicing
Portfolio.

¢+ Wealth Management/Private
Banking — report all loans originated
through a servicer’s private wealth
management or private banking
division. This is a seeded Dimension
and list of values are pre-populated
by the installer.

107

DIM_LOSS_SHARE_AGREEMENT

Loss Share
Agreement
Dimension

This table stores specific loss sharing
agreements. A unique ID must be
generated for each active sharing
agreement. The specific ID must be
consistent over time for as long as the
agreement remains active without a
relevant change in the terms of the loss
sharing agreement.

The institution must also provide a written
summary of the relevant terms of each
loss sharing agreement along with the
corresponding Loss Share ID number.
Additional supporting documentation may
be requested if necessary.

Report blank if the account is not
associated with a loss sharing agreement.
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108

DIM_MORT_INVESTOR_TYPE

Mortgage Investor

Type Dimension

This table stores the mortgage investor
type or insurance company code which
logically owns the mortgage till debt is
cleared off. The list of values are pre-
populated by the installer.

109

DIM_MORTGAGE_OCCUPANCY

Mortgage
Occupancy
Dimension

This table stores the code of mortgage
occupancy for a given loan /account. The
list of values are pre-populated by the
installer.

110

DIM_PROG_ACTIVITY_STATUS

Program Activity
Status Dimension

This table stores the program activity
status code. The list of values are pre-
populated by the installer.

111

DIM_REPAYMENT_STATUS

Repayment Status
Dimension

This table stores the loan repayment plan
status code.

Repayment Performance Status — This
field tracks the performance of repayment
and step-to-mod plans. If a repayment
plan or step-to-mod was completed
successfully during the month, it must be
coded as such in the work-out type
completed field). This field is only to be
populated for repayment plans that were
active as of the end of the month or
broken during the month. Broken plans
must only be reported in the month the
plan breaks. The list of values are pre-
populated by the installer.

112

DIM_VALUATION_METHOD

Valuation Method
Dimension

This table stores list of all methods used
for valuation purposes.

113

DIM_RISK_SECTOR

Risk Sector

This table stores the reporting risk sectors
which are determined based on the legal
entity of the counterparty.

114

DIM_LOAN_SERVICE_TYPE

Loan Service Type
Dimension

This table stores the details of loan
service type which details whether the
loan is Extended, Guaranteed, Serviced,
or Insured by the Holding Company.
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115 | DIM_PLEDGED_STATUS Pledged Status This entity stores the Pledged Status
Dimension information.
116 | DIM_SECURITIZATION_TYPE Securitisation Type | This table stores the different
Dimension securitization types as defined by Basel.
117 | DIM_MARKET_RISK_POSITION Dimension Market This entity stores a master list of different
Risk Position positions a Financial Institution can have
on different marketable instruments. For
example: Long Position, Short Cash Long
Call, Long Put, and so on.
118 | DIM_BASEL_BANK_ROLE Basel Bank Roles This table stores the Bank Role type as
defined by Basel Accord.
119 | DIM_BASEL_PRODUCT_TYPE Basel Product This table stores the details of product
Types Dimension type as defined by Basel.
120 | DIM_BASEL_CONSL_OPTION_TYPE Basel This entity stores the Basel Consolidation
Consolidation Option Type (Solo / Consolidation).
Option Dimension
121 | DIM_EXPOSURE_UNDERLYING_TYPE Exposure This table stores the various underlying
Underlying Type type for the exposure.
122 | DIM_BEHAVIOUR_TYPE Behaviour Type This table represents account behaviour /
performance. Expected Values are Core,
Volatile, Substandard, Doubtful, Loss,
Sight Devolvement, Sight Recovery,
Usance Devolvement, and Usance
Recovery.
123 | DIM_REG_RISK_CLASS Regulatory Risk This table stores the regulatory risk class
Classification like High / Medium and so on.
124 | DIM_BASEL_POOL_TYPE Dimension Basel This table stores the various securitization
Pool Type pool types.
125 | DIM_BASEL_ASSET_CLASS Basel Asset Class This table stores the Basel defined
exposure types.
126 | DIM_RISK_TYPE Risk Type This Master table stores the risk ttypes.
Dimension For example: Price Risk, Volatility Risk,

and so on.
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127 | DIM_BASEL_METHODOLOGY Basel Methodology | This table stores the approach
Dimension methodology as defined by Basel.
128 | DIM_CAPITAL_COMP_GROUP Capital This table stores the dimensions of
Computation Group | Capital Computation Group.
Dimension
129 | DIM_BANK_BASE_ ROLE Bank Base Roles This table stores the Bank Role type as
Dimension defined by Basel.
130 | DIM_FIDUCIARY_SERVICE_TYPE Fiduciary Service This entity stores the details of various
Type Dimension types of fiduciary service.
131 | DIM_FIDUCIARY_SERVICE_ROLE Fiduciary Service This entity stores the details of various
Role Dimension roles played by a fiduciary service
provider.
132 | DIM_MR_ASSET_CLASS Market Risk Asset This entity stores the list of Ratings like
Class Dimension AAA, EQ & custom Equities, XS and
COM, which are used to identify the
Interest Rate Risk Factor, Equity Risk
Factor, Currency Risk Factor, and
Commaodity Risk Factors respectively.
133 | DIM_FUND_TYPE Fund Type This table stores list of all applicable types
Dimension of fund.
134 | DIM_FUND Fund Dimension This table stores list of all funds used by
the entity.
135 | DIM_CAP_INSTRUMENT_TXN_TYPE Capital Instrument This table stores the capital instrument
Transaction Type transaction type.
Dimension
136 | DIM_CONSTRUCTION_LOAN_TYPE Construction Loan This table stores details of Construction
Type Dimension Loan Type like 1-4 Family residential,
construction, town houses, duplex for the
construction loans issued by Holding
company.
137 | DIM_ISSUER_TYPE Issuer Type This entity stores the issuer yypes.
Dimension
138 | DIM_ACCOUNT_TYPE Dimension Account | This table stores the details of the account

Type

type.
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139 | DIM_SALE_TYPE Sale Type This table stores the loan sale types.
Organization can sell the loans as whole
loan, through securitization, or pass
through certificates.
140 | DIM_REG_EQ_INVST_CLASSFCTN Regulatory Equity This table stores the regulator defined
Investment classifications of equity investment as
Classification used in regulatory reports. Expected
Dimension Values are Direct Public Investment,
Direct Nonpublic Investment, Indirect
Investment.
141 | DIM_REG_EQ_TXN_GROUP Regulatory Equity This table stores the regulator defined
Transaction Group | types of equity transactions as used in
Dimension regulatory reports. Expected Values are
Purchase, Return of Capital, Net
Valuation Changes, and others.
142 | DIM_SCENARIO Scenario This entity stores the details of various
Dimension kinds of values to be analyzed like actual
or budgeted.
143 | DIM_REG_VINTAGE Regulatory Vintage | This table stores the vintage definitions
Dimension used in building Vintage dimensions in
CRR. Vintage codes are "Year" + "Month"
combination.
Additional Comment is:
Vintage dimension was built on fact table.
144 | DIM_ACCT_SOLD_EXEMPT_STATUS Account Sold This table stores the status of exemption
Exemption Status for sold accounts. Loans sold have liability
Dimension on bank on legal terms. This dimension
helps to identify if particular loan is
exempted from reporting as it is already
repurchased or settlement is completed.
145 | DIM_STANDARD_ACCT_HEAD Standard This dimension lists the various standard

Accounting Head
Dimension

accounting heads (Equity, Reserves and
Surplus, and so on.) under which a bank
classifies its GL sources of accounting

capital.
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146 | DIM_INSTRUMENT_CATEGORY Instrument This table stores instrument category -
Category Assets/Liabilities/Others/Services.
Dimension

147 | DIM_EXPOSURE Exposure This table stores the account wise

Dimension summary for product processor.

148 | DIM_OPRISK_LOSS_DATA_CATEGORY | Operational Risk This tables stores the operational loss

Loss Data data category. Expected Values are

Category Internal, External, Model Input, and

Dimension Scenario.

149 | DIM_VARIABLE Variable Definition This table stores the variables to be

Dimension consumed by Enterprise Stress Testing or
any other similar usage.

150 | DIM_ACCRUAL_STATUS Accrual Status This table stores the loan accrual status.

Dimension Values expected are:

0 = Accrual
1 = Non-Accrual
151 | DIM_CREDIT_SCORE_MODEL Credit Score Model | This table stores the list of credit score
Dimension models used in arriving at the credit score.
152 | DIM_PRODUCT_INT_TERM_GROUP Product Interest This table stores the Interest and Term

Term Group Group together.

Dimension For example, few US loans are
categorized as Fixed 30 which means
fixed interest and 30 years maturity and
are reported with name Fixed 30.

153 | DIM_REG_ACCT_SOURCING_CATEGOR | Regulatory Account | This table stores the list of regulatory
Y Sourcing Category | account sourcing categories that a bank

Dimension follows to acquire a customer.

154 | DIM_REG_AMORTIZATION_TYPE Regulatory This table stores the information regarding

Amortization Type various regualtory amortization types.

Dimension

155 | DIM_REG_ATTRITION_REASON Regulatory Attrition | This table stores the various attrition

Reason Dimension

reasons of a loan as prescribed by the
regulator.
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156 | DIM_REG_CREDIT_LIMIT_TYPE Regulatory Credit This reclassified table stores the list of
Limit Type credit limit types.
Dimension
157 | DIM_REG_INS_LOAN_TYPE Regulatory This tables stores the regulatory loan
Mortgage types based on the mortgage issurance
Insurance Loan issuers.
Type Dimension
158 | DIM_REG_LOAN_DELQ STATUS Regulatory Loan This table stores the various deliquency
Delinquency Status | status of a loan as prescribed by the
Dimension regulator.
159 | DIM_REG_LOAN_SEGMENT Regulatory Loan This tables stores the regulatory portfolios
Segment of loans segmented based on regulatory
Dimension requirements.
160 | DIM_REG_MORT_INS_ISSUER Regulatory This tables stores the regulatory mortgage
Mortgage insurance issuer values as required by the
Insurance Issuer regulator.
Dimension
161 | DIM_REG_VALUATION_METHOD Regulatory This table stores the regulatory valuation
Valuation Method method used to calculate the mitigant
Dimension value.
162 | DIM_SERVICED_LOAN_ACCOUNT Serviced Loan This table stores account summary.
Account Dimension | However only for those accounts which
bank holds for servicing purpose only.
These account may or may not be
originated by bank.
163 | DIM_STANDARD_IRC Standard Interest This entity stores the standard interest
Rates Dimension rate curve definitions.
164 | DIM_STD_BALANCE_CATEGORY Standard Balance This dimension entity stores the list of
Category regulatory categories that a balance can
Dimension have.
165 | DIM_STD_CENTRAL_AUTHORITY Standard Central This table stores the central authorities

Authority
Dimension

like FRB, FDIC and so on.
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166 | DIM_ACCOUNT_CLASSIFICATION Account This entity stores the account
Classification classifications according to different
Dimension different regulations.
167 | DIM_ACCOUNT_PURPOSE Account Purpose This table captures the purpose for which
Dimension the bank has initiated the account.
168 | DIM_ACCT_SOURCING_CATEGORY Dim Account This dimension entity stores the list of
Sourcing Category | Account sourcing categories that a bank
Dimension follows to acquire a customer. This is
used as a source to arrive at Regulatory
values for account sourcing category.
169 | DIM_AMORTIZATION_TYPE Amortization Type This entity stores the various type/method
Dimension of amortizing principal and interest.
170 | DIM_BASEL_CREDIT_RATING Basel Credit This entity stores the Basel defined Credit
Ratings Dimension | Ratings.
171 | DIM_CD_DEFAULT_PARAM_GROUP Credit Derivative This table stores the group of parameters
Default Parameter used to define the credit derivative
Group Dimension valuation for incremental default analysis
of credit derivatives.
172 | DIM_COMMODITY Commodity This entity stores the master list of
Information commodities and their details. For
Dimension example: Sugar, Steel, Rubber, and so
on.
173 | DIM_COMMODITY_GROUP Commaodity Group This table stores the commodity grouping
Dimension required for CVA Sensitivity analysis as
specified by the regulator.
174 | DIM_CREDIT_LINE_PURPOSE_CAT Credit Line This entity stores the purpose category of

Purpose Category
Dimension

credit line which is available for liquidity,
credit, both or other. This can have four
values:

¢+ LIQ (=Liquidity),

¢  CRT (=Credit),

¢+ BOT (=Both Liquidity and Credit),
¢ OTH (Others).
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175 | DIM_CVA_SENSTVTY_FCTOR_DTLS Sensitivity Factor This table stores the details of factors
Details Dimension used for CVA sensitivity analysis done
using variables other than rating, interest,
FX, equity and commodity. User is
expected to store detailing of factors here.
176 | DIM_DIRECTIONAL_RISK_REG_CLASS Directional Risk This table stores the classificaiton codes
Regulatory required for directional risk reporting as
Classification required by FED. Values expected are:
Dimension ¢+ Governments
¢+ Agencies
¢ Municipals
¢ Swaps / Discounting Curve
¢ Instruments shocked by MV**
¢+ Other+0O87
177 | DIM_ENERGY_CONVERSION Energy Conversion | This tables stores energy conversions.
Dimension For example: Power, Gas can be values
indicating that fuel is converted to which
energy type.
178 | DIM_FORECLOSURE_STATUS Foreclosure Status | This table stores the foreclosure process
Dimension status. Values expected are:
0 = Not in foreclosure
1 =In foreclosure, pre-sale
2 = Post-sale foreclosure, Redemption,
non-REO (if available, otherwise
REO)
3=REO
179 | DIM_FRY9C_HCC_SCHEDULE FR Y-9C HCC This table stores US FED FR Y-9C
Schedule schedules codes and categories as
Dimension applicable to the CCAR Reporting.
These are basically mnemonic codes
which are detailed to their descriptions
and broken down as per CCAR
requirements.
180 | DIM_INDEX_TYPE Index Type This column stores the index type. For
Dimension example: STOCK, COMMODITY, CDX,

and so on.
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181 | DIM_IRC Interest Rate Curve | This entity stores the interest rate curve

Dimension definitions.
182 | DIM_MR_COUNTER_PARTY Dim MR Counter This table stores the standard
Party Dimension counterparty types for trading book
instruments. This is used in Basel MR
Standardized approach.
183 | DIM_MSR_PRODUCT_TYPE MSR Product Type | This entity stores the code for the MSR
Dimension product type. Values are FHLMC 30 year,
GNMA 10 years, and so on.
184 | DIM_MTM_COLL_PORTFOLIO MTM Collateral This table stores the values for collateral
Portfolio Dimension | used in MTM derivative positions at a
portfolio level.

185 | DIM_OCCUPANCY_TYPE Occupancy Type This table stores the Mortgage Occupancy

Dimension Type. Values expected are self occupied,
rented, vacant, other, and so on.

186 | DIM_OECD_INDICATOR OECD Indicator This table stores the OECD indicator as

Dimension defined by Basel 1. This is the dimension
table that stores whether RWs are in
Organisation for Economic Co-operation
and Development's agreed methodology
or not.

187 | DIM_ORIGINAL_MATURITY_BAND Original Maturity This table stores the band definitions for

Band Dimension Original Maturity of the exposure.

188 | DIM_PD_MODEL_TYPE PD Model Type This table stores definition of model used
for calculation of probability of default. It
also conveys information on type of input
information like internal/external, and so
on.

189 | DIM_POSITION_TYPE Position Type This table stores the various positions of a

Dimension marketable instrument.
190 | DIM_PRODUCT_BOOK Product Book This table stores whether the exposure is

Dimension

of Banking book or Trading book (if info is
not available, it is under Missing
category).
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191 | DIM_REAL_ESTATE_OWNED_TYPE Real Estate Owned | This table stores the Real estate owned
Type Dimension type of the Holding company like
Foreclosed Real estate, Real estate
Acquired.
192 | DIM_REG_ACCOUNT_PORTFOLIO Regulatory Account | This table stores the Regualtory Account
Portfolio Dimension | Portfolios user-defined group of accounts
which are reported under Regulatory
Reports. This table stores the master list
of all the portfolios used in Regulatory
Reporting of the Institution.
193 | DIM_REG_ACCOUNT_SEGMENT Regulatory Account | This table stores the regulatory account
Segment segements. These segement are arrived
Dimension as a part of regulatory classifications and
consumed in Regulatory Reporting.
Segement is part of regulatory accounting
portfolio.
194 | DIM_REG_CP_CNT_CATEGORY Regulatory This entity stores the collateral asset
Counterparty category offered / posted as collateral to
Contract Category given legal entity as part of contracts like
Dimension SFT / Derivative / Others, used in report
FR Y-14Q Counterparty.
195 | DIM_REG_CREDIT_STATUS Regulatory Credit This table stores the regualatory credit
Status Dimension status as prescribed by the regulator.
196 | DIM_REG_INDEMNFICATION_TYPE Regulatory This table stores the various
Indemnification indemnification types of a loan as
Type Dimension prescribed by the regulator.
197 | DIM_REG_MITIGANT_TYPE Regulatory Mitigant | This entity stores the regulatory mitigant
Type Dimension types. These are derived based on
Standard Mitigant type and few other
mitigant attributes.
198 | DIM_REG_PRIMARY_OBLITN_TYPE Regulatory Primary | This table stores the primary obligations of

Obligation Type
Dimesion

a reporting institution. Primary obligations
are those central obligations arising from
the essential purpose of a contract or
transaction, and from which other
(secondary) obligations arise.
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199 | DIM_REG_RESRV_LIABILITY_TYPE Regulatory This table strores the reservable liability
Reservable Liability | type as defined by Regulator. Reservable
Type Dimension liability types refers to deposits, primary
obligations which are allowed for
reserving.
200 | DIM_REG_WRITEOFF_REASONS Regulatory Write- This tables stores the regulatory Write-off
off Reasons reasons mentioned by the regulator.
Dimension
201 | DIM_REGION Region Dimension | This entity stores the master lists of
regions where campaigns can be
targeted.
202 | DIM_RUN_IDENTIFIER Run Identifier This table stores the Bank Role type as
Dimension defined by Basel Accord.
203 | DIM_RUN_TYPE Run Types This entity stores the master list of all Run
Dimension types supported.
204 | DIM_STANDARD_EVENT_TYPE Standard Loss This entity stores the master list of
Event Type Operational Loss Event Types as
Dimension prescribed by the regulator.
205 | DIM_STANDARD_LOB Standard LOB The entity stores the master list of Lines of
Dimension Business as prescribed by the regulator.
206 | DIM_STD_DEPOSIT_MAT_INSTR_TYPE Deposit Maturity This table stores the maturity instruction
Instruction Type type from customer. Values expected are:
Dimension ¢ TROTHTXNACC: Transfer to Other
Transaction (Savings /Demand)
Account
¢ AUTORENEW: Auto Renewal\
¢+ NOINSTR: No Instruction Available
207 | DIM_STRESS Stress Dimension This table stores the master details of
stress definitions made.
208 | DIM_TRADING_ACCT_BOOK_TYPE Trading Account This table stores the trading assets and

Book Type
Dimension

liabilities. Along with Holding type as held
for trading at times regulator has an
additional criteria like positive fair value for
identification of trading assets and

negative fair value for trading liabilities.
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209 | DIM_UNDRLYNG_ASST_POOL_TYPE Underlying Asset This table stores the underlying asset pool
Pool Type Table type for derivative instruments. For
Dimension example: Student Loan ABS means an
asset backed security backed by student
loans. In this case, this table stores
Student Loan.
210 | DIM_VALUATION_METHOD Valuation Method This table stores the list of all methods
Dimension used for valuation purposes.
211 | DIM_VARIABLE Variable Definition This table stores the variables to be
Dimension consumed by Enterprise Stress Testing or
any other similar usage.
212 | DIM_REG_CHANNEL Regulatory This table stores the various types of
Channel Dimension | channels through which accounts are
originated.
213 | DIM_REG_PARTICIPATION_TYPE Regulatory This table stores the various loan
Participation Type participation types as required by the
Dimension regulator. This table contains pre-seeded
values.
214 | DIM_REG_DISPOSITION_TYPE Regulatory This table stores the various types of
Disposition Type disposition of accounts as required by
Dimension regulator.
215 | DIM_PARTICIPATION_BANK_ROLE Participation Bank This table stores the different types of
Role Dimension loan participantion roles that can be
performed by the bank.
216 | DIM_OPTION_TYPE Option Type This table stores the different embedded
Dimension option types. This table contains pre-
seeded values.
217 | DIM_CREDIT_PARTICIPATION Credit Participation | This table stores the Credit participation
Dimension information.
218 | DIM_CREDIT_PARTICIPATION_TYPE Credit Participation | This table stores the various Credit

Type Dimension

Participation types.
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219 | DIM_CREDIT_PARTICIPTN_TRANCHE Credit Participation | This table stores the Credit participation
Tranche Dimension | Tranche information.
220 | DIM_REG_IRC Regulatory Interest | This entity stores the Regulatory Interest
Rate Curves Rate Curve definitions .
Dimension
222 | DIM_PD_MODEL Probability of This table stores the Probability of Default
Default Model model name, description, and version
Dimension details.
223 | DIM_HEDGE_PORTFOLIO_SET Hedge Portfolio Set | This table stores the unique hedge
Dimension identification under which the accounts
are covered.
224 | DIM_HEDGED_RISK Hedged Risk This column stores the codes for hedged
Dimension Risk. Sample values are:
¢ OCFV: Overall Change in Fair Value
or Variability in Cash Flows,
¢+ IR: Interest Rate Risk,
¢ FX: Foreign Exchange Risk,
¢ CR: Credit Risk,
¢+ |IRFX: Interest Rate Risk & Foreign
Exchange Risk,
¢ |IRCR: Interest Rate Risk & Credit
Risk,
¢ FXCR : Foreign Exchange Risk &
Credit Risk,
¢+ |IRFXCR: Interest Rate Risk & Foreign
Exchange Risk & Credit Risk,
¢ CIFVOPT: Change in Fair Value of
Embedded Call or Put Option.
225 | DIM_REG_HEDGE_TYPE Regulatory Hedge This table stores the regulatory hedge

Type Dimension

type codes. Sample values are:

¢ CFH: Cash Flow Hedge,
¢ FVH: Fair Value Hedge,
¢ OTH: Other Hedge
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3.1.12 Fact Tables/Entities

For all tables with data flow type tagged as a Processing, it is recommended that end users map data
directly to result area if processing application is not part of OFSAA product suite. For example, Basel
computations, RWA Numbers, and Capital Ratio are taken from processing area which is populated by

OFSAA or other Basel application.

For processed tables, you can look for the following options:
¢ OFSAA Data Integration Hub (DIH) product

¢ Flat File

¢+ Table-to-Table Transformation with source being processing application

Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow

No. Names Type

1 FCT_ACCOUNT_MITIGANT_ MAP | Fact Account Mitigant | This entity stores the account to Staging

Map mitigant mapping. It supports
more than one mitigant to be
mapped to an account.
2 FCT_ACCT_RECOVERY_ Fact Account This entity stores the details of Staging
DETAILS Recovery Details recoveries for each account.
3 FCT_ACCT_WRITE_OFF _ Fact Account Write This entity stores the details of Staging
DETAILS Off Details write-off for each account.

4 FCT_CARDS_SUMMARY Fact Cards Summary | This table stores the contract Staging,
summary of all active card Results
accounts.

5 FCT_COMMON_ACCOUNT _ Fact Common This table stores common Staging

SUMMARY Account Summary account level information that
usually comes as an input
through staging.

6 FCT_CREDIT_LINE Fact Credit Facility This table stores the credit facility | Staging,
data. Credit facility is committed Results
line of credit given to a customer
who can have multiple draws /
exposures out of a given credit
line.

7 FCT_LOAN_ACCOUNT_ Fact Loan Summary This table stores the details of Staging,

SUMMARY loans. This table includes Results
mortgage and vehicle loans.

Oracle Financial Services Software

86




OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
User Guide, Release 8.0.4.1.0

Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
8 FCT_MITIGANTS Fact Mitigants This entity stores all the Mitigants | Staging
and their details.
9 FCT_RECOVERY Fact Recovery This table stores the recovery Staging
details for all delinquent
accounts.
10 FCT_REG_CAP_ACCOUNT_ Fact Regulatory This table stores the regulatory Results
SUMMARY Capital Account capital for each account.
Summary Typically, this table is an input
from Basel application.
11 FCT_PARTY_FINANCIAL_ DETAIL | Fact Party Financial This entity stores the financial Staging
Detail information (Balance-Sheet,
Profit and Loss statement, and
Ratios) in base and reporting
currency of the parties like
Customer and Guarantor.
12 FCT_PARTY_FINANCIALS Fact Party Financials | This entity stores the financial Staging
information (Balance-Sheet,
Profit and Loss statement, and
Ratios) of the parties like
Customer and Guarantor.
Balance sheet is prepared as of
a particular date (Balance sheet
creation date).
13 FCT_PARTY_RATING_DETAILS Fact Party Rating This table stores the party rating | Staging
Details details of the customer,
counterparty, guarantor, and so
on.
14 FCT_IFRS_ACCOUNT_ Fact IFRS Account This table stores the measures Processed
SUMMARY Summary related to account that are
computed by IFRS application.
15 FCT_ACCOUNT_POSTION_ PAIR | Fact Account Position | This table defines position Staging

Pair

pairings that relate a primary
position and its offsetting
position. The position pairs can
be held in any manner (for
example, cash or margin). It
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
contains only active customer
account positions.
16 FCT_ACCT_CUST_DETAILS Fact LRM Account This entity stores the derived Staging
Customer attribute at account and
Relationship Details customer granularity (includes
joint accounts).
17 FCT_ACCT_PLACED_COLL_MAP | Fact Account Placed This table stores the account to Staging
Collateral Map placed collateral mapping. It is
an intersection table to denote a
placed collateral can be used in
multiple account and an account
contains multiple collateral.
18 FCT_COLL_PORTFOLIO_MTM_D | Fact MTM Collateral This table stores the MTM impact | Processed
ETAILS Details on derivative positions on a day-
to-day basis.
19 FCT_COLL_PORTFOLIO_MTM_ Fact MTM Collateral This table stores the MTM impact | Processed
SUMMARY Summary on derivative positions at a
cumulative level.
20 FCT_DEPOSITS_BORROWINGS Deposits And This table stores all the deposit Staging,
Borrowings and other borrowings accounts of | Results
bank.
21 FCT_IFRS_MITIGANTS _ Fact IFRS Mitigants This table stores the valuation of | Processed
SUMMARY Summary Mitigants as per IFRS
requirements. Mitigant definitions
happen in DIM MITIGANT and
this table serves as additional set
of attributes for FACT
MITIGANTS.
22 FCT_IFRS_PLACED_ Fact IFRS Placed This table stores the valuation of | Processed
COLLATERAL Collateral placed Collateral as per IFRS
requirements. Placed Collateral
definitions happen in DIM
PLACED COLLATERAL and this
table serves as additional set of
attributes for FACT PLACED
COLLATERAL.
Oracle Financial Services Software 88




OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
User Guide, Release 8.0.4.1.0

Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
23 FCT_LRM_ACCOUNT_ Fact LRM Account This table stores the details of Processed
SUMMARY Summary the Account Derived in Liquidity
Risk Management Solution.
24 FCT_LRM_PLACED _ Fact LRM Placed This table stores the liquidity Processed
COLLATERAL Collateral specific procedded attributes for
placed Collateral as per Liquidity
Risk regulations. Placed
Collateral definitions happen in
DIM PLACED COLLATERAL
and this table serves as
additional set of attributes for
FACT PLACED COLLATERAL.
25 FCT_MGMT_REPORTING Fact Management This table stores the Processed
Reporting management reporting data
related to organization and
product profitability/income
statement/balance sheet.
26 FCT_PLACED_COLLATERAL Fact Placed Collateral | This table stores the details of Staging
collateral which are placed
against an account.
27 FCT_RATING_DWNGRD_ Fact Rating This entity stores the details Processed
COLL_SUMMARY Downgrade Collateral | regarding loss of
Summary Rehypothecation Rights due to a
downgrade for a placed
collateral.
28 FCT_RATING_DWNGRD_ Fact Rating This entity stores the details Processed
MTGNT_SUMM Downgrade Mitigant regarding loss of
Summary Rehypothecation Rights due to a
downgrade for a mitigant.
29 FCT_REG_ACCOUNT_ Fact Regulatory This table stores the regulatory Results
SUMMARY Account Summary reclassifications and other
information as required for
regulatory reporting.
30 FCT_LEGAL_ENTITY_DETAILS Fact Legal Entity This table stores the details of Staging

Details

the legal entity.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
31 FCT_REG_AGG_CASH_FLOWS Fact Regulatory This entity stores the aggregated | Results
Aggregated cashflows for regulatory reporting
Cashflows purposes.
32 FCT_REG_CUSTOMER _ Fact Regulatory This table stores the details at a Results
SUMMARY Customer Summary customer level.
33 FCT_REG_GL_CASH_FLOWS Fact Regulatory This table stores the cashflow Results
General Ledger details of general ledger
Cashflows accounts for regulatory reporting
requirements.
34 FCT_REG_MITIGANTS_ Fact Regulatory This table stores the cashflow Results
SUMMARY Mitigants Summary groups required for FR2052 a
reporting.
35 FCT_REG_PLACED_ Fact Regulatory This table stores the cashflow Results
COLLATERAL Placed Collateral groups required for FR2052 a
reporting.
36 FCT_REG_RUN_LEGAL_ENTITY_ | Fact Regulatory Legal | This table stores the reporting Results
MAP Entity Run Map entity identifier for every
regulatory reporting run.
37 FCT_SUBST_PLACED _ Fact Substitutable This entity stores the details of a | Processed
COLLATERAL Collateral collateral which has to be
substituted.
38 FCT_SUBSTITUTABLE_ Fact Substitutable This entity stores the details ofa | Processed
MITIGANTS Mitigants mitigant which has to be
substituted.
39 FCT_TRANSACTION_SUMMARY Fact Transaction This table stores the transaction Results
Summary summary.
40 FCT_TRD_ACCOUNT_TXN_ Fact Trading Account | This entity stores all Fact Trading | Results
SUMMARY Transaction Summary | Account Transaction details.
41 FCT_FIXED_ASSETS Fact Fixed Assets This fact table stores measures Staging

pertaining to assets. Fixed
assets are physical assets such
as Buildings, Land, Machinary,
Automobiles, Gold bullion, and
so on. They can be sold and
appropriate profit/loss can be
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
recognized based on appropriate
accounting principles.
42 FCT_LLFP_ACCOUNT _ Fact Loan Loss This entity stores loan loss Processed
SUMMARY Forecasting And forecasting and provision
Provision Account account summary. Typically this
Summary table is an input from loan loss
forecasting and provision (llfp)
application.
43 FCT_REG_ACCT_MITIGANT _ Fact Regulatory This table stores the account Results
MAPPING Account Mitigant mitigant mapping information.
Mapping
44 FCT_CR_CUSTOMER _ Fact Credit Risk This entity stores the details of Staging
SUMMARY Customer Summary various measures pertaining to
the customer.
45 FCT_ASSETS_SOLD Fact Assets Sold This table stores the data of Staging
assets sold over a period of time.
For example, banks sells loans
to other parties.
46 FCT_ENTITY_INFO Fact Entity This entity stores the information | Staging
Information about the various entities in the
Oraganization Structure of the
Financial Institution.
a7 FCT_FIDUCIARY_SERV_ Fact Fiduciary This entity stores the details of Staging”
INVST_SUMM Services Investmnet investments done through a
Summary fiduciary account.
48 FCT_MERCHANT_BANKING Fact Merchant This entity stores the details of Staging
Banking issues associated with a fiduciary
account.
49 FCT_MITIGANT_REG_CAPITAL Fact Mitigant This table stores the regulatory Processed
Regulatory Capital capital information related to
mitigants.
50 FCT_REG_TRANSACTION_ Fact Regulatory This table stores the summary of | Results
SUMMARY Transaction Summary | regulatory transactions. For
example, amount of securities
sold or transferred from HTM to
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
AFS.
51 FCT_SECURITIZATION_POOL Fact Securitisation This table stores the information | Processed
Pool on the securitization pool.
52 FCT_SEC_EXPOSURES Fact Securitisation This entity stores all the Processed
Exposures Securitisation Exposures for
Basel Il processing.
54 FCT_INSTR_PROPOSED_TXNS Fact Instrument This table stores the proposed Staging
Proposed set of instruments that are
Transactions transacted by the Financial
Institution.
55 FCT_NON_SEC_EXPOSURES Fact Non This entity stores all the Processed
Securitisation Securitisation Exposures.
Exposures
56 FCT_NETTABLE_POOL Fact Nettable Pool This entity stores all Pools Processed
created for Netting.
57 FCT_PAYMENTS_SUMMARY Fact Payment This entity stores the payment Results
Summary value, Receipt or inward value
and Netted (payment and
receipts) value aggregated at
currency level in natural currency
and reporting currency.
58 FCT_CAP_INSTR_POSITIONS Fact Capital This entity stores the regulatory Staging
Instrument Positions position of capital instruments
and details of treatment to capital
instrument under Basel | and Ill
regulations.
59 FCT_REG_EXP_MITIGANT _ Fact Regulatory This table is planned for Processed
MAPPING Exposure Mitigant deprecation.
Mapping
60 FCT_CP_CREDIT_QUALITY_ Fact Counterparty This table stores the output of Processed
SUMMARY Credit Quality CVA calculation done for a given
Summary counterparty.
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Sl.

No.

List of Seeded Tables

Table/Entity Logical
Names

Table/Entity Descriptions

Data Flow
Type

61

FCT_MORT_SERV_RIGHTS

Fact Mortgage
Servicing Rights

This tables stores the Mortgage
Servicing Rights valuation
information. Mortgage Servicing
Rights values are typically book
value, fair value, and so on.

Processed

62

FCT_REG_LE_CAPITAL_
SUMMARY

Fact Regulatory Legal
Entity Capital
Summary

This table stores the regulatory
capital related information for the
legal entity. This table stores all
information from the GL related
to the capital structure
processing and the various levels
of capital computations
processed and computed by the
application. This stores
information at the granularity of
the capital line item, for each
capital component group. Some
of the line items stored are Tier 1
Capital, Tier 2 Capital, Total
Capital, and Capital Ratio.

Results

63

FCT_REG_CP_CAPITAL
SUMMARY

Fact Regulatory
Counterparty Capital
Summary

This table stores all the
regulatory capital related
information of a counterparty.
Some of the risk parameters in
this table are probability of
default and internal and external
rating for the counterparty. This
table is generally used for CVA
and default fund calculations.

Processed

64

FCT_REG_CAP_PLCD_COLL_
SUMMARY

Fact Regulatory
Capital Placed
Collateral Summary

This table stores the information
of all exposures to a bank which
are placed collateral. The placed
collateral by the bank is for
default fund contribution or for
other OTC transactions, with a
central counterparty. It is
generally used for cleared
transactions and default fund
contributions.

Processed
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
65 FCT_REG_CAP_POOL_ Fact Regulatory This table stores the information Processed
SUMMARY Capital Pool of all exposures to a bank, which
Summary are at a pool level. Some of the
pool identified for this table are
OTC nettable pool and retail
pools. This table stores the
regulatory capital information
related to these pools.
66 FCT_LOANS_SERVICED Fact Loans Serviced This table stores the details of Staging
loans serviced by bank. They
may or may not be originated by
the bank.
67 FCT_FUND_CIS_COMPOSITION Fact Fund CIS This entity stores the Staging
Composition composition of the Investment
funds.
68 FCT_CAP_INSTR_TXNS Fact Capital This entity stores the Staging
Instrument transactions on the capital
Transactions instruments.
69 FCT_CREDITRISK_ACCOUNT_ Fact Credit Risk This entity stores the different Processed
SUMMARY Account Summary measures of exposures
pertaining to Credit Risk
Analytics.
70 FCT_LIQUIDITY_REPORTING Fact Liquidity This entity stores the measure to | Processed

Reporting

be reported for each of the
Liquidity Reporting line.
Reporting Measures are the
amounts displayed in standard
template prescribed by
supervisor. For example,
Reporting lines and measures
mentioned in QIS Reporting
Template reporting lines,
reporting lines and measures
mentioned in "Instructions for
completing and submitting the
Liquidity Monitoring Tool (4-G)

template”.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
71 FCT_LIQUIDITY_REP_LINE_ Fact Liquidity This entity stores the comments Processed
COMMENT Reporting Line for each of the Liquidity
Comments Reporting line. Reporting Lines
are the standard template
reporting lines prescribed by
supervisor. For example,
Reporting lines mentioned in QIS
Reporting Template reporting
lines, reporting lines mentioned
in "Instructions for completing
and submitting the Liquidity
Monitoring Tool (4-G) template".
72 FCT_REG_EQ_INV_SUMMARY Regulatory Equity This table stores the summary of | Results
Investmnet Summary | equity investments done by entity
as per regulatory equity
investment types.
73 FCT_OTTI_FV_PROJECTIONS Fact Other Than This table store the assumptions | Processed
Temporary to determination criteria and
Impairment Fair value for Other-than-temporary
Value Projections impairment for product
investment.
74 FCT_OPSRISK_LOSS _ Fact Operational Risk | This table stores the projection of | Processed
PROJECTION Loss Projection operational losses across
required measurement units and
period for a given operational
loss data category.
75 FCT_OTTI_FV_ASSUMPTIONS Fact Other Than This table stores the Processed
Temporary assumptions to determination
Impairment Fair criteria and value for Other-than-
Value Assumptions temporary impairment for product
investment.
76 FCT_SCEN_VARIABLE_ Fact Scenario This table stores the projection of | Processed

PROJECTION

Variable Summary

various variables for Enterprise
Stress Testing or any other
similar usage.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
77 FCT_CAP_INSTR_PROPOSED_R | Fact Capital This entity stores the proposed Staging
EDEEM Instrument Proposed | set of capital instruments that are
Redemption redeemed or converted by the
Financial Institution.
78 FCT_CAP_INSTR_PROPOSED_ Fact Capital This entity stores the proposed Staging
ISSUES Instrument Proposed | set of capital instruments that are
Issues issued by the Financial
Institution.
79 FCT_REGULATORY_PLANNED_A | Fact Regulatory This table stores the impact of Processed
CTION Planned Actions Planed Actions on various
measures like capital, RWA,
exposure, and so on that are
required for Basel Ill and Dodd-
Frank schedule. Financial
Institutions must capture all
material planned actions,
including, but not limited to, the
roll-off or sale of an existing
portfolio, the issuance of
regulatory capital instruments
and other strategic corporate
actions.
80 FCT_REPORTING_GROUP_ Fact Reporting Group | This entity stores the outputs at Processed
OUTPUT Output Reporting Group Level.
81 FCT_STANDARD_ACCT_HEAD Fact Standard This table stores the data as per | Processed
Accounting Head the standard accouning heads.
82 FCT_CARDS_BALANCE_ Fact Cards Balance This table stores the cards Staging
SUMMARY Summary summary details of cards like
eop bal, interest rate, current
payment, and others against
card balance category.
83 FCT_PFT_ACCOUNT_ SUMMARY | Fact PFT Account This table stores the account Processed

Summary

level measures computed by the
PFT application.
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Sl. List of Seeded Tables Table/Entity Logical | Table/Entity Descriptions Data Flow
No. Names Type
84 FCT_REG_CP_EXP_MTM_DTLS Regulatory This table stores the MTM
Counterparty summary for a given
Exposure Mitigant counterparty and Netting
Summary agreement for business as usual
and stressed scenarios.
85 FCT_CREDIT_PARTCPTN_TRNC | Fact Credit This entity maps the participation
H_MAP Participation Tranche | to various tranches.
Map
86 FCT_ACCT_CREDIT_SCORE_DE | Fact Account Credit This entity stores the details of
TAILS Score Details the credit score of account
thoroughout its lifetime.
87 FCT_SERV_ACCT_CREDIT_SCO | Fact Serviced This entity stores the details of
R_DTL Account Credit Score | the credit score of serviced
Details account thoroughout its lifetime.
88 FCT_INSTRUMENT_PD_DETAILS | Fact Instrument This table stores the probability
Probability of Default | of default values as of given date
Details for all relevant instruments.
89 FCT_CUSTOMER_PD_DETAILS Fact Customer This table stores the probability
Probability of Default | of default values as of given date
Details for all relevant customers.
20 FCT_REG_HEDGE_SUMMARY Fact Regulatory This table stores summary of
Hedge Summary hedged portfolio set which
includes effective and ineffective
portion of gain and loss, hedged
notion amount, IRC used, and so
on.
91 FCT_HEDGE_PORTFL_SET_ACC | Fact Hedge Portfolio This table stores the unique
_MAP Set Account Map hedge identification providing
summary of accounts that are
"Hedged" and instrument which
is used for "Hedging".
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3.2 Mapping of Results to Reporting Requirements of Lombard Risk

Figure 28 explains the flow of data between OFSAA and AgileREPORTER:
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Figure 28: Data Flow between OFSAA and AgileREPORTER

OFSAA provides the data to AgileREPORTER in the form of derived entities. Derived entity is an existing
OFSAA higher order metadata object and can be physicalized as a materialized view in the database.
Derived entities store aggregated data from base fact entities specified in the dataset and have the
necessary dimensions and measures. Dimensional and measure combination stored within the derived
entity is mapped to cells within the report. This mapping is maintained within the ‘Dimensional mapping’
template. ‘Decision Process’ within AgileREPORTER reads the derived entities and dimension mapping
information to derive the data for reporting. Derived entities are created based on measures, hierarchies,
and datasets.

Decision Agile
Process REPORTER

Figure 29: Decision Process in AgileREPORTER

Some cells in the schedule can be derived as per the logic provided by the regulator. Derivation can be
an expression built using values from other cells. Examples of derivation are ratio, node-level rollup,
direct reference to cells in other schedules within the report. These derivations are performed within the
AgileREPORTER. OFSAA provides data only for the cells that are not derived.
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Note: Metadata for data transformation is available as part of the data ware house configuration pack
provided Out-of-Box / pre-configured from OFSAA. You need not perform any mapping for the reports.
However, this information can be useful for maintainance or extensions when Out-of-Box pack is not
available.

3.3 AgileREPORTER: Submission

The AgileREPORTER is a web-based regulatory reporting tool provided by Lombard Risk. It provides
necessary features to address e-filing workflow, validation and submission process, and supports reports
(called as forms/returns) for various jurisdictions. AgileREPORTER provides a reliable and efficient
infrastructure to compile, generate, and submit regulatory reports.
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4 OFSAA Features

This chapter provides an understanding of the AAI components used in the solution and dimensional
mapping. It includes:

¢  OFSAA Infrastructure

¢ Business Metadata

¢ Derived Entity
¢ Rules Run Framework Features

¢ Dimension Mapping

Regulatory Reporting (REG REP) Solution configures the data hand off structure to Lombard using
metadata. The following sections provide details on datasets, measures, hierarchies and Derived Entities.
Multiple derived entities are linked to a specific regulatory schedule. You can modify the configuration
using OFSAA infrastructure. Additionally, metadata route provides traceability from reporting elements to
the data elements used.

4.1 OFSAA Infrastructure

OFSAA Infrastructure includes the facilities for creating and maintaining dimensional reference data,
interest rate and currency exchange rate data, and process tuning data. Additionally, OFSAA
Infrastructure includes functionality for building and maintaining rules that can be used by any Oracle
Financial Services Analytical Application. These common rule objects include:

¢ Expressions

¢ Hierarchies

¢+ Filters

The analytical applications that you see on the Left Hand Side (LHS) of the Financial Services
Applications home page depends on your logon privileges and on the OFSAA modules that are installed
for your environment.
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Figure 30: Landing Page

4.2 Business Metadata

In addition to Derived Entity, REG REP uses the following OFSAA features to create the business
metadata. For details on the features, refer to OFS Analytical Applications Infrastructure User Guide in
OHC documentation library.

¢

Hierarchies: Some OFSAA dimensions support hierarchies. Hierarchies can be used to provide
sophisticated stratification for either processing or reporting purposes. For example, an
organizational hierarchy can start with a Division level containing Western Region, Eastern
Region, and Southern Region; the next level down within the hierarchy can be state or county. A
product hierarchy can begin with branches for Asset vs.Liability vs. Service products; under the
Asset branch, you can define additional branches for Mortgage Lending, Commercial Lending,
Consumer Lending, and so on.

Measures: Business Measure refers to a uniquely named data element of relevance which can
be used to define views within the data warehouse. It typically implies aggregated information as
opposed to information at a detailed granular level that is available before adequate
transformations.

Business Processor: It refers to a uniquely named data element of relevance which can be used
to define views within the data warehouse. It typically implies aggregated information as opposed
to information at a detailed granular level that is available before adequate transformations.

Datasets: It refers to a group of tables whose inter-relationship is defined by specifying a join
condition between the various tables. It is a basic building block to create a query and execute on
a data warehouse for a large number of functions and to generate reports.
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4.3 Derived Entity

It is the primary component of OFSAA used for OFSDF Interface with Lombard Risk for US FED.
Regulatory Reporting (REG REP) Solution uses Derived Entity to create physical materialized view which
is then queried by Lombard using pre-set data hand-off templates. An Entity refers to a table in which
data is stored. Derived Entity within the infrastructure system facilitates you to define entities which are
populated through a series of data transformation processes resulting from an existing Data Set or a
Source Application. An Entity can be used to define other Business Metadata such as measures,
hierarchies, dimensions, data sets, and cubes.
Derived Entities comprise the following:

¢ Measures

¢ Hierarchies

¢ Datasets
Ensure to define the above components within OFSAA before configuring the derived entity, and select
Materialized View property in Derived Entity. This property creates the derived entity as materialized

views.
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Figure 31: Derived Entity User Interface
Derived Entities must have AS_OF DATE and LEGAL_ENTITY as the mandatory dimensions. Rest of
the structure of the derived entity can vary depending on the dimensions present. A metadata
configuration table is present in AgileREPORTER to link the name of the column in the derived entity and
dimension that is referred in dimension mapping process.
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Derived entities have data for the ‘Final Reporting Run’ only, which is reported to the Regulatory, and are
refreshed for the latest hand-off date.

A metadata configuration table is maintained within AgileREPORTER to capture the derived entities that
supply data for each schedule.

4.3.1 Creation of Derived Entity

Refer to OFS Analytical Applications Infrastructure User Guide in (OHC) documentation library for
detailed steps on creating a derived entity.

4.3.2 User Roles

Following are the user roles for derived entity:

¢+ Reporting Analyst: This user can create, modify, and delete a derived entity.

¢+ Data Analyst: This user can view the derived entities.

4.4 Rules Run Framework Features

OFSDF Interface with Lombard Risk for US FED uses the following Rules Run Framework of OFSAA. For
details on the features refer to OFS Analytical Applications Infrastructure User Guide in OHC
documentation library.

¢+ Rules: Financial institutions require constant monitoring and measurement of risk in order to
conform to prevalent regulatory and supervisory standards. Such measurement often entails
significant computations and validations with an organization’s data. Data must be transformed to
support such measurements and calculations. The data transformation is achieved through a set
of defined Rules.

REG REP uses Rules for reclassification of dimensions.

¢ Process: A set of Rules collectively form a Process. A Process definition is represented as a
Process Tree. The Process option in the Rules Run Framework provides a framework that
facilitates the definition and maintenance of a Process. By defining a Process, you can logically
group a collection of Rules that pertain to a functional process.

¢ Run: The Run feature in the Rules Run Framework helps you to combine various components
and/or processes together and execute them with different underlying approaches. Further, run
conditions and/or job conditions can be specified while defining a run.

4.5 Dimension Mapping

Each cell reference is mapped to a set of dimensions and measures. This mapping is documented in
excel and then converted to a Decision table through an offline utility provided by AgileREPORTER.
Decision table is a metadata object within AgileREPORTER that stores the criteria for deriving value for
each cell reference. The metadata is packaged for regulatory report as part of the OFS Risk Regulatory
Solution. Decision table process within AgileREPORTER reads the metadata and derived entity published
by OFSAA to populate data required for returns for the specified date and legal entity.
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The following table is an example of dimension mapping. Each cell reference is mapped to a set of
dimension members and measure. If a dimension is left empty for a cell reference, it indicates that it is not
participating in the mapping process. If there are multiple mappings for a cell reference, then the value of
this cell can come from any of these criteria.

Decision mapping table is processed against the contents of derived entity to reporting data. Each record
of the derived entity is matched against the criteria specified in the decision table to identify the cell
reference and derive return data (such as, cell reference and cell value).

Table 11: Dimension Mapping Example 1

Cell . Branch
2
References Is Derived? Product Type Customer Type Country Measure
BHCK1234 No Real Estate Individuals us Amortized Cost
Loans
BHCK1235 No Real Estate Individuals Non-US Amortized Cost
Loans
BHCK9088 Yes
BHCK1598 No Credit Cards Individuals Amortized Cost
BHCK7075 No Foreign Banks Non-US Amortized Cost
BHCK7075 No Sovereign Non-US Amortized Cost

The following table is derived after converting the dimension member and measure names into
corresponding dimension member codes (nhot surrogate keys) and measure codes. This decision table
mapping is provided for each decision table in excel format as per template. AgileREPORTER converts
the decision table mapping present in excel into configuration entries within their schema.

Table 12: Dimension Mapping Example 2

CR:glflerences Is Derived? Product Type Customer Type Eginnct?y Measure
BHCK1234 No RELO IND us MREGO0001
BHCK1235 No RELO IND Non-US MREGO0001
BHCK9088 Yes

BHCK1598 No CC IND MREGO0001
BHCK7075 No FB Non-US MREGO0001
BHCK7075 No SOV Non-US MREGO0001

Note: All the dimension member codes that are used in the decision table are preseeded by OFSAA and
cannot be modified. Therefore, if you have other member codes in the dimension, then you must
re-classify them by using re-classification rule post load, or value-code mapping during load.
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Decision tables must be prepared closer to the report submission period. In some cases, reclassification
of multiple dimensions which result in a single unified reporting dimension must be performed in order to
address the complexity of decision table. Reclassification rule is defined in OFSAA and packaged as part
of OFSAA Risk Regulatory Reporting (REG REP) Solution.

In some cases, certain sections of the schedule or the entire schedule can be a list of data rows without
any mapping to fixed set of dimension members. For example, Top 20 counterparties, List of Available for
Sale (AFS) - securities. In such cases, since there are no cell references, decision table mapping
specifies the names of dimensions and measures of derived entities in ‘sheet’ column or ‘row’ column of
the template.

Note: As a part of the solution, metadata exists as out of box / pre-configured with installer.
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5 Executing Run through Run Management

Starting from OFSDF 8.0.3.1.0 release, we are packaging two out of the box Runs for data loading. Same
can be executed through the Run Management screen. The following are the two runs that are packaged
as part of Installer.

¢+ Financial Services Data Foundation Sourced Run: This Run can be executed once per day for
Data Movement from Staging Area to Results Area for Non-RUN SKEY tables.

¢ OFS REG REP USFED Run: This Run can be executed any number of times per day with each
unique RUN SKEY for Data Movement in Run enabled tables.

5.1 Summary and Details Page

Upon initially navigating to Run Management - Run Management, a summary page is displayed
showing all the defined Runs. By selecting a Run or by using search criteria, you can control the set of
Runs that are displayed. This page displays the list of runs defined in the Run Rule Framework (RRF)
except those with Immediate Execution Option Yes in the grid.

5.2 Navigation within the Summary Page

When you first navigate to the Run Management summary page, the Runs defined in the RRF are
presented in a summary grid. The Run Management summary page has two sections:

¢ Search

¢ List of Runs

5.2.1 Search Section

Among other properties, each Run possesses a segment, a Run Name, and a Run Type. You may
search on any of these properties in the Search section.

’ B v XA v | usengisnv | oFsav
ORACLE Financial Services Analytical Applications
ppiications | Object Administaton  System Conigu sty Management

Figure 32: Search Section
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5.2.2 List of Runs Section

The List of Runs section presents a grid containing all of the Runs that meet your search criteria. This
summary grid offers several icons that allow you to perform different functions when a Run is selected.

To select a Run, click the check box in the first column of the grid.

¢+ View: Selecting a single row out of the grid enables the View icon. Clicking the View icon allows
you to view the detailed definition of a Run on a read-only basis. The View icon is only enabled
when a single Run has been selected.

¢+ Run Default Parameters: Selecting a single row out of the grid enables you to define the default
parameters of a Run.

¢ Run Execution Parameters: Selecting a single row out of the grid enables you to define the
execution parameters of a Run.

¢ Run Execution Summary: Selecting a single row out of the grid enables you to view the status

of the Run executed in the Run Execution parameters window.

5.2.2.1 List of Runs Summary Grid

The following columns categorize each Run in the summary grid:
¢ Run Name: Displays the short name of the Run.
¢+ Run Type: Displays the type of Run, Simulation or Baseline Run.
¢+ Created By: Displays the name of the User who defined the Run.
¢+ Creation Date: Displays the date on which the Run was created.

¢+ Last Modified By: Displays the name of the user who has performed any modifications to the
Original Run details.

¢ Last Modified Date: Displays the date on which the Original Run details were modified.
5.2.3 Navigation within Run Default Parameters Window

Click Run Default Parameters icon on the navigation bar of the Run Management Summary Window to
input the Run level parameters. The Run Parameters Window is displayed.

Services Data Foundation > Run Management > Run Management

Run Management Summary

Segment [usFEDSEG v Run Name

Run Type C v

4 List of Runs | | $1to10f1
Run Name Run Type Created By Created Date Last Modified By Last Modified Date
US FED Run BASELINE RUN SYSADMN 08/0172016

Figure 33: Run Management Summary
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NOTE: To modify or view the parameters the Modify Run Parameters role should be mapped to that
relevant user profile.

This window consists of two sections Run Details and Run Execution Parameters.

5.2.3.1 Run Details Section

This section displays the name of the Run which is a read-only value.

5.2.3.2 Run Execution Parameters Section

In this section, you can update the following:

¢ Reporting Currency: Reporting Currency Code parameter is used for calculation of amounts in
Reporting Currency during Data Population.

¢+ Legal Entity: Legal Entity Code parameter is used for identifying the legal entity, which is used
for the Run.

¢+ Consolidation Type: Consolidation Type parameter is used for selecting legal entities on a solo
or consolidation basis. In a solo run, only the selected legal entity will be used. In a consolidated
run, along with the selected legal entitiy, all its child legal entities are also used.

¢ Consolidation Hierarchy: Legal Entity Hierarchy is used for selecting the required hierarchyfor
the consolidated run. This parameter is not required for solo run.

# s Run Details

Run Name US FED Run

# = Run Execution Parameters
Reporting Currency *

Legal Entity *

Consolidation Type * [Consolidated v

Consolidation Hierarchy *

FIC MIS Date * E’

Run Execution Description

Save | Execute | Close

Figure 34: Run Parameters Window

Before proceeding further, to ensure that you do not lose the updated data, click Save.

NOTE: To get the values for Reporting Currency parameter and Legal Entity parameter, you need to

save the following hierarchies under Save Metadata screen:
1. Legal Entity Code for Run (HFSDFO001)
2. Reporting Currency Code for Run (HFSDF002)
3. Legal Entity Hierarchy for Run (HFSDFO003)
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For further details on Save Hierarchy, refer to Oracle Financial Services Advanced Analytical
Applications Infrastructure Application Pack 8.0.4.0.0 on OHC.

The values selected for reporting currency and Legal entity for the selected Run is shown as the default
selected value in the Run Execution Parameters screen.

5.2.4 Navigation within Run Execution Parameters Window

Click Run Execution Parameters icon on the navigation bar of the Run Management Summary window.
The Run Execution Parameter window allows you to enter and save the Run execution parameters.

# 2k Run Details

Rim Name US FED Run
# == Run Execution Parameters
Reporting Currency * usD
Legal Entity * Others Leee
Consolidation Type * Consolidated v

Consolidation Hierarchy * Default Org Structure Hierarchy

FIC MIS Date * 10/05/2017 EJ
Run Execution Description USFED Reguiatory Run
| Save | } Execute Close |
# Audit Panel
Created By SYSADMN Created Date 08/01/2016
Last Modified By - Last Modified Dale

Figure 35: Run Execution Parameters Window

The Run Execution Parameters window consists of two sections Run Details and Run Execution
Parameters.

5.2.4.1 Run Details Section

This section displays the name of the Run which is a read only value.

# 2 Run Details A

Ri Name US FED Run

Figure 36: Run Details

5.2.4.2 Run Execution Parameters Section

The following Run execution parameters can be updated:

¢ Reporting Currency: Reporting Currency Code parameter is used for calculation of amounts in
Reporting Currency during Data Population.
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¢ Legal Entity: Legal Entity Code parameter is used for identifying the legal entity, which is used
for the Run.

¢ FIC MIS Date: Enter the extraction date in this field.

¢ Run Execution Description: Enter a longer description of the Run.

NOTE: To get the values for Reporting Currency parameter and Legal Entity parameter, you need to
save the following hierarchies under Save Metadata screen:
1. Legal Entity Code for Run (HFSDF001)
2. Reporting Currency Code for Run (HFSDF002)

By clicking the Save button; a batch with the defined Run execution parameters is created. The batch
created can be executed from the Batch Execution screen.

By clicking the Execute button, a batch with the defined Run execution parameters is created and
executed immediately. Status of the executed run can be seen in Batch Monitor screen or Run Execution
Summary page.

NOTE: For further details on Save Hierarchy and Batch Execution, refer to Oracle Financial Services
Advanced Analytical Applications Infrastructure Application Pack 8.0.4.0.0 on OHC. To execute
a Run, the execute run role should be mapped to your user profile. Currently, the users mapped
under FSDF Admin or FSDF Operator User Groups automatically have this role.

5.2.5 Navigation within Run Execution Summary Page

Select a Run from the Run Management Summary page and click Run Execution Summary icon to
display the Run Execution Summary page where the following sections are displayed.

Run Skey Run Execution id FIC MIS DATE Execution Status Execution Date Time of Execution Reporting flag

Close

Figure 37: Run Execution Summary

This section consists of the two sections Run Execution Summary and Run Execution Details.

5.2.5.1 Run Execution Summary Section

The Run Execution Summary displays the following details:
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¢

¢

¢

Run Name: Displays the name of the Run.
Run Type: Displays the type of Run, Baseline or Simulation.

Run ID: Displays the Run Execution ID.

5.2.5.2 Run Execution Details Section

The Run Execution Details section presents a grid containing all of the executions of Run and status of a
particular execution of the Run. The menu bar in this grid offers several icons that allow you to perform
different functions when a Run Execution is selected. To select a Run Execution, click the check box in
the first column of the grid. More than one Run Execution can be selected at a time but this will cause
some of the icons to become disabled.

¢

Parameter details: Click this icon to view the Run execution and Run default parameter details in
read-only mode.

Copy: Click Copy icon, to copy the parameters as defined in the Run Execution Parameter
window to create a new batch.

Execute: Click Execute icon to trigger the batch which has been created from the Run Execution
Parameter window. The status of the triggered batch is displayed. In the Execution Summary
page, multiple selections of the execution IDs are available to trigger a batch.

Request Report Flag: To request for a Report Flag, select a Run Execution ID in the Run
Execution Summary page and click Request for Reporting Execution icon. A dialog box
appears to input your comments. Click Submit and the status of this Run is displayed in the
Report Flag section. Only a successful execution can be requested for reporting. For the selected
Run and Execution date, there can be only one reporting flag.

Override Report Flag: Any reporting execution can be overwritten with another execution. Select
a successfully triggered batch in the Run Execution Summary page. The Override Report Flag
icon is enabled, if an execution is already marked as a Report Flag. You can override the
execution by updating your comments. This should be approved by the approver and the
procedure is similar to the procedure detailed in the Approve Report Flag section.

Approve Report Flag: After submitting the Reporting Run in the earlier section, the Approve
Report Flag icon is enabled. After clicking the icon, a dialog box with the User Comments and
Approver Comments is displayed. The Approver can update the comments in the Approver
Comments field and then click Approve or Reject button accordingly.

5.2.5.3 Run Execution Grid

The Run Execution Details displays the following details:

¢

¢

¢

Run Skey: Displays the Run skey of an individual execution.
Run Execution ID: Displays the execution ID of the Run.

FIC MIS DATE: Enter the extraction date in this field.
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¢+ Execution Status: Displays the status of the execution which is failed or complete.
¢+ Execution Date: Displays the date when the Run was executed.

¢+ Time of Execution: Displays the time when the Run was executed.
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6 Metadata Export Utility

The Metadata Export Utility helps the user to export OFSAA metadata into Excel Sheet. This feature
helps to get a view of OFSAA metadata and its dependencies. It is a template based approach where-in
user creates templates and selects Metadata Objects that need to be extracted. The extraction process is
supported only for Excel Sheet. While defining the template, user is expected to have prior knowledge of
the OFSAA Metadata objects that are relevant from his application point of view.

6.1

Prerequisites

The following executions must be performed before using the Metadata Export Utility:

1. MDB Publish: Execute the batch, INFODOM_MDB
2. Logs: MDB logs are generated under deployed area /Context_Name/logs/MDB_XXXX.log
3. Data Elements Wrapper Execution: After MDB Publish is completed succesfully with message
“Metadata publishing is finished.” in the /Context_Name/logs/MDB_XXXX.log, you must execute
the Data Elements Utility with the following seeded batch to get the Data Lineage for each
Metadata in OFSAA:
<INFODOM>_POP_DATA_ELEMENTS_USFED
NOTE: This execution requires adequate tablespace. Ensure that your Atomic Schema is having
enough tablespace in TEMP and USERS.
Parameters used in DATA_ELEMENTS Batch
The batch can be executed in different modes according to each requirement. The following are
the parameters used for executing the batch.
You can edit the parameters by accessing the Batch Maintainance screen.
a. Login to Oracle Financial Services Analytical Applications interface with your credentalils.
b. Navigate to Applications = Financial Services Data Foundation - Operations >
Batch Maintenance
c. Select Batch Name (<INFODOM> POP_DATA_ ELEMENTS_USFED)
Select Task1 and click the Edit button. The EditTask Definiton Window is displayed.
Modify the Parameter List field as applicable.
NOTE: The values must be in single quotes and comma separated for each value. Follow the same
order as in this table.
Sl. No. | Parameter Description List of Values Default Value
1 P_METADATA_FLAG Metadata Parser Flag | Y/N Y’
2 P_REPORT_FLAG Report Parser Flag Y/N Y’
3 P_MDR_USAGE_FLAG | Usage Parser Flag Y/N ‘N’
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Sl. No. | Parameter Description List of Values Default Value
4 P_MDR_MD_DF_FLAG | Metadata to DataFlow | Y/N ‘N’
Flag

5 P_INFODOM_NAME Infodom Name ##INFODOM## | <Value of the
Infodom where
USFED is
installed>.

For example:
‘USFEDINFO’

6 P_SEGMENT_CODE Segment Code #H#SEGMENT## | <Value of
Segment Code
which is used
while installing
USFED>.

For example:
‘USFEDSEG’

7 P_REG_APP_ID Application Identifier ##APPID## Application ID for

US FED.
For example:
‘OFS_REG_REP
_USFED’
¢ Metadata Parser Flag (P_METADATA_FLAG): By enabling this flag, the data
elements utility parses all the Business Metadata like Business Hierarchies, Business
Measures, Business Processes, Derived Entities, Datasets, Aliases and its lineage
between them. It also parses Data Flow Metadata like T2Ts, SCDs, Rules, and the
lineage between them.
¢+ Report Parser Flag (P_REPORT_FLAG): By enabling this flag, the data elements
utility parses all the Dashboards, Reports, Schedules, Views, and join these outputs
with the Metadata which are already parsed through the Metadata Parser Flag
(P_METADATA_FLAG).
NOTE: Even if this flag is enabled, the Dashboards which get parsed depend on the

FSI_DE_POP_REPORT_LIST table in Atomic Schema. By default, all Dashboards are enabled
and if you wish to parse particular Dashboards, modify the FSI_DE_POP_REPORT_LIST table
by enabling / disabling the “Include Report Column”. The following are the default Dashboards

packaged.

DASHBOARD ID JURISDICTION CODE REPORT CODE INCLUDE REPORT
1 USFED FRY-9C Y
2 USFED FRY-9LP Y
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DASHBOARD ID JURISDICTION CODE REPORT CODE INCLUDE REPORT
3 USFED FFIEC-009 Y
4 USFED FFIEC-009a Y
5 USFED FRY-15 Y
6 USFED FRY-20 Y
7 USFED FRY-12 Y
8 USFED FRY-11 Y
9 USFED FRY-11s Y
10 USFED FR-2314 Y
11 USFED FR-2314s Y
12 USFED FR-2052A Y
13 USFED FR-2052B Y
14 USFED FRY-14Q Y
15 USFED FRY-14A Y
16 USFED FFIEC-031 Y
17 USFED FR-2886B Y
18 USFED FFIEC-041 Y
19 USFED FRY7N Y
20 USFED FFIEC101 Y
21 USFED FR-2900 Y
22 USFED FDIC-8020 Y
23 USFED FRY-14M Y
24 USFED FR-2644 Y

NOTE: After the Metadata Parsing is completed and if there are no further changes in Business
Metadata and Data Flow Metadata, you can execute the batch by disabling the Metadata Parser
Flag (P_METADATA_FLAG). Now the Metadata is not parsed again, but the Report newly
enabled through FSI_DE_POP_REPORT_LIST table is parsed.
If there is a change in Business Metadata and Data Flow Metadata, you need to enable the
Metadata Parser Flag (P_METADATA_FLAG) and parse once again.

¢ Usage Parser Flag (P_MDR_USAGE_FLAG): By enabling this flag, the data
elements utility parses all the Entities and joins these outputs with the Metadata
which are already parsed through Metadata Parser Flag (P_METADATA_FLAG).
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¢ Metadata to DataFlow Flag (P_MDR_MD_DF_FLAG): By enabling this flag, the
data elements utility joins all the Business Metadata parsed output with Data Flow
parsed output for all applications.

¢+ Infodom Name (P_INFODOM_NAME): This is the value of the Infodom where
OFS_REG_REP_USFED is installed. No need to modify this value.

¢ Segment Code (P_SEGMENT_CODE): This is the value of the Segment Code
which is used while installing OFS_REG_REP_USFED. No need to modify this value.

¢+ Application Identifier (P_REG_APP_ID): This is the application identifier of the
product (OFS_REG_REP_USFED). No need to modify this value.

6.1.1 Verifying Logs

Data Elements logs are generated in Atomic Schema under the FSI_MESSAGE_LOGS table.

Flag

Batch Run ID

Indication

P_METADATA_FLAG

METADATA_ELEMENTS

Processes Business Metadata.

The message “Completed Over ALL
Metadata” indicates that the Business
Metadata parsing is complete.

P_METADATA_FLAG

ULTIMATE_METADATA_ELEME
NTS

Calculates Ultimate Table/Column for
Business Metadata.

The message “Completed
ULTIMATE_METADATA_ELEMENTS”
indicates that the Business Metadata
Ultimate elements parsing is complete.

P_METADATA_FLAG

DATA_FLOW_ELEMENTS

Processes Data Flow Metadata.

The message “Completed Elements for
DATA_FLOW_ELEMENTS” indicates
that the Data Flow Metadata parsing is
complete.

P_METADATA_FLAG

ULTIMATE_DATA_FLOW_ELEM
ENTS

Calculates Ultimate Source
Table/Column for Data Flow Metadata.
The message “Completed
ULTIMATE_DATA_FLOW_ELEMENTS
” indicates that the Data Flow Metadata

Ultimate elements parsing is complete.

P_METADATA_FLAG

POP_MDR_LINEAGE_METADAT
A

Links Data Flow Metadata Lineage with
Metadata Browser.

The message “Completed
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Flag

Batch Run ID

Indication

MDR_METADATA Data Flow” indicates
that the Metadata Lineage parsing is

complete.

P_REPORT_FLAG

REPORT_ELEMENTS_OFS_RE
G_REP_USFED

Processes Dashboard Elements from
FSI_M_CELL_DIM_VAL and
FSI_M_CELL_DEFN.

The message “Completed
REPORT_ELEMENTS for
OFS_REG_REP_USFED” indicates
that the Dashboard Metadata parsing is

complete.

P_REPORT_FLAG

REPORT_TO_TARGET_MAP_O
FS_REG_REP_USFED

Processes Dasbboard with Processed
Business Metadata.

The message “Completed
REPORT_TO_TARGET_MAP for
OFS_REG_REP_USFED” indicates
that the Dashoboard to Business
Metadata parsing is complete.

P_REPORT_FLAG

REPORT_TO_SOURCE_MAP_O
FS_REG_REP_USFED

Processes Dasbboard with Processed
MDR Lineage.

The message “Completed
REPORT_TO_SOURCE_MAP for
OFS_REG_REP_USFED” indicates
that the Dashboard to Data Flow
Metadata parsing is complete.

P_REPORT_FLAG

POP_FINAL_ELEMENTS_OFS_
REG_REP_USFED

Processes Final Data Elements for
USFED.

The message “Completed
POP_FINAL_ELEMENTS for
OFS_REG_REP_USFED” indicates
that all the Dashboard related Metadata

parsing is complete.
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Flag

Batch Run ID

Indication

P_MDR_USAGE_FLAG

DATA_FLOW_USAGE

Processes Data Flow Usage.

The message “Completed Elements for
DATA_FLOW_USAGE?” indicates that
the Data Flow Usage Metadata parsing
is complete.

P_MDR_USAGE_FLAG

ULTIMATE_DATA_FLOW_USAG
E

Calculates Ultimate Table/Column
Usage for Data Flow Metadata.

The message “Completed
ULTIMATE_DATA FLOW_USAGE”
indicates that the Data Flow Ultimate

Usage Metadata parsing is complete.

P_MDR_USAGE_FLAG

POP_MDR_LINEAGE_METADAT
A

Links Data Flow Usage Lineage with
Metadata Browser.

The message “Completed
MDR_METADATA Data Flow” indicates
that the Data Flow Usage MDB
Metadata parsing is complete.

P_MDR_MD_DF FLAG

METADATA_TO_DATAFLOW

Processes Parsed Business Metadata
joined with Parsed Data Flow Metadata.

The message “Completed
METADATA_TO_DATAFLOW’
indicates that the Business Metadata to
Data Flow Metadata parsing is

complete.

6.1.2 Validating Lineage Outputs

In Atomic Schema, you must verify that data is present in the following tables and ensure that the

table is populated:

¢ MDR_LINEAGE_METADATA
¢ FSI_DE_REPORT_SOURCE_DETL_MAP
¢ MDR_USAGE_METADATA (Optional, data is populated only if P_MDR_USAGE_FLAG

is enabled.)

¢ FSI_DE_METADATA_SOURCE_DETAILS (Optional, data is populated only if
P_MDR_MD_DF_FLAG is enabled.)
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NOTE: It is recommended that the following SQL statement must be executed in Config Schema, if this

INDEX is not created:
CREATE INDEX index_mdr_mod_parent_child
CREATE INDEX index_mdr_mod_parent_child
ON mdb_object_dependencies (parent_object_def _id,child_object_def id)
COMPUTE STATISTICS
/

6.2

Create and Export Metadata Report Templates

Perform the following steps to create and export the Metadata Report Templates:

1.

Navigate to Object Administration - Utilities > Metadata Report.

ORACLE Financial Services Analytical Applications

Applications | Object Administration | Sysiem Configuralion & ldenity Management

Seluct Information Domain

FSOFINFO

Templata List (1) 78 Add

Tempiata I ¥ Tormplato Narma Tamale Desciphon Croatad Dato
2283 sance 04012017 oFsAD
<l >

Click Add icon, in Summary screen, to create a new Metadata Report Template.

Financial Services Analytical Infrastr re > Object Administration > Utilitles > Metadata Report
¥ Search and Filter [ Go 4 Clear 20, Refresh
Template \ \ Template | \
D Name
» Template List (§) [ Add
TemplaieID ¥ Templaie Name Template Description Crealed Dale Crealed By
[0 223483 sample 04-01-2017 OFSAD
< I >
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3. Provide the Name and Description for the new template in Template Definition page.

Template Definition

Back L Next
Definition Choose Object type

Definition
Basic Details

Name NDTest X

Description Tester

@ Save Return

4. Select the desired object from the Object Type dropdown to be exported.

Individual report generates only the basic properties of the object selected, that is, name and
description. Relational report generates detailed information up to the Entities level, if
Dependencies is chosen; and up to the Staging Columns level, if Data Lineage is selected along
with Dependencies.

Dependencies: Metadata object is dependent on several other metadata objects. Metadata
object is also used (that is, consumed) in several other metadata objects. Dependency or usage
tree can be of any depth. For example, a rule can be dependent on a hierarchy, business
processor, and dataset. Further, each of these metadata objects can be dependent on other
metadata objects. Metadata Export Utility exports all the dependent or used metadata objects for
all paths in the dependency or usage tree, if this option is selected.

Lineage: Data is loaded from source systems to staging and then moved across to processing /
reporting. Lineage traces the data element as it moves across different layers of OFSAA: staging,
processing, and reporting. Metadata Export Utility exports the lineage of each of the reporting
area data element that is identified by dependencies.
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For Individual: In the Export Options, do not select Dependencies or Data Lineage.

Financial Services Analytical Applications Infrastructure > Object Administration > Utiities > Metadata Report

Template Definition

< Back O L4 e Next >
Definition Choose Object ty Filter Objects
Choose Object type
Object Types
Choose  pashboard x
Export Options
Dependencies
Data Lineage
@ Save ¥ Return
The exported sample report for Individual is as follows:
A B c D E F
1 [CLASSIFICATION RULE DEF ICLASSIFICATION_RULE_NAME CLASSIFICATION RULE_DESC
2 1465916940587 RRDF - 14Q FRY 8C Line Re- Classification RRDF - 14Q FRY 4C Line Re- Classification
3
4
5
6
T
]
9
10
11 -
4 4 b | Classification Rule %] [ m 0.
For Relational: In the Export Options, select Dependencies.

Financial Services Analytical Applicat Infrastr re > Object Admini: > Utilities > Metadata Report

Template Definition

< Back ) L4 % Next >
Definition Choose Object ty... Filter Objects

Choose Object type

Object Types

Choose | pashboard X

Export Options

Dependencies (:)

Data Lineage

& Save ¥ Retun
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The exported sample report for Relational is as follows:

A B C D E F G H J K
1 [Path Name IDependency -
2 Path1 Dashboard » Report > View > Hierarchy > Entities =
3 Path2 Dashboard > Report > View = Derived Entity > Measure > Entities >
4 Path3 Dashboard = Report = View > Derived Entity = Hierarchy > Entities >
5 Path4 Dashboard = Report = View > Derived Entity = Dataset > Alias > Entities
6 Paths Dashboard = Report = View > Derived Entity = Dataset > Entities =
7 Pathé Dashboard » Report > View > Derived Entity = Business Processor = Measure » Entities >
8 Path? Dashboard > Report = View > Derived Entity > Business Processor > Dataset = Alias > Entities >
9 Pathg Dashboard » Report > View > Derived Entity = Business Processor = Dataset > Entities >
10 Pathg Dashboard > Report > View > Reporting Element > Measure > Entities = i
11 Path10 Dashboard » Report > View > Reporting Element = Hierarchy > Entities = 1
12 Path11 Dashboard = Report = View > Reporting Element > Derived Entity > Measure > Entities =
13 Path12 Dashboard > Report > View > Reporting Element > Derived Entity > Hierarchy > Entities >
14 Path13 Dashboard > Report > View > Reporting Element > Derived Entity > Dataset = Alias > Entities >
15 Path14 Dashboard » Report > View > Reporting Element > Derived Entity > Dataset » Entities »
16 Path15 Dashboard > Report > View > Reporting Element > Derived Entity > Business Processor > Measure > Entities >
17 |Path16 Dashboard = Report = View > Reporting Element > Derived Entity > Business Processor > Dataset = Alias = Entities =
18 Path17 Dashboard > Report > View > Reporting Element > Derived Entity > Business Processor > Dataset > Entities >
19 Path18 Dashboard > Report = View > Reporting Element > Business Processor > Measure > Entities =
20 Path19 Dashboard > Report > View > Reporting Element > Business Processor > Dataset > Alias > Entities > W
21 Path20 Dashboard = Report = View > Reporting Element > Business Processor > Dataset > Entities »
22 -
4 4+ | paths ~Pathl Path? ~Path3 , Path4 ~Path5 , Patht ~Path7 ,~Path8 . Path{ Ml m ] 0

The first sheet shows the different Paths and their Dependencies upto the Entities level. Select
the required Path sheet at the bottom to view the dependencies.

Each path tells how the dependency/usage is derived from dashboard to entity or vice versa
involving various OFSAA object types like Derived Entity, Hierarchies, Datasets, Measures, and
so on.

These paths are generated by the system using data already published in MDB dependency
tables as part of OFSAA MDB object publish.

For every dependent object type displayed in each path sheet, the following columns are
displayed:

¢+ Object type name

¢+ Object type description

¢+ One or many Object specific properties (optional)
For example: In Pathl, Dashboard is the first Object type, the dependencies generated are
Dashboard Name, Dashboard Description, and Dashboard properties: Dashboard Country,
Dashboard Regulator and so on. Similarly, Report is the next Object type in Pathl and the
dependencies generated are Report Name, Report Description, Views Name, Views Description,

View Display Format and so on. Then followed by Hierarchy Objects name, description and
properties up to the Entities level.
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The Usage sample report (generated by default when Dependencies is selected) is as follows:

A 3 C D E G, H
1 )_NAME )_DESC )_COUNTRY )_REGULATOR [REPORT, _NAMEJREPORT DfSC VIEWS_NAME VIEWS DESC VIEW DI SPU\V FORMAT HIERARCHY ! NMIE i
2 [FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [BS Schedule BS7Balance Sheet FRY-118S  FRY-118S  Tabular IFRS - Reported at fair Value Flag H
3 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Reserve [BSM Schedule BS-MMemoranda FRY-11.85-M FRY-11-85M Tabular Reg delinquency band Hierarchy
4 FRY-1 Financial Statements of U'S_USA Board of Govemors of the Federal Resenve [BS M Schedule BS-MoMemoranda FRY-11-8S-M FRY-11.85M Tabular Sale type code Hierarchy
5 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Reserve [BS [Schedule BS7Balance Shest FRY-118S  FRY-1185  Tabular IFRS - Fair Value RCY Hierarchy
6 FRY-11 Financial Statements of U S USA Board of Gavemors of the Federal Reseve [iS [Schodule [S7Income Stateme FRY-1145  FRY-1145  Tabular Consolidation Code
7 FRY-11 Financial Statements of U S. USA Board of Govemors of the Federal Resenve [iS-8 [Schedule IS-B7Changes in Al FRY-1145-8  FRY-1145-8  Tablar Reporting Line Code
8 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Resenve [BSM [Schedule BS-M7Memoranda FRY-11.BS-M FRY-1185M Tabular Bands hierarchy
3 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Resee [8S Schodule 8S7Balance Sheet FRY-118S  FRY-11.85  Tabular Osivative Type Code Hierarchy
10 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Reserve [BSM Schedule BS-MMemoranda FRY-11-8SM FRY-11-85M Tabular Standard Party Type Hierarchy
11 FRY-11 Financial Statements of U S USA Board of Gavemors of the Federal Reserve [BS Schedule BS7Balance Sheet FRY-118S  FRY-11-8S  Tabular Balance Sheet Category Hierarchy
12|FRY-11 Financial Statements of U S USA Board of Gavemors of the Federal Resenve [8S [Schedule 8S7Balance Sheot FRY-11.85  FRY-11.85  Tabular Trading Account Book Type Codo H
13 FRY-11 Financial Statements of U S. USA Board of Gavemors of the Federal Resenve [IS-A Schedule IS-A7Changes in EcFRY-111S-A  FRY-114S-A  Tabular Capital Instrument Transaction Typ
14 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Resene [BS Schedule BS?Balance Shest FRY-11.BS  FRY-11.85  Tabular Non Interest beanng deposit Heerar %
15 FRY-11 Financial Statements of U S USA Board of Gavemors of the Federal Resene [BS-4 Schedule BS MMemoranda FRY-1185M FRY-11-8SM Tabular Accrual Status Code Hierarchy
16 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Resene [BS Schedule BS7Balance Shest FRY-118S  FRY-118S  Tabular Reporting Line Code
17 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Reserve [1S-A Schedule IS-A7Changes in ECFRY-111S-A  FRY-114S-A  Tabular Instrument type Hierarchy
18 |FRY-11 Financial Statements of US. USA Board of Gavemors of the Federal Resene [BS-4 [Schedule BSMMemoranda FRY-11BSM FRY-11.8SM Tabular Regulatory Product Classification H
19 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Resenve [BS-A [Schedule BS-A7Loans and LeFRY-11-8S-A FRY-11-85-A Tabular Reg deiinquency band Hierarchy
20 FRY-11 Financial Statements of U S. USA Board of Govemors of the Federal Reserve [BSM [Schedule BS-M7Memoranda FRY-118SM FRY-11.8SM Tabular Baiance Sheet Category Hierarchy
21 FRY-11 Financial Statements of U S. USA Board of Govemors of the Federal [Schedule FRY-11.8SM FRY-11.8SM Tabular Coasolidation Code
2 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Reserve [BSM Schedule BS-M7Memoranda FRY-11-8S-M FRY-11-85M Tabular Holding Type Code Hierarchy
23 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Reserve [BS Schedule 8S7Balance Sheet FRY-1185  FRY-1185  Tabular Bands hierarchy
24 FRY-11 Financial Statements of U S USA Board of Govemors of the Federal Reserve [8S [Schedule 8S7Balance Sheet FRY-1188  FRY-11.85  Tabular Instrument type Hierarchy
25 [FRY-11 Financial Statements of U S USA Board of Gavemors of the Federal Reserve [BS Schedule BS?Balance Sheet FRY-11.8S  FRY-11-85  Tabular Buy or Sell Indicator Hiecarchy
26 FRY-11 Financial Statements of U S USA Board of Gavemors of the Federal Reserve [BS-A [Schedule BS-A7Loans and LeFRY-1185-A  FRY-118SA  Tabular Troubled Debt Restructure Flag Hie
27 FRY-11 Financial Statements of US_ USA Board of Gavemors of the Federal Resenve [BS [Schedule BS7Balance Sheet FRY-1188  FRY-11.8S  Tabular Other Real Estate Owned Flag Hier
28 FRY-11 Financial Statements of U S. USA Board of Govemors of the Federal [Schedule in AIFRY-114S:B  FRY-11458  Tabular Consolidation Code
25 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal Reserve [BSM [Schedule BS-M7Memoranda FRY-118S-M FRY-11-6SM  Tabular Reg Instrument Classifcation Hiera
30 FRY-11 Financial Statements of U'S. USA Board of Govemors of the Federal Reserve [BSM Schedule BS MMemoranda FRY-11-8S-M FRY-11-85M Tabular Instrument type Hierarchy
31 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Reserve [BS-M Schedule BS-M7Memoranda FRY-11-8S-M FRY-11-85M  Tabular Risk Factor typs code Hisrarchy
32 FRY-11 Financial Statements of U.S. USA Board of Gavemors of the Federal R [Schedule IS-A7Changes in ECFRY-11SA  FRY-114SA  Tabular Consolidation for Aggregation
3 |FRY-11 Financial Statements of U S. USA Board of Govemors of the Federal Reserve [BS-A [Schedule BS-A7Loans and LeFRY-11-8S-A  FRY-11.8S-A Tabular Negative Amoization Flag Hierarch
34 FRY-11 Financial Statements of U.S. USA Board of Govemors of the Federal Reserve [BSM Schedule BS-M7Memoranda FRY-11-8S-M FRY-11.85M Tabular Customer Country Hierarchy
3 FRY-11 Financial Statements of U S USA Board of Gavemors of the Federal Resene [BS-A Schedule 8S-A7Loans and LeFRY-118SA  FRY-11.85A Tabular Accrual Status Code Flag Hiecarchy
3 FRY-11 Financial Statements of U S USA Board of Govemors of the Federal Resenve [IS [Schedule IS7ncome Stateme FRY-114S  FRY-114S  Tabular Reparting Line Code
37 FRY-11 Financial Statements of U.S. USA Boardof Govenors of the FederalResenve BS54 [Schedule BS MMemoranda FRY-1TESM FRY-1185M  Tabular Reporting Line Cade
55 cov 4 Cimmamiol Chmtammamin ol € 110 Dt o O tho Endpsei Dinan ndede BEADL cov 4R o b5
TN Baths | patha” Bathd - Bathd . Gatha ' baths _ PathG _ bathy  Datng . Bath . bathil . bathil " paoniz _pathi3 Pathid . patniS ML m

| A | B & D E F G H
1 [Path Name lusage
2 Path1 Columns > Hierarchy > View > Report >Dashboard =
3 Path2 Columns > Measure > Derived Entity > View > Report »Dashboard >
4 Path3 Columns = Hierarchy > Derived Entity > View > Report >Dashboard =
5 Path4 Columns > Measure > Business Processor > Derived Entity > View > Report >=Dashboard >
6 Paths Columns > Measure > Reporting Element > View > Report >Dashboard =
T Path& Columns = Hierarchy > Reporting Element > View > Report >Dashboard =
§ Path? Columns > Measure > Derived Entity > Reporting Element > View > Report »Dashboard >
9 |Pathg Columns = Hierarchy > Derived Entity > Reporting Element > View > Report »Dashboard >
10 |Path9 Columns > Measure > Business Processor > Derived Entity > Reporting Element > View > Report =Dashboard >
11 |Path10 Columns = Measure > Business Processor > Reporting Element > View > Report =Dashboard »
12
13
14
15
W 4 b ¥ | paths ~Pathi Path? -~ Path3 -~ Path4 . Path5 , Path6 . Path7 .~ Path8 . Path{iJHllL m

The first sheet shows the different Paths and their Usage upto the Dashboard level. Select the

required Path sheet at the bottom to view the Usage.

Select Data Lineage in Template Definition - Choose Object Type to export the lineage

details up to the Staging Columns level.

A B C 0 E F G H I
1 JCOLUMNS_DESC COLUMNS_PHYSICAL_COL_ID  HIERARCHY_NAME HIERARCHY_DESC HIER_TYPE HIER_MULTI_DIM_PROPERTY HIER_TOTAL_REQD VIEWS_NAME
2 Transaction Account Flag Indicates if saxd account is conside FCT_DEPOSITS _E BORRDVVINGS F_Trans Account Flag Hierarchy  Hierarchy for Trans Account Flag BI GUL Yes FFIEC-031-RC-E
3 Ropurchased Ot indemnifed Flagindicates if the said account 1s Rep FCT_LOAN_ACCOUNT_SUMMARY. Repurchased of Indemiied Flag Repurchased of Indemaified Flag 81 REGULAR Yos FFIECO31-RCP
4 |Impairment Amount Under Asc 3 This column stores the impsiment FCT_LOAN_ACCOUNT_SUMMARY . Impair asc31030 Amount Check Impair asc31030 Amount Check 81 REGULAR Yes FRY-9CHCC
5 Troubled Debt Restructure Flag This column indicates if sad loan i FCT_LOAN_ACCOUNT_SUMMARY . Troubled Debt Restructure Fiag FTroubled Debt Restructure Flag ¢ B1 REGULAR Yes FFIEC-041-RC-O
6 Negative Amortization Flag  This column stores ifloan has nege F CT_LOAN_ACCOUNT_SUMMARY . Negate Amortization Flag Hiera Negative Amortization Flag Heera I REGULAR Yes FFIECO31-RCC
7 | Martgage Broker Surogate Key This stores unique identier for the FCT_LOAN_ACCOUNT_SUMMARY Broker Skey Hierarchy Broker Skey Hierarchy 8 REGULAR Yes FFIEC031-RC-P
8_ Cleared Transaction Flag This columns stores f particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc 81 REGULAR Yes FFIECO31-RCR Part I
3 Cleared Transaction Flag This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc 81 REGULAR Yes FRY-150
10/ Mark To Market Value In Reports This stares the mark to market valuFCT_REG_ACCOUNT_SUMMARY NMtm ValueFRAS Herarchy _Hierarchy Mim Value FRAS 81 REGULAR Yes FRY-158
11 Broker Sumogate key This stores unique identier for the FCT_DEPOSITS_BORROWINGS N_Broker Hierarchy Deposit Borows Broker Hierarchy Degosit Borow 81 REGULAR Yes FFEC31-RCE
12  Callable Deposit Indicator Indicates if said deposit can be call FCT_DEPOSITS_BORROWINGS F_ Deposit Option Indicatar Hierarct Deposit Option Indicator Hierarct 81 REGULAR Yes FFIECO31-RCE
13 Impairment Amount Under Asc 3This column stores the impament FCT_LOAN_ACCOUNT_SUMMARY Impax asc31030 Amount Check Impair asc31030 Amount Check BI REGULAR Yes FFIECO31-RCC
14 Troubled Debt Restructure Flag This column indicates if said loan isFCT_LOAN_ACCOUNT_SUMMARY . Troubled Debt Restructure Flag f Troubled Debt Restructure Flag t 81 REGULAR Yos FRY-9CHCN
15 Troubled Debt Restructure Flag This colum indicates if said loan isFCT_LOAN_ACCOUNT_SUMMARY Troubled Debt Restructure Flag } Troubled Debt Restructure Flag ¢ 81 REGULAR Yes FFIECO41-RC-C
16 Troubled Debt Restructure Flag This column indicates if said loan isFCT_LOAN_ACCOUNT_SUMMARY. Troubled Debt Restructure Flag  Troubled Debt Restructure Flag } 81 REGULAR Yes FFIEC31-RC-O
17 Negative Amortization Flag  This column stores if loan has negz FCT_LOAN_ACCOUNT_SUMMARY . Negatie Amortization Flag Hiera Negative Amortization Flag HheraBl REGULAR Yes FFIEC-O41-RC-C
18 |Cleared Transaction Flag This columns stores if particular tra FCT_REG_ACCOUNT_SUMMARY F Cleared Transaction Flag Hierarc Cleared Transaction Flag Hierarc 81 REGULAR Yes FFIECO41-RC-R Pant I
19 Mark To Market Value In Reporti This stores the mark to market quFCT REG ACCO(NT SUMMARY \Mtm Value-FRAS Hierarchy Hierarchy Mtm Value-FRAS Bl REGULAR Yes FRY-15F
20 Broker Surrogate key This stores unique identser for the |FCT_DEPOSITS_BORROWINGS.N_Broker Hierarchy Deposit Borowi Broker Hierarchy Deposit Borow BI REGULAR Yos FFIEC-041-RCE
21 Troublod Dbt Restrctur Flag This courmn inchcaes f 32 lan ECT_LOAN ACCOUNT_SUMMARY. Troubed Dotk Restnucture Fag Troublod Dotk Restrucure Fiag 181 REGULAR Yos FRY-9CHCC
22 Martgage Broker Surrogate Key This stores unique identiier for the FCT_LOAN_ACCOUNT_SUMMARY  Broker Skey Hierarchy Broker Skey Hierarchy 8l REGULAR Yes FFECO41-RCP
23 Mortgage Broker Surragate Key This stores unique identier for the FCT_LOAN_ACCOUNT_SUMMARY . Broker Skey Hierarchy Broker Skey Hierarchy Bu REGULAR Yes FRY-9CHCP
24 Claim Local Currency Code  Refers to the Local currency code f FCT_REG_ACCOUNT_SUMMARY v Currency Code Comparison Hier: Currency Code Comparison Hi REGULAR Yes FFIEC-009.C. Part Il
25 Cross Border Claim indicator _ Indicates if sad claim is cross brodFCT_REG_ACCOUNT_SUMMARY F Cross Border Claim Hierarchy  Cross Border Claim Hierarchy s: REGULAR Yes FFIEC-009.C. Part I
26 Transaction Account Fl Indicates i said account is conside FCT_DEPOSITS_BORROWINGS F_Trans Account Flag Hierarchy  Hierarchy for Trans Account Flag 81 REGULAR Yes FRY-9CHCE
27 Deposit Call Exercised indicator This Column Storss the Deposit CaFCT_DEPOSITS_BORROWINGS F_Next Option Flag Deposit Bomow Next Option Flag Depost Borrow BI REGULAR Yes FFIECO31-RCE
28  Troubled Debt Restructure Flag This column indicates if sad loan it FCT_LOAN_ACCOUNT_SUMMARY  Troubled Debt Restructure Flag t Troubled Debt Restructure Flag 61 REGULAR Yeos FRYTN.BS-A
29 Troubled Dett Restructure Flag This column indicates if sad loan sFCT_LOAN_ACCOUNT_SUMMARY  Troubled Debt Restructure Flag F Troubled Debt Restructure Flag ¢ 81 REGULAR Yes FR2314-8S-A
30 Negative Amortization Flag  This colum stores if loan has negsFCT_LOAN_ACCOUNT_SUMMARY. Negate Amortization Flag Hiera Negative Amortization Flag Hhera I REGULAR Yes FRY-1185-A
31 Recourse to General Credit  This stares the recourse to general FCT_REG_ACCOUNT_SUMMARY F Recourse To General Credt Indic Recourse To General Credit indic 81 REGULAR Yes FFIECO41-RCV
32 | Contractual Maturity in Days  This column stores the orignal mati FCT_REG_ACCOUNT_SUMMARY N Contractual Maturity Term Hierar Contractual Maturity Term Hieras 1 REGULAR Yes FFIEC-041-RC-R Pan I
i Nounie ol Sumge ay T coime soves the rwvance FCT REQ ACCOUNT SUMMAVY Nt Poc Simogts ey Ha sl Pl Su.ﬂogle Key Hie Bl REGULAR Yes FRY-9CHCM
34 Broker Sumogate key This stores unique identier for the FCT_DEPOSITS & |_Br archy Deposit Hierarchy Deposit Borow Bl REGULAR Yes FRY-9CHCE
35 Broker Surogate key This stares unique dener for the FCT_DEPOSITS_BORROWINGS N_Broker Herarchy Dapost Borom Broker Hierarchy Dapost BorowiB1 REGULAR Yes FFIECO31-RCO
3 | Deposit Call Exercised indicator This Column Stores the Deposit CaFCT_DEPOSITS_BORROWINGS F_Next Option Flag Deposit Bomow Next Option Flag Deposit Borrom I REGULAR Yes FFECO41-RCE
37 Deposit Listing Senice Provider : This Column Stores the unique ider FCT_DEPOSITS_BORROWINGS N_Deposit List Skey Hierarchy Deposit List Skey Hierarchy -] REGULAR Yes FFIEC-041-RC-E
:“‘n 5 Ft'; lPalhl ath2. n«"mz Path4 ‘;;t;;- A;Kh‘é "P);u” nl’t‘;i’“ I.gl(;é‘ Di;ﬁnn-—wj 4 i i
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NOTE: Data Lineage can be selected only if Dependencies is opted.

Financial Services Analytical Applications Infrastructure > Object Administration > Utilities > Metadata Report

Template Definition
< Back O [ ] O
Definition Choose Objectty... Filter Objects
Choose Object type
Object Types
Choose

Dashboard %

Export Options

Dependencies O
Data Lineage D

¥ Return

& Save

Next >

NOTE:

Data Lineage is generated as a separate sheet in the generated Relational report along with the

Dependencies. Select the Lineage sheet to view the Data Lineage (up to Staging column level).

Home | Inset  Pagelayout  Formulas  Data  Review  View

cut " = = 2 e || = Fe PEMh X Autosum v

iCany Arial -10 - A ATl | || &~ | | Sewrap Text General «_’5 «_ﬁjﬁ i JI‘ f 4;_‘ @ Finl - W \;a
= pomat panter || B1Z [ A | EdMergemvcenter 7| |8 7 8 o || )| SR e s | et O T Gders A teen

Clipboard [ Font i) Alignment ) MNumber £ Styles Cells Editing
AL - Je | SCHEDULE ¥
B c D E F G ¥

1 [SCHEDULE Tview CELL ID DERIVED ENTITY CODE METADATA CODE RESULT AREA TABLE RESULT AREA COLUMN
2 [HCE FRY-9C-HC-E BHOD6648 DERHCEQ3 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
3 HCE FRY-9C-HC-E BHCB6648 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
4 [HCE FRY-9C-HCE BHODG648 DERHCEQ3 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK,
5 HCE FRY-9C-HC-E BHOD2389 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
6 HCE FRY-9C-HCE BHOD2604 DERHCEQ3 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK,
7 HCE FRY-9C-HC-E BHOD2389 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
8 HCE FRY-9C-HCE BHODG648 DERHCEQ3 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
9 HCE FRY-9C-HC-E BHCB2389 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
10 HCE FRY-9C-HCE BHCB2210 DERHCEQ3 DSRHCEQ3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
11 HC-E FRY-9C-HC-E BHDMA164 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
12 HCE FRY-9C-HC-E BHCB2389 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
13 HC-E FRY-9C-HC-E BHOD2389 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
14 HCE FRY-9C-HC-E BHFNA245 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
15 HC-E FRY-9C-HC-E BHCB6648 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
16 HC-E FRY-9C-HC-E BHDMA242 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
17 HC-E FRY-9C-HC-E BHFNA245 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
18 HC-E FRY-9C-HC-E BHOD2604 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
19 HC-E FRY-9C-HC-E BHDMA242 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
20 HCE FRY-9C-HC-E BHFNA245 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
21 HCE FRY-9C-HC-E BHCB6648 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
22 HCE FRY-9C-HC-E BHFNA245 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
23 HCE FRY-9C-HC-E BHDMA242 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG_DEPOSIT TYPE_SK
24 HCE FRY-9C-HC-E BHCB2210 DERHCEQ3 DSRHCE(3 FCT_LEGAL_ENTITY_DETAILS N_ENTITY_TYPE_SKEY
25 HCE FRY-9C-HC-E BHCB6648 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
26 HCE FRY-9C-HC-E BHFNA245 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
27 HCE FRY-9C-HC-E BHOD2389 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
28 HCE FRY-9C-HC-E BHOD2389 DERHCEQ3 DSRHCE(3 FCT_REG_ACCOUNT_SUMMAFN_REG_DEPOSIT_TYPE_SK
29 HCE FRY-9C-HC-E BHODG648 DERHCE03 DSRHCE(3 FCT_REG_ACCOUNT SUMMAFN_REG DEPOSIT TYPE_SK
30 HCF FRY-AC-HC-F HHCH?TKﬁ DFRHCFOZ NSRHGEN: FCT RFG ACCOUNT SUMMAEN RFG DFPOSIT TYPE SK
4 < »"wi] Paths Pathi  Path , Path3 , Pathd , Paths Pathé , Path]| Lineage § 73 m
Ready f— [EEEET e s— )
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5. Select Filter Objects to see the selected objects.

Financial Services Analytical l > Object i > Utilities » Metadata Report

Template Definition

< Back O O L Next >
Definition Choose Object type Filter Objects Review
Filter Objects
Dashboard

@ Save 7 Retun

6. Select one Filter Object from the Available Objects and Click ’ to add a Selected Object.

. . . . < .
Select one Selected Object from the Available Objects and click to remove a Filter
Object.

Dashboard

Available Objects Selected Objects

EFR-2314
EFR2314s
bR 20524
i FR 2052b
B FRY-14Q
EFRY-14A
B FFIEC-031
i FR-28868
[ FFIEC-041
EFRY7N
BFRY-9LP
EFFIEC101

EFRY-9C

Search.

When the object list is huge, use the Search option as shown above. Type first three letters of the
Filter Object name and the relevant Filter Objects is displayed.

NOTE: You can type the complete Filter Object name to select and add to the Selected Objects.
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Dashboard

Available Objects Selected Objects

EFRY7N EFRY-9C
EFRY-OLP

EFRY-14M <

EFRY-15

EFRY-20

EFRY-12

BFRY-11

EFRY-11s

EFRY-14Q

EFRY-14A

FRY| X o OK

7. Review the Template Definition once and click Save.

- ~
Template Definition
< Back Q O Q L] Next »
Definition Choose Object ty. Filter Objects Review
Review
Object Identifier Object Name Object Type
0 1482689198163 FRY-9C Dashboard
< >
Page 1 of1(10f1items)
@ Save | ¥ Retum v
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8. Click Return to go to the Summary page.

Financial Services Analytical Applications Infrastructure > Object Administration > Ultilites > Metadata Report
+ Search and Filter > Go 4 Clear 20, Refresh

Template Template
D Name

v Template List (2) [8 Add @ Delete [ View ,Em'- Download

Template ID . Template Name Template Description

Created Date

Created By

223484 NDTest Tester 05-01-2017 OFSAD
[ 223483 sample 04-01-2017 OFSAD
< I >

9. Select a Template in the Template List in Summary screen and click Generate to export the

desired objects in Excel Sheet format.

NOTE: MDB Publish must be triggered before executing the Generate option.

10. The Report Generation function is an asynchronous action and to check the status of the export

function, use the Refresh option in Summary screen.

Finangial Services Analytical Applicat . i > Object Administration > Utilities > Metadata Report

¢ Search and Filter C> Go Jcleal’r' Refresh I

Template ID Template Name

v Template List (2) [& Add

ate Name Template Description Created Date
Tester 05-01-2017 QOFSAD
04-01-2017 OFSAD

Created By

Not Started
Not Staried

Status

< I

For Excel Export, the following are the Status values:

¢ Not Started: The Report Generation is yet to start, but the function has triggered the

action in the background.

¢ Ongoing: The Report Generation is started and in process.
¢ Completed: The Report Generation is completed and ready to view or download.
¢+ Failed/Partially Completed: The Report Generation encountered an issue and the

process is partially completed or failed.

NOTE: The export logs are generated and placed in the path /Context Name/logs/MDB.log.

Log files give the following information:
a) All Paths query
b) Query for each path and if data present for this path
c) Lineage query
d) Status of excel output creation
e) Exceptions and errors, if any
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11. Select a Template in the Template List in Summary screen and click Download to save a copy
of the generated Metadata Report Templates excel sheet, after the export status shows as

Financial Services Analytical Applications Infrastructure > Object Administration > Utilities > Metadata Report
* Search and Filter C Go ) Clear 2., Refresh
Template Template
ID Name
¢ Template List (2) [@ Add @ Delete [ view £ Eait [X] Generatd
TemplaieID ¥ Tempiaie Name Template Descriplion Created Date Created By
223434 NDTest Tester 05-01-2017 OFSAD
[ 223483 sample 04-01-2017 OFSAD
< I >

User Access

The following user groups are pre-seeded in the component that helps user to get access to the
Metadata Report Extract screen.

a. MDR View Group: Helps users to see Metadata Report Extract with View permissions.
b. MDR Owner Group: Helps users to create templates in Metadata Report Extract.

6.3 View Metadata Report Templates

Perform the following steps to view the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click View icon to view the generated Metadata Report Templates excel report (after the export
status shows as completed).

Financial Services Analytical Applications Infrastructure > Object Administration > Utilities > Metadata Report
* Search and Filter C Go ) Clear 2., Refresh
Template Template
ID Name
¢ Template List (2) [8 Add @ Delel 2 Edit [X] Generate 22, Download
TemplaieID ¥ Tempiaie Name Template Descriplion Created Date Created By
223434 NDTest Tester 05-01-2017 OFSAD
[ 223483 sample 04-01-2017 OFSAD
< I >

NOTE: The Metadata Report Templates excel report is opened in view-only mode.

6.4 Modify/Edit Metadata Report Templates

Perform the following steps to edit or modify the Metadata Report Templates:
1. Select a Template in the Template List in Summary screen.

2. Click Edit icon to modify the generated Metadata Report Templates excel report (after the export
status shows as completed).

Financial Services Analytical Applications Infr cture > Object Administration > Utilities > Metadata Report
v Search and Filter T Go < Clear . Refresh
Template Template
D Name
= Template List (2).[@ Add @ Delete B Vie Generate 3, Download
Template D ¥ Template Name Template Description Created Date Created By
223484 NDTest Tester 05-01-2017 OFSAD
[ 223483 sample 04-01-2017 OFSAD
< I >
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6.5

Perform the following steps to delete the Metadata Report Templates:

Delete Metadata Report Templates

1. Select a Template in the Template List in Summary screen.

2. Click Delete icon to delete the Metadata Report Templates.

Financial Services Ar

tical Applications
v Search and Filter T Go < Clear

Template Template
D Name

v Template List (2).[@ Add| @ Delete | view £ Edit [2] Generate 0, Download

resh

ucture > Object Administration > Utilities > Metadata Report

Template D ¥ Template Name Template Description Created Date Created By
223484 NDTest Tester 05.01-2017 OFSAD
[0 223483 sample 04-01-2017 OFSAD

< I >
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7 Report Submission

This chapter provides an understanding of the report submission process. It includes:
¢ Report Submission: AgileREPORTER to Requlator
¢ Edit Checks/ Validity Check/ Quality Checks
¢ Report Templates to be used in AgileREPORTER

7.1 Report Submission: AgileREPORTER to Regulator

After OFSAA has prepared and hands off the data as required to Lombard Risk, the subsequent activities
are performed within the AgileREPORTER.

Lombard takes care of the report format as per the regulatory requirement which may be eXtensible
Business Reporting Language (XBRL)/ XML/ Excel / .Data/ XML and so on.

7.2 Edit Checks/ Validity Check/ Quality Checks

The AgileREPORTER carries out the report level / submission check comprising Edit Chceks / Validity
Checks / Quality Checks as provided by the regulator.

Note: Refer to the AgileREPORTER user documentation provided by Lombard Risk, for details of
activities within the AgileREPORTER.

7.3 Report Templates to be used in AgileREPORTER

The report templates to be used in AgileREPORTER are listed as follows:

Report Name Report Template
FDIC-8020 FDIC8020_V1
FFIEC-009 FFIEC009 Vi1
FFIEC-009A FFIECO09A_V1
FFIEC-031 FFIEC031_V9
FFIEC-041 FFIEC041_V9
FFIEC-101 FFIEC101_V2
FR-2052A FR2052A V4
FR-2314 FR2314_V2
FR-2314S FR2314S_V2
FR-2644 FR2644 V2
FR-288SB FR2886B_V1
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Report Name

Report Template

FR-2900 FR2900_V3
FRY-11 FRY11 V2
FRY-11S FRY11S_V2

FR Y-12 FRY12_V2

FR Y-14A OR FRY14A0OR_V2
FR Y-14A RCI FRY14ARCI_V1
FR Y-14A RCT FRY14ARCT_V2

FR Y-14A SCENR

FRY14ASCENR_V1

FR Y-14A SUMM

FRY14ASUMM_V3

FR Y-14M FRY14M_V1

FR Y-14MA1 FRY14MA1 V2
FR Y-14MA2 FRY14MA2_V2
FR Y-14MB1 FRY14MB1 V2
FR Y-14MB2 FRY14MB2_V2
FR Y-14MC1 FRY14MC1_V2
FR Y-14MD1 FRY14MD1_V2
FR Y-14MD2 FRY14MD2_V2
FR Y-14QA1 FRY14QA1 V3

FR Y-14QA AUTO

FRY14QAAUTO V2

FR Y-14QA INTAUTO

FRY14QAINTAUTO_V2

FR Y-14QA INTCARD

FRY14QAINTCARD_V2

FR Y-14QA INTFM

FRY14QAINTFM_V2

FR Y-14QA INTHE

FRY14QAINTHE_V2

FR Y-14QA INTL OTHCONS

FRY14QAINTLOTHCONS_V2

FR Y-14QA INTSB

FRY14QAINTSB_V2

FR Y-14QA STUDENT

FRY14QASTUDENT_V2

FR Y-14QA US OTHCONS

FRY14QAUSOTHCONS_V2

FR Y-14QA USSB

FRY14QAUSSB_V2
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Report Name

Report Template

FR Y-14Q BAL FRY14QBAL_V2
FR Y-14Q CIL FRY14QCIL_V1
FR Y-14Q CRE FRY14QCRE_V1

FR Y-14Q FVO/HFS

FRY14QFVOHFS_V2

FR Y-14Q MSR

FRY14QMSR_V1

FR Y-14Q OPSRISKBL

FRY14QOpsriskBL_V1

FR Y-14Q OPSRISKMS

FRY14QOpsriskMS_V1

FR Y-14Q OPSRISKRFR

FRY14QOpsriskRFR_V1

FR Y-14Q OPSRISKTH

FRY14QOpsriskTH_V1

FR Y-14Q OPSRISKUOM

FRY14QOpsriskUOM_V1

FR Y-14Q PPNR

FRY14QPPNR_V2

FR Y-14Q RCI

FRY14QRCI_V2

FR Y-14Q RCT

FRY14QRCT_V3

FR Y-14Q RETAIL AUTO

FRY14QRetailAuto_V1

FR Y-14Q RETAIL INTAUTO

FRY14QRetailintauto_V1

FR Y-14Q RETAIL INTCARD

FRY14QRetaillntcard_V1

FR Y-14Q RETAIL INTFM

FRY14QRetailintrm_V1

FR Y-14Q RETAIL INTHE

FRY14QRetailINTHE_V1

FR Y-14Q RETAIL INTL OTHCONS

FRY14QRetailintlothcons_V1

FR Y-14Q RETAIL INTSB

FRY14QRetailintsb_V1

FR Y-14Q RETAIL STUDENT

FRY14QRetailStudent_V1

FR Y-14Q RETAIL US OTHCONS

FRY14QRetailUSothcons_V1

FR Y-14Q RETAIL USSB

FRY14QRetailUssb_V1

FR Y-14Q SEC

FRY14QSEC_V5

FR Y-14Q SUPMNT

FRY14QSUPMNT_V2

FR Y-14Q TRADING

FRY14QTRADING_V3

FR Y-15

FRY15 V4

FR Y-20

FRY20_V2

Oracle Financial Services Software

132



OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
User Guide, Release 8.0.4.1.0

Report Name Report Template
FR Y-7N FRY7N_V1

FR Y-7NS FRY7NS_V1

FR Y-9C FRY9C_V6

FR Y-9LP FRYOLP_V1

7.4 Supported Report Template Version and Activation Date

The AgileREPORTER contains the details of the Report template version and the activation date of the
same. This can be accessed by selecting the Entity setup option in the Settings Menu which enables the
user to Add, Modify, and Delete Entitites. Click on a created Entity to access report templates according
to version and the activation date, and assign the necessary privilages as required.

Lombard Risk | Dashboard 2 XBRLChecker = hipadmn | & @

Entity and Return Administration

Entity Setup . Add new entity ©

Figure 38: AgileREPORTER Entity Setup
Refer to the OFS AgileReporter Application User Guide for more details.
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8 Maintenance

This chapter provides an understanding of the maintainence process for the regulatory templates.

Changes to regulatory template is one of the most common and continuous activity. The following steps
help to assess the impact (You can replace the measure, dimension for existing dataware housing
configuration pack using the below process):

1. Choosing different execution as a final. After report verification, if requirement is to change the
execution, then you must visit Marking Run as Final section. After making these changes you
must refresh Derived Entities (Executing Batch to Resave Derived Entities). Then
AgileREPORTER also needs to retrieve returns so that revised data is reflected on
AgileREPORTER.

2. If Executing Batch to Resave Derived Entities is not working, you can look for Batch Operation
Log files. For file path, refer to OFS Analytical Applications Infrstructure Installation Manual in
OHC documentation library and search for ficdb/log.

3. To apply revised patch, refer to the ReadMe file for instructions to be followed.
4. To update revised data warehouse configuration pack, perform the following instructions.

i. Click Settings = Administration = Data Warehouse Integration.

Lombard Risk | Dashboard Job Manager XBRL Checker = himadmin | 3 @

Show Deleted Retuns Delete Retum Log &) create New E§ mportadjustments ~ ExportTo Regulator Format | USe's
Privilege Groups
Regulator WORKFLOW STATUS
ENTITY RETURNS ¢  VERSION ¢ REFERENGEDATE ¢  JOBSTATUS UPDATE  APPROVAL EDITIONS  TRANSMISSI User Groups
US FED Reserve N LUEAE

us EFIEC031 4 301002013 Q0 €y Undate  NO ATTESTATION NEEDED

[ 1]

s S us EFIEC041 4 30002013 Q0 €y Undale  NO ATTESTATION NEEDED

-

us ERYOC 2 3010072013 Q0 (p Undate  NO ATTESTATION NEEDED

[[]

1 15 v

Figure 39: Data Warehouse Integration
ii. Click Add to add a contextual button.
iii. Enter details of the contextual button.
Name: It is the text that needs to be displayed in the contextual button.

URL Pattern: Replace <<OFSAA HOST>>, <<OFSAA PORT>> and
<<OFSAA_ CONTEXT>> with host, port and web context of the environment where OFSAA
is installed. Replace <<OFSAA HOST>> with the name of information domain.

http://[<<OFSAA HOST>>:<<OFSAA PORT>>/<<OFSAA CONTEXT>>/OFSAADrilldow
n/drilldownreport.jsp?cellid=${cellld}&infodom=<<INFODOM>>&legalentity=${entityCode}
&run=%${runi&date=${referenceDate}
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Example:
http://127.0.0.1:8080/ofsaa/OFSAADrilldown/drilldown.jsp?cellid=${cellld}&infodom=0FS
FSDFINFO&legalentity=${entityCode}&run=${run}&date=${referenceDate}

i. Use http or https depending on the protocol configured for OFSAA.
ii. Pickanicon.

iv. Click Add to save the details.

Lombard Risk | Dashboard XBRLChecker - hipadmin | % @

Data Warehouse Integration
OFSAA Contextual Buttons.
| oEscreTON IcoN

e Data Lineage &
-

Builtin Variable:

= s{entityName} = sgormCode}

= sfregulatoryPrefix) = s{tableCode}

Figure 40: Adding Contextual Button

5. After the data ware configuration pack is updated, Lombard Configuration pack must reflect this.

Note: Refer to AgileREPORTER user documentation for details.

8.1 Data Schedules Views Creation

Source view required for generation of certain data schedule based returns like FR2052A and FR Y-14M
must be created manually after all the dependent derived entities are saved successfully through batch
framework. The views are ported as metadata in a future release after the dependent enhancements to
BMM framework is confirmed. For now, the views must be executed manually by the DBA in the atomic
schema.

8.1.1 FR 2052A

The command <<Infodom>> USFED_FRY2052A RESAVEDE must be executed to save all the derived
entities required by FR 2052A. Post successful execution, the following views must be executed manually
in the atomic schema. The scripts can be found within the Post_Scripts folder in the 8.0.4.0.0 installer
kit.

¢ FR2052A_ASSET_INFLOW.sql

¢ FR2052A _DEPOSITS_OUTFLOW.sql
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FR2052A_FX_SUPPLEMENTAL.sq
FR2052A_INFO_SUPPLEMENTAL.sql
FR2052A_OTHER_INFLOW.sq|
FR2052A_OTHER_OUTFLOW.sq|
FR2052A_SECURED_INFLOW.sq|
FR2052A_UNSECURED_INFLOW.sq
FR2052A_WHOLESALE_OUTFLOW.sql

* & & & o oo o

8.1.2 FRY-14M

The command <<Infodom>>_USFED_FRY14M_RESAVEDE must be executed to save all the derived
entities required by FR Y-14M. Post successful execution, the following views must be executed manually
in the atomic schema. The scripts can be found within the Post_Scripts folder in the 8.0.4.0.0 installer
kit.

FRY14M_Al1 LOAN_LEVEL_DD_V.sql

FRY14M_A2 PORTFOLIO_LEVEL_DD_ V.sql

FRY14M_B1 HOME_EQUITY_V.sql

FRY14M_B2 HOME_EQUITY_V.sql

FRY14M_C1 LOAN_LEVEL DD V.sql

FRY14M_D1 LOAN_LEVEL_V.sql

FRY14M_D2 PORTFOLIO _LEVEL V.sql

* & & & o oo o
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9 Validation / Edit Checks for Data Schedules

This chapter explains the validation / edit checks for various data schedules supported within the
Regulatory Reporting application.

9.1 Overview of Edit Check Process

As per regulatory references, edit checks are used during regulatory report submission to verify and
improve overall data quality, and communicate key structural features of the collection. "DATA
COLLECTED" for Regulator is "DATA SUBMITTED" for a reporting entity.

For template reports, edit checks are exclusively handled in Lombard Risk AgileREPORTER and are not
covered in the OFSAA application.

9.2 Configuration Steps

Perform the following configurations to validate / edit check for the data schedules before the Edit Check
execution:

A. Source Model Generation

1. Log in to OFSAA application GUI.

lapplications = Object Administration =~ System Configuration & Identity Management
Select Applications Financial Services Data Foundation > Data Management Framewark
Financial Services Data Foundation v

S 4|5Fy Data Management Framework
4 1 Financial Services Data Foundation

Manage Data movement using framework for Dala Management
g E‘ Data Model Management

4 [ pata Management Framework » % Data Management Tools |25 Data Quality Framework
4 ‘@ Data Management Tools Tools for Data Management Manage Data Quality using framewrork for Data Quality

5
3 Data Sources
» E Data Entry Forms and Queries

Tools to create simple forms based Dala Entry

3 pata Mapping
& pata File Mapping
(B Post Load Changes
» 2 Data Quality Framework
» ® Data Entry Forms and Queries
» [E unified Analytical Metadata
» B rule Run Framework
» & Run Management
» [ operations
b B setiings
) Metadata Browser

2. Navigate to Financial Services Data Foundation - Data Management Framework - Data
Management Tools - Data Sources. A new window is displayed as follows.
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[t Data Management Tools ~
-] Applications Source Designer

Data Sources Sourca Designer

&2 .
:‘j”“ Saurees »Define Applications A&
# B3 AAICONFIG_APF
" Application Name *
= B3 DIM_MGMT_AFF
=
= reoe Description
STAGING
= & usreo
PROCESSING ER
| Source type O File @ Table O webleg
| Based On ® roBMS O Hors
name * [10184.148.130 I~ Database nsme* [parfsafatm-ORACLE ]

*Map
Application USFED v
Available Sources Source Applications
Available Sources =¥ mapped Sources
AAI_GONFIG_SRC PROCESSING
FSDFINFO
[7] STAGING B

L]

i

3. Navigate to Mapped Sources > USFED - PROCESSING.

4. Select PROCESSING in Source Applications and click Source Model Generation icon. A new
window is displayed as follows.

Generate Source Model

Source Model

»Generate Source Model r;

R

5. Click Catalogs icon and then click Generate.

B. SETUP_MASTER Table

The SETUP_MASTER table must be updated with the top-most parent entity for the Bank that is used
for consolidation with the following SQL statement:

UPDATE SETUP MASTER
SET V_COMPONENT VALUE = <Top Most Parent Entity Code>
WHERE V_COMPONENT CODE = '2052A CONS ENTITY CODE';

9.3 Execution Steps

Perform the following batch run to complete the Edit Check execution:
FSDFINFO_USFED_EDIT_CHECK_FR_ZO52A batch.
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9.4 How to Execute the Batches?

Perform the following steps to complete the Edit Check Batch execution:

1. Log in to OFSAA application GUI.

2. Navigate to Financial Services Data Foundation - Operations - Batch Execution.

Execution window is displayed as follows.

The Batch

A i Object

System

Select Applications

Financial Services Data Foundation

4 [ Financial Services Data Foundation
» [ Data Model Management

Data Management Framework

[E] unified Analytical Metadata

8 Rule Run Framework

28 Run Management

I operations
B Batch Maintenance

Ay Y oW ow

[ Bateh Execution
[ Batch Scheduler
T atch Monitor

® Batch Cancellation
& view Log

& processing Report

[ settings
i metadata Browser

& Identity

Financial Services Data Foundation > Operations > Batch Exscution

Batch Execution

» Batoh Made

Mode (@ Run () Restart () Rerun
» Search
Bstch I Like IFSDF\NFCL USFED_EDIT_CHECK_FR_20524

IBstch Description Like

Module | v

» Bateh Details
|Batehin &
[] FSDFINFO_USFED_EDIT_CHECK_FR_20524

» Task Details

Task ID Task Description | Metadsta Value

» Information Date

Date =

Last Modification Data Between

| Bstch Desciiption

= and

1-141

This bateh will execute DQ and DT checks sssociated with FR-2052A edit checks.

| component 1o Precedence

Mo data found

Execute Balch

Task Status ‘

3. Enter the edit check name in Batch ID Like and click Search. The Batch ID is displayed in the

Batch Details pane.

ion & Identity

Object System C

Select Applications
Financial Services Dala Foundation
4 L:l:‘ Financial Services Data Foundafion
» [ pata Model Management
» [ Data Management Framewiork
» [El unified Analytical Metadata
+ [ rule Run Framework
» B8 Run Management
4 @ operations
E Batch Maintenance
@ Batch Execution
[ Batch Scheduler
T@ Batch Monitor
® Batch canceliation
& view Log
[l Processing Report
Seftings

i) metadata Browser

BatchID &
. FSDFINFO_USFED_EDIT_CHECK_FR_2052A

Financial Services Date Foundation > Operafions > Balch Execution

Batoh Execution

» Batch Mode

Mode @ Run () Restart () Rerun
» Search
Batch ID Like FSDFINFO_| USFED_EDIT_CHECK_FR_2052A

Batch Description Like

Madule ~

Last Modification Date Between

» Batch Details

i

| Bateh Description

@& Calendar - Inter..  — e
 fask Dete [ o] Y - Jeveaca] - 8 Oy
TaskID 4 Task Descriplion | Metedsts Vaiuel IR T Precedence
Task1 null USFED_EDIT 1 [ 2| =2
Task2 null FN_POP_2052, a 3 s z E3 2 10 | ja
Taska null FN_PoP 20s2f | A1 | 12 | 13 | 14 | 15 | 16 | 17 | fs
Tasks null FN_POP z0sz) | A8 | 19 | 20 | 21 | 22 | 23 | 24 |,

25 | 26 | 27 | 28 | 20 | 30 E

Tasks null FN_POP_2052 —— A
Task null FN_EDCHK_E) Tl A

» Information Date

T
Date s

< Execute Baich >

= an

1-101

il exacute DQ and DT checks sssocisted with FR-2052A edit checks.

1-8i8

Tesk Status
N

z z|z|z|z

4. Select the Batch ID, click the Date icon to choose the batch execution run date and click Execute

Batch.
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9.5 Logs and Status

For Batch log, navigate to Financial Services Data Foundation - Operations - Batch Monitor to
check the status of the batch.

The Edit Check log is classified into two types:
1. Summary Table

The FSI_EDIT_CHECK_SUMMARY table stores the summary of the edit check executions for all
the OFSAA implementations of edit checks. The summary table attributes and description is as

follows.

Attribute Name Attribute Description

V_BATCH_ID This is the ID provided by the batch execution.

N_EDIT_CHECK_SKEY This is the surrogate key (SKey) of the edit check from the
FSI_EDIT_CHECK_MASTER table.

V_DQ_CHECK_ID This is the ID from the DQ_CHECK_MASTER table populated for
the Data Quality Check based edit checks.

RUN_STATUS The following are the values for RUN_STATUS:
F — Failed
E — Error
| — Information
W — Warning
P — Pass
Null — Data Quality makes no entry is for RUN_STATUS if there is
no data being processed.

FAILED_ROWS Number of rows for the RUN_STATUS.

FIC_MIS DATE Date of the Batch execution.

ENTITY Data Transformation edit checks populates the individual entity
names of the checks.

NOTE: Edit Check does not make an entry for either ENTITY or DQ_CHECK_ID if it is aggregated
validations performed across multiple FR-2052A report data schedules.
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2. Detail Table

The following table shows the mapping for each Edit Check and its Details Table.

Edit Check | Edit Check Edit Check Details Table

No. Description Type

2 Internal Transactions | Data Quality ¢ DQ_RESULT_SUMM_MASTER
Reported on ¢ DQ_RESULT_DETL_MASTER
Consolidated
Reporting Entity

3 Internal Transactions | Data Quality ¢ DQ_RESULT_SUMM_MASTER
Reported Without ¢ DQ_RESULT_DETL_MASTER
Internal Counterparty

4 Lendable Value in Data Quality ¢ DQ RESULT SUMM_MASTER
Excess of Market ¢ DQ_RESULT_DETL_MASTER
Value

5 Third-Party Reporting | Data ¢ FSI EDIT CHECK 5 LOG
Entity Exposures Transformation
versus Consolidated

6 Symmetry of Data ¢ FESI EDIT CHECK 6 LOG
Intercompany Transformation
Transactions

7 Large Haircuts on Data Quality ¢ DQ_RESULT_SUMM_MASTER
Secured Transactions ¢ DQ_RESULT_DETL_MASTER

9 Missing Required Data ¢ FESI RUN PROD BY ENT TYP LOG
Products by Entity Transformation
Type

10 Improper Intra-entity Data Quality ¢ DQ_RESULT_SUMM_MASTER
Consolidation ¢ DQ_RESULT_DETL_MASTER

12 Invalid or Missing Data Quality ¢ DQ_RESULT_SUMM_MASTER
Counterparty Field ¢ DQ RESULT DETL_MASTER

13 Missing or Not Data Quality ¢ DQ_RESULT_SUMM_MASTER
Applicable [Collateral ¢ DQ_RESULT_DETL_MASTER
Class] Field

14 Large Other Product Data ¢ FSI_EDIT_CHECK_SUMMARY
or Counterparty Transformation
Balance

Oracle Financial Services Software

141



OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
User Guide, Release 8.0.4.1.0

The Data Transformation Details Tables with the attributes and descriptions are as follows.

a. FSI_EDIT_CHECK_5 LOG

This table stores the result of comparison between aggregation of maturity value, collateral

value, lendable value, and market value of the top-most parent entity with its child entities.

Attribute Name

Attribute Description

D_FIC_MIS_DATE

FIC MIS DATE of the batch provided during execution

N_MATURITY_STATUS

Maturity status has two values:
0 — Maturity values of parent not matching child entities

1 — Maturity Values of parent matching child entities

N_COLLATERAL_STATUS

Collateral status has two values:
0 — Collateral value of parent not matching the child entities

1 — Collateral value of parent matching the child entities

N_LENDABLE_STATUS

Lendable status has two values:

0 — Lendable value of the parent not matching the lendable
value of the child entities

1 - Lendable values of the parent matching the lendable
values of child entities

N_MARKET_STATUS

Market status has two values:
0 — Market value of the parent not matching child entities

1 — Market value of parent matching child entities

V_BATCH_ID

Batch ID of the batch being executed

b. FSI_EDIT_CHECK_6_LOG

This table stores the result of comparison between the maturity outflow amount versus the

maturity inflow amount.

Attribute Name

Attribute Description

V_INTERNAL_COUNTERPARTY

Internal Counterpart value of the Inflow / Outflow

D_FIC_MIS_DATE

FIC MIS DATE of the batch provided during execution

N_ED_STATUS ED status has two values:
0 — Maturity value sum of inflow not matching outflow
1 — Maturity value sum of inflow matching outflow
V_BATCH_ID Batch ID of the batch being executed

V_REPORTING_ENTITY

Legal Entity Name / Internal Counterparty of the views
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c. FSI_RUN_PROD_BY_ENT_TYP_LOG
This table stores the availability status of PIDs for the reporting enitity’s entity type.

Attribute Name Attribute Description
RUN_SKEY RUN SKEY is the run from the views
FIC_MIS_DATE FIC MIS Date of the batch being executed
ENTITY_TYPE Entity Type of the Reporting Entity
PID PID of the record from view
STATUS_FLAG Staus values has two flags:
1 - PID is present for that entity type of Reporting Entity
0 — PID missing for that entity type of Reporting Entity
BATCH_ID Batch ID of the batch being executed

The status of validation / edit checks are stored in the following SQL statement:

SELECT T1.FIC MIS DATE, T2.V_ED CHK ID, T2.V_ED CHK NAME,
NVL(T1.V_DQ CHECK ID, T1.ENTITY) ENTITY, T1.FAILED ROWS,
T1.RUN_STATUS

FROM
FSI_EDIT CHECK SUMMARY T1,
FSI_EDIT CHECK MASTER T2
WHERE T1.N EDIT CHECK SKEY = T2.N EDIT CHECK SKEY
AND T1.V_BATCH ID = <Batch ID>
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9.6 FR-2052A Post-Submission Validation Checks

This section outlines the automated validation applied to each FR-2052A submission to verify and
improve overall data quality, and communicate key structural features of the collection. These checks
represent the early foundation of a validation framework for the FR-2052A and is refined and expanded
upon as the collection progresses. OFS Regulatory Reporting performs the following checks either

through Data Quality or Design.

Validation Check

Performed in:

Regulatory Reporting /

Lombard Risk AgileREPORTER /
Processing

Approach:

Design /

Data Quality /

Data Transformation

Value

Internal Transactions Reported on Regulatory Reporting Data Quality
Consolidated Reporting Entity
Internal Transactions Reported Regulatory Reporting Data Quality
Without Internal Counterparty
Lendable Value in Excess of Market | Regulatory Reporting Data Quality

Third-Party Reporting Entity
Exposures versus Consolidated

Regulatory Reporting

Data Transformation

Symmetry of Intercompany
Transactions

Regulatory Reporting

Data Transformation

Large Haircuts on Secured
Transactions

Regulatory Reporting

Data Quality

Mismatched Currency Reporting

Regulatory Reporting

Design (this is handled as part of

OFS Regulatory Reporting Model

design)

Missing Required Products by Entity

Regulatory Reporting

Data Transformation

Type

Improper Intra-entity Consolidation Regulatory Reporting Data Quality
Invalid or Missing Counterparty Field | Regulatory Reporting Data Quality
Missing or Not Applicable (Collateral | Regulatory Reporting Data Quality

Class) Field

Large Other Product or Counterparty
Balance

Regulatory Reporting

Data Transformation

Weekend Maturities (in respective

source system)

Processing
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10 Troubleshooting Guidelines

This section covers troubleshooting guidelines for user of Oracle Financial Services Regulatory Reporting
Integration with AgileREPORTER, hereafter called as Integration.

Integration users provide the data inputs through the OFSDF where data is loaded, processed and results
are made available for reporting purposes. Integration package then makes this data available in required
formats to AgileREPORTER. In AgileREPORTER, this data is then aggregated according to the reporting
requirements and end users view this from AgileREPORTER User Interfaces designed for the Viewing /
Editing of this aggregated data.

This section provides detailed guidelines on how to troubleshoot the data issues tracing back the data
flow from AgileREPORTER.

10.1 Prerequisites

It is assumed that user can login and see following menus and respective reports in AgileREPORTER.

Lombard Risk | Dashboard ]  XBRLChecker ~ hipadmn = % @

Show Deleted Returns Delete Return Log X Create New (gl mport adjustments ~ Export To Regulator Format 1 Export @) Retrieve Retumn

Regulator WORKFLOW STATUS
ENTTY RETURNS ¢  VERSION ¢  REFERENGEDATE ¢  JOBSTATUS UPDATE  APPROVAL EDITIONS ~ TRANSMISSION ~ MODIFIED & MODIFIED BY &
US FED Reserve LYEAR

12/09/2016 112159 RPADMIN

us FFIEC031 4 30009722013 [r]®] {3 Undate  NO ATTESTATION NEEDED

L[]

Eniity

us us EFIEC041 4 30/09/2013 [R]@] {2 Undate NO ATTESTATION NEEDED

14/00/2016 12:01:45  RPADMIN

o

us ERY3C 2 3010972013 Q0 ) Update  NO ATTESTATION NEEDED (1) Jarse 08/03/2016 114104 RPADMIN

a

Form

1 15 v
All
Available date

Al

Figure 41: AgileREPORTER

This means configurations activities for the AgileREPORTER and OFSAA are completed. Set up activities
for Entity is done and reports templates as shown above are available for viewing. Report Names shown
in the figure are for illustration purpose and actual name depends on the integration pack licensed.

10.2 Troubleshooting Use Cases

10.2.1 Unable to Generate Report

If you are unable to generate reports, meaning none of the derived entities referred in the report has rows
for the LE/date combination, then you must refer to Installation Manuals of AgileREPORTER or OFSAA
Integration pack for further instructions and steps to be followed.

If the process mentioned in Installation Manual is correctly followed and still report list is not available
then you are requested to login the bug / service request with Lombard Risk.

10.2.2 Data Unavailable in AgileREPORTER

This is a use case where you are logged in to AgileREPORTER, and selected particular regulatory report
for appropriate entity and As of Date, but unable to generate the report.
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10.2.2.1 Fetching Null or Zero Values

AgileReporter is showing either Zero or Null values. It indicates that Derived Entities has data (however,
all required filer conditions are not matching and resulting in zero value output) or Derived Entiy does not
have data at all.

A Show Import Log ~ Adjustments ~ ExportToFile = Exportto Regulator Format g1 Live Validation &Y Validate Now ~ Workflow
Editions | 03/24/2016 11:13:27 #17 L 2IC, Instances 1 N ]
Show Scale [ x] R
FRY.0C
Page 90765 5
0
Schedule HI-C—Disaggregated Data on the Allowance for Loan and Lease Losses o
Whst
Schedule HI-C s to be completed by holding companies with $1 billion or more in total assets. 1 B
(Eoiumn A (Column &) (Column C) (Coiumn b (Column E} (Coumn F Cover
Recorded Investment. | Allowance Balance: | Recorded investment: |  Allowance Balance: | Recorded Investment: |  Allowance Balance:
Individually Evaluated | Individually Evaluated | Collectively Evaluated | Collectively Evaluated Purchased Purchased Sch HI(1014)
for Impairment for Impairment for Impairment for Impairment Creditimpaired Loans | Creditmpaired Loans )
(ASC 310-10-35 (ASC 310-10-35 (ASC 450-20 (ASC 450-20 (ASC 310-30, (ASC 310-30) SchHI(2of4,
Dollar Amounts in Theusands: BHCK! _ Bil | il | Thou | BHCK! _ Bil |Mil| Thou |BHCK. _BIL | Mil| Thou {BHCK. _Bil |Mil| Thou BHCK. Bil |Mil| Thou |BHCK] _Bil | Mil | Thou IEE
1 Real estate loans '
a ion loan: w708 | NULL M709 NOLL MT10 MNDILE M7 11 WNOIEE M712F NUEL M713§ NULE 1.a Sch HI (4 of 4
b. Commercial
real estate loans 7147 WL 17715 WO 1716 WO 17777 WO 1719 IWOLE 17720} WUEE 1b. SchHEA
c. Residential _
real estate loans W73 DL 17733 WL 733 DL 17734 WDL 1738 WOLE 1735 WOIL 1.c EEIIE )
2. Commercial loans2...... NUEL 723 INULE M729 NULE w730 NOLE w731 NUEL 732 NULL 2 Sch HI-B (2 072)
3. Credit cards NULL V734 NULL 1735 NULL 736 NULL M73T NULL V738 NULL 3
4.Other consumer loans INULL 1740 UL 741 NULL w742 UL 1743 NULL V724 NULE 4 SchHLC
5. Unallocated, if any 1745 4,500 5
6. Total Notes to Income Stmt (1 0f3)
(sum of items 1.a through 5).._..i M748 | INULE 747 WNULE 78] NULE M749 0:m7501 NUEE m751] NULL ©.
Notes to Income Stmt (2 073
o Notes to Income Stmt (3 0f3)
1. The asset size fest s generally based on the total assets reported as of June 30, 2014
2. Include all loans and leases not reported as real estate loans, credit cards, or ofher consumer loans SchHC (1 of3,
Seh HC (2 0f3)
A showimport Log ~ Adjustments ~ ExportToFile  ~ Exportio Regulator Format | &) Live Validation g Validate Now ~ Worklow
Editions | 032472016 11:13:27 #17 - Instances 1 -0
SiomEcas a Sch HE-Q (2 0f2
Page 63 0765 SchHC-R (1 of 14
Sch HC-R (2 of 14)
Schedule HC-V—Variable Interest Entities Sch HCR (3 of 14)
TColumn A7 Column B Column € SchHCR 4 of 14
Securitization Vehicles ABCP Conduits Other VIES
Dollar Amounts in Thousangs| BHOK| _ Bl Mill Thou__|BHCK] _ Bil I il | Thou__|BHOK] _Bil I Ml I Thou SEILEREETR
1. Assefs of consolidated variable interest entities Sch HCR (6 of 14)
(VIES) that can be used only to seftie obligations of
SCchHCR (7 of 14)
consolidated VIES
2. Cash and balances due from depository institutions. . | J981 0] Jogz 0] Joa3 0| 1a SchHCR (8 of 14)
b. Held-tlo-maturity securitie: Jog4 0] Joss 0] Joss 0] 1b
Sch HCR (9 of 14)
¢ Avallable-for-sale securities J987 0) yoss 0] s989 0] 1e
d. Securifies purchased under 1o resell 4990 0 Jag1 0] Jog2 0] 14 Sch HC R (10 of 14
. Loans and leases held for sale 4993 0f ya0s 0| yo05 0| 1e
Sch HCR (11 07 14)
f Loans and lsases, net ofuneamed income 996 0) Jag7 0] J998 0 11
g. Less: Allowance for loan and lease losses. 4999 0{ koot 0] koo2 0] 1g Sch HG R (12 of 14
h. Trading assefs (other than derivatives. KO03 0] kooa 0| koos 0] 1n
SCchHCR (13 0f 14)
i Derivative trading assets K006 0] koor 0] koos 9] i
j. Otherreal estate ovned K009 200] ko10 0] ko1t 0] 1j Sch HG R (14 of 14
k. Other assets K012 0fko13 0] kn14 0| 1k
Sch HC-S (10f3)
2. Liabilities of consolidated VIES for which ereditors do
nothave recourse to the general credit ofthe: Sch HG-S (2 of 3
reporting holding company;
poring g come Sch HC-S (3 0f3)
a. Securities sold under agreements to repurchase K015 \ 0 | K016 \ ﬂ\ K017 \ 0] 2a
b. Derivative rading liabilities K018 | 0[ko19] 0] ko2o | 0] 25 SchHCV
¢ Commercial paper K021 | 0] ko2z | 0] k023 | 0] 2¢
Notes to the Bal Sheet(1 o7 2)
d. Other borrowed money
(exclude commercial paper) K024] 0] ko2s] 0] k26 | 0] 24 Notes to the Bal Sheet(2 of 2)
e. Ofher liabilite: w027 | 0] kozs | 0] ko2 | 0] 2e . 5

Figure 43: Fetching Zero Values

You must validate as:
1.

a.

b.

Derived Entity has data:
Execute the Derived Entity / Materialized views to check if Derived Entity has data or not.
If Derived Entity / materialized view has data but not showing in AgileREPORTER, you

must log a Bug / Service Request with Lombard Risk.

2. Derived Entity does not have data:
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a. Execute the Derived Entity / Materialized views to check if Derived Entity has data or not.

b. If Derived Entity does not have data, then check the Business Metadata excel for a given
schedule.

c. Check Worksheet titled ‘Derived Entity’ in Business Metadata excel. Get all the derived
entities for a given schedule.

d. Get dataset for each derived entity.

e. Execute datasets in OFSAA FSDF Atomic Schema to check if data is available for a
given dataset joins.

f. If data is available in dataset queries, you must log a Bug / Service Request with
AgileREPORTER.

g. If data is not available in dataset, then check if selection of Entity, Available Date (as of
date) is appropriate and required executions are available. If Entity, As of Date and Run
executions are correct and still data is not available, then you must log a Bug / Service

Request with Oracle Support.

10.2.3 Data Available in AgileREPORTER but Not as Expected

This use case where you are able to refer data for a required cell of a schedule in AgileREPORTER,;
however, value shown differs from expected value.

Let us take following example to illustrate the steps to be followed. This refers to Schedule HC-M from FR
Y-9C report from US FED. Particular cell referred here is BHDMK169 —

6.a. Loans and leases (included in Schedule HC, items 4.a and 4.b):
(1) Loans secured by real estate in domestic offices:
(a) Construction, land development, and other land loans:

(1) 1-4 family residential construction loans

A show import Log ~ Adjustments ~ ExpotToFile - ExporttoRegulatorFormat g Live Validation g7 Validate Now ~ Workiow
Editions  03/24/2016 11:13:27 #17 (O instances 1 - O
Show Scale a8 horar
Page 34 of 65 SchHC-G&H
Schedule HC-M—Memoranda
Seh HC-|
Dollar Amounts in Thousands[BHCK] __Bil | Mil | Thou
1. Total number of holding company common shares Number (Unrounded SCUHESK
3459 0.0009) 1 Sch HC-L (107 4)
2.Debt maturing in one year or less (included in Schedule HC, items 16 and 19.a} that is
issued to unrelated third parties by bank 555 | 0] 2 Seh HC-L (2 0f4)
3.Debtmaturing in more than one year (included in Schedule HC, items 16 and 19.a) thatis R @
issued to unrelated third parties by bank 6556 | 0] 3 :
4.Other assets acquired in safisfaction of debis previously contracted 6557 | 100] 4 Seh HC-L (401 4)
5.Securities purchased under agreements to resell ofset against securities sold under
1o on Schedule HC 288 | 0] s
6. Assets covered by loss-sharing agreements with the FDIC Sch HC-M (2074}
a. Loans and leases (included in Schedule HC, items 4.2 and 4.b)
(1) Loans secured by real estate in domestic offices SchHC-M (304)
(a) Construction, land development, and other land loans [eHOM Sch HC-M (4 of4)
(1) 1-4 family residential construction loans. K169|256,608.000.000.000| 6.a.(1)(a)(1)
(2) Other construction loans and all Iand development and other land loans K170 |2.774,602,720,000,000 6.a(1)@)2 Seh HC-N (1 07 5)
(b) Secured by farmiand K171 [266,608,000,000.000] 6.2 (1)(b Seh HON (2 015)
(¢) Secured by 1-4 family residential properties:
(1) Revolving, open-end loans secured by 1-4 family residential properties and Sch HC-N (3 0f 5)
extended under lines of credit.......... S o K172 ] 85,536,000,000.000 | G.a(1)(c)i1) T TR
(2) Closed-end loans secured by 1-4 family residential properies !
(a) Secured by first liens m?s\ 18,817,920,000,000 | &.a(i)ch2)a Sch HC-N (5 0f5
(b} Secured by junior liens... S | K174 18,817,920,000,000| 6.2.(1)c2ib
(d) Secured by multifamily (5 o more) residential properties. K175 0] saft)d Sch HC-P
(e) Secured by nonfarm nonresidential properties: Seh HC-Q (1 012)
(1) Loans secured by owner-occupied nonfarm nonresidential properties S | KITE] 0] sa)e)
(2) Loans secured by ofher nonfarm nonresidential properties 1177 [266,608,000.000.000] 6.3 (1)(e)(2. Sch HC-Q (2 0f2)

Figure 44: Schedule HC-M from FR Y-9C Report

You can drill down for each cell to check details of data as what is included in aggregation. To drill down,
click the value of particular cell and it is shown highlighted. It shows OFSAA data lineage icon on clicking
as shown in Figure 45.

Oracle Financial Services Software 147



https://support.oracle.com/

OFS Regulatory Reporting for US Federal Reserve — Lombard Risk Integration Pack
User Guide, Release 8.0.4.1.0

A show Import Log ~ Adjustments ~ ExportToFile  ~ Exportto Regulator Format &9 Live Validation Y Validate Now ~ Workflow
Editions 0372412016 11:13:27 #17 ~ | (5 Eitene  Instances 1 N ]
Show Scale a LeEeE
SchHC-G&H
Seh HC-|
SchHC-K

Sch HC-L (10f4
Sch HC-L (2 0f4)
Sch HC-L (3074)
SchHC-L (4 of 4!
Sch HC-M (2 of 4)
Sch HC-M (3 of 4)

Sch HC-M (4 of )

[256608000000000

direct cell edit
Sch HG-N (1 075)

OFSAA

— Sch HC-N (2 of 5)

a

Sch HC-N (3 0f 5)
Sch HC-N (4 0f 5)
Seh HC-N (5 0f 5)
Sch HC-P
Sch HC-Q (1 0f2)

Sch HC-Q (2 072)

Figure 45: Data Lineage

Make sure that you are logged in to OFSAA infrastructure before clicking Data Lineage icon.

¢

If you are not already logged in, clicking here opens the OFSAA infrastructure login window. Log
in using appropriate credentials and come back to Report Portal and click the same Data
Lineage icon again.

If you are already logged in to OFSAA Infrastructure, the Data Lineage first page opens as shown
in Figure 46.

Data Lineage
Run Execution 14 7 Date 30Sep 2013
Legal Enty us Reference Igentiier BHDMK169
» Derived Entity : DERHCMO1  (30) B 5
Holding Type C |Bands hierarchy | instrument type Hierarchy | Regulatory Product Classification Hierarchy | Risk Factor type | Desivative Tupe ¢ HIREGHS  |Geography - Branch Country | Surrogate Key Hierarch,
HTM 1045 IRSPOTRER 1-4FAMCONLOAN R sPoT CORMNC  US N
HTM 1043 IRSPOTRREP 1-4FAMCONLOAN R e CORING U [
HTM 1048 IRSPOTRREP 1-4FANCONLOAN R sPOT CORMNG U N
HTM 1205 EQRCPS 1-4FANCONLOAN £ sPoT INSCOV U N
HTH 1045 coLmes 1-4FAMCONLOAN R spoT CORMC Ut [
HTM 1205 CISPOTCIU 1-4FAMCONLOAN o spoT INsCOV  US N
HTM 1205 EQRCPS 1-4FAMCONLOAN £0 e INSCOV U [
HTM 1045 IRSPOTREP 1-4FANCONLOAN R sPOT CORMNG U N
HTM 1043 CoLmES 1-4FANCONLOAN R spoT CORMNC U N
HTH 1205 coLmes 1-4FAMCONLOAN R sPoT Nscov U [

»

Figure 46: AgileREPORTER

Top block of this screen shows following information which helps to connect the AgileREPORTER

aggregated data to OFSAA references.
1. Run Execution ID: This refers to OFSAA Execution ID chosen for a given report.

2. Date: This refers to AS OF DATE selected for a given report.

3. Legal Entity: This refers to the OFSAA Legal Entity for whom the report is generated.

4. Reference Identifier: This is the cell reference for which data drill down / lineage is being

checked.

Second block displays all hierarchies with values used in a given Derived Entity and measures
aggregated for a given combination of a hierarchy values.
To refer the measure values, scroll rightwards using horizontal scroll bar at bottom of second
block. On extreme right, measures are displayed as shown in Figure 47:
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Data Lineage

Run Execution Id 7 Date 30 Sep 2013

Legal Entty us Reference dentiier BHDMK 159

» Derived Entity : DERHCMO1  (30) ] 5

m failed insured dep insts - HCM | Construction loan type - HCM | Customer Country Hierarchy | Agreement Sponsorer Code Hierarchy | Entity Type Hierarchy | Accrual Status Code Fla Hierarchy | Req Prod Type Hierarchy | Amortized Cost - Common Account Summary

UsA FDIC ACCRU 8.553,600,000.000.00
usa FDIC ACCRU 12.830,400,000,000.00
usa FDIC ACCRU 12.830,400,000,000.00
UsA FDIC ACCRU 8.553,600,000.000.00
usa FDIC ACCRU 8,553,600,000,000.00
usa FDIC ACCRU 4.276,800,000,000.00
UsA FDIC ACCRU 8.553,600,000.000.00
usa FDIC ACCRU 8,553,600,000,000.00
usa FDIC ACCRU 8,553,600,000,000.00
UsA FDIC ACCRU 8.553,600,000.000.00

Figure 47: Measure Values

Only measure values are hyperlinked indicating that they can be drilled down further. On clicking
the amount, second level drill down show the lowest granularity data available for a given cell
reference.

10.2.3.1 Using Drill Down with Data Lineage View

Data Analysts/You can then compare these accounts and their respective monetary amounts with
expected values. One can check the following:

1. All required accounts are shown in aggregation

2. Unwanted accounts are not included in aggregation

3. Measures / Monetary amounts at account granularity are as expected.

Any deviation from expectations can be then checked back for:

1. If measure is stage pass through, then validate using T2T to verify if stage data is as expected or
must be corrected.

2. If measure is processed, then validate using T2T to verify processing measure is correctly moved
to result area.

3. If reclassified hierarchies are showing unexpected values, check Rules and source hierarchies of
rules. This use case needs close verification to ensure that all source hierarchies have required
values or Rule sequence which can lead to overwriting the values.

4. |If all the source data is as expected and result area is now showing unexpected output, then log a
Bug / Service Request with Oracle Support.

10.2.3.2 Data Lineage View is Unavailable

If the second block does not show any data, then data analysts/you are advised to refer to the data set
worksheet of Business Metadata.

Data Lineage

Run Execulion Id 1 Date 30 Sep 2013

Legal Eniy us Reference dentier BHCKJ456

» Derived Entity : DE - Derivatives and Ofi-Bal heet Items HC-L1  (0) B

|

Figure 48: Data Lineage Unavailable
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There can be few reasons why second block does not show the data:

1. Internet connection is timed out or broken down - in this case clicking Data Lineage on
AgileREPORTER results in a blank second block. To rectify this, re-login to OFSAA infrastructure
and AgileREPORTER.

2. Data Lineage view works after Metadata is published using OFSAA Infrastructure. To validate if
Metadata is properly published or not.

3. If Metadata is properly published and second block still does not show the data, then start with
Derived Entity code shown at the beginning of second block. This Derived Entity code is available
even if data is not available.

4. Using this Derived Entity code data analysts are advised to refer to OFSAA Business metadata
with worksheet name as ‘Derived Entity’. Sample Business Metadata excel is shown in Figure 49:

A 5 3 0 £ P G [l J x|
1 Jerived Enti Short Description Long Description Source Type | Ageregate [terialised Vi Dataset Code Selected Metadata [Selected Metadata Codel
146 Band Type Hierarchy HIREGL16
19| Instrument type Hierarchy HIREGDLE
150 Regulatory Product Classification Hierarchy | HIREG0SS
151 Party Type Hierarchy HIREG037
152) Entity Type Hierarchy HIRHCPOL
153) Product Type Hierarchy [FiRrcroL
154 Undrawn Amt - Common MSRHCLO1
155 Calendar Date HIREGODL
156] IDE - Derivatives and Off-Balance-Sheet |DE - Derivatives and Off-Balance-Sheet DS - Derivatives and Off-Balance-Sheet ltems - HC- [Run Description HIREGOD2
157|DERHCIOL items He-LL tems HC-LL Dataset [N ¥ DsRACLOL |11 Org Structure Entity Code [riREG00S
158 Reg Instrument Classification Hierarchy | HIREGD1L
159 Hierarchy HIREGD48
160 Holding Type Code Hierarchy HIREGO12
161 Calendar Date [rireGo0L
162 Run Description HIREGOD2
163 Org Structure Entity Code HIREGODS =]
164 Buy or Sell Indicator Hierarchy HIRHCODL
5 Fair value - IFRS Account Summary. MSRHCNOS
168| DERHCLO2 DE - Derivatives and Off-Balance-Sheet HDE - Derivatives and Off-Balance-Sheet N v DSRHCLO2 __|DS - Derivatives and Off-Balance-Sheet Items - HC-I{Notional Amount RCY MSRBS001
167 Calendar Date HIREGODL
168 Fair value RCY - Mitigants MsRrCL02
163 DERHCLO3 X - Account to Mitigant Map X - Account to Mitigant Map Datasst [N v DS - Account to Mitig: Account Skey - Account to Mitig HIRHCLO2
170 Calendar Date HIREGOD1
171 Fair value RCY - Mitigants MSRHCL02
172 [Account skey - Account to Mitig HIRKCL02
173 | DERHCL0A DE - Account to Mitigant Map with Mitigs DE - Account to Mitigant Map with Mitigant Ty Dataset [N v DS - Account to Mitig: with Mitigant Type _[Mitigant Type Hierarchy HIREGS
174 Net CE Amount MSRHCLOS
175 Calendar Date HIREGODL
176 Run Description HIREGDD2
177 Org Structure Entity Code HIREGD0A
17| DERHCLOT DE - Derivatives and Off-Balance-Sheet HDE - Derivatives and Off-Balance-Sheet N v DS - Derivatives and Off-Balance-Sheet items - HC-L{Standard Party Type Hierarchy HIREG103
179) O ~F air value ALY - Mitigants WSRHELTD
180 Reg Instrument Classification Hierarchy lnwﬁsml ¥
4« » ¥ HierarchiesBI  Base Measures ~ Datasets ,~ Business Process | Derived Entity “Reports “¥J ol »

Figure 49: Business Metadata
5. By referring to Business Metadata, you can get complete information on Derived Entity such as
dataset, Fact tables, measusres, hierarchies defined under particular Derived Entity.

i 9 L=NN 0N
D1232 ~ fe | fct_common_account_summary B
A B c D a
1 _Dataset Code From Clause: Ansi Join B
1232 FCT_COMMON_ACCOUNT_SUMMARY Jfct_common_account_summary
233 [fct_reg_account_summary innerjoin fct_reg_account_summary on fct_reg_account_summary.n_mis_date_skey=
234 dim_dates Jict_common_account_summary.n_mis_date_skey
1235 dim_run and fcr_reg_account_summary.n_acct_skey = fc_common_account_summary.n_acct_skey
1236 dim_org_stcure inner join dim_reg_product_classification on dim_reg_product_classification.n_eg_prod_lassification_skey=
1237 o caricion DS - Derivatives and Off-Balance-sheet Items - He-LL |2IM_REG_PRODUCT_CLASSIFICATION Jfct_rez_account_summary.n_ree_prod_classification_skey
238 dim_entity_type nner join fct_legal_entity_details on fct_legal_entity_details.n_entity_skey =
239 FCT_LEGAL_ENTITY_DETAILS Jict_common_account_summany.n_entity_skey
1240 dim_reg_product type AND fct_legal_entity_details.n_mis_date_skey = fct_common_account_summary.n_mis_date_skey
241 Dim_instrument_type inner join dim_entity_type on dim_entity_type.n_entity_type_skey = fct_legal _entity_details.n_entity_type_skey
242 dim_product type irner join dim_instrument_type on dim_instrument_type n_instr_type_skey =
243 dim_pary_type Jict_reg_account summary.n_instr type_ske

Figure 50: Derived Entity

The Dataset ANSI Joins provide valuable information on how various entities are joined/linked together.
By executing these Joins, you can confirm if data is available for given filters and conditions. If data is
fetched using Dataset Joins and Data Lineage does not show data, you must log a Bug / Service Request

with Oracle Support.
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